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The SHS titles focus on how learners can gain the know-how that they need for the situations and activities 
in their respective courses. Because each lesson is designed to be outcomes-based, the interactive 
activities that come with each courseware incorporate constructively-designed assessment measures. 
They also follow a curriculum that aligns with and far exceeds DepEd expectations.

But beyond all these, it’s the TFI spirit of making learning a great experience imbued in our courseware 
that sets them apart from all the rest.

Dr. Jaime D.L. Caro
Chief Academic Officer
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AbouT ThE booK
The E-Tech courseware enables students to adopt a more critical framework in consuming and creating 
media products. It emphasizes self-directed and outcomes-based learning in which students can initiate 
and manage their own learning through activities that equip them with professional and real-world skills, 
helping them become active and responsible members of society. To senior high school students, media 
become more than just sources of information; they become spaces for expression and transformation.

LESSon SECTIonS
The TFI Senior High School Series features a Unifi ed Lesson Section System.

LESSon TITLE
The lesson title presents a question that not only captures what the lesson is about but also presents
the student with the practical use of learning the lesson.

TArgET
This section contains at least three learning objectives that tell the student about what they will learn
at the end of the lesson.

In this section, students will be given 
a pre-work activity that enables them 
to assess what they already know 
about the topic. Guide questions and 
graphic organizers will be used to touch 
on essential concepts which will be 
discussed in detail in the latter parts of 
the lesson.

A special feature of this section is the 
sample material containing marginal 
questions which the student must 
answer on their own. These questions 
will be answered in the discussion 
which constitutes the second part of the 
section and tackles concepts and skills 
using self-directed learning principles.

To help the student engage with the 
lesson in a more critical manner, this 
section will present them with questions 
that connect the lesson to relevant or 
current issues and trends.

In this section, students will be given a 
combination of objective and essay-type 
activities that assess how much they have 
learned from the lesson.

This section will give students links to 
additional resources that they can use for 
further study as well as supplementary 
materials that can help them prepare for 
their portfolio project.

Containing an evaluation task that 
connects the lesson to the whole 
module, this section helps the student 
work on their portfolio project little by 
little. Activities in this section can be 
done either individually or by group.

EXPLorE

EXAMInE

ChECK

EQuIP

buILD
InTEgrATE
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MoDuLE 1
how does e-tech empower people and 
affect social change?

Learning outcomes
•	Discover how empowerment technologies empower people.

•	 Identify recent social issues that have something to do with    
  empowerment technologies.

•	Use advanced productivity tools collaborativelyin developing and   
  proofreading a project.

Portfolio output
Project Pitch – a five- to ten-page paper documenting the details of your 
social change project. The following are the elements of your project that 
must appear in the project pitch document:

Title of the Project 
This refers to the social issue you have identified and you want to tackle 
during the semester. Your aim is to address this issue by increasing 
people’s awareness about it. Your title should be in question format. 

objectives of the Project
This refers to the outcomes that your group wants to produce after the 
project has been completed. 

related Literatures and resources
Try to prove your point by presenting articles, research, or statistics. 
Present at least 10 articles here.

Philippine Copyright 20171
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Criteria Excellent
5 PTS

Very Good
3 PTS

Needs Practice
1 PT

Title of the project 
(Question Form)

The chosen title fits the 
proposed issue

The chosen title somehow 
fits the proposed issue but 
needs improvement

The chosen title somehow 
does not fit the proposed 
issue 

Objectives of the project
The project’s objectives are 
all SMART

Some of the project’s 
objectives are not SMART

All the project’s objectives 
do not follow SMART

Relevancy of related 
literatures and resources 
gathered

Articles, research, and 
statistics presented are all 
relevant and cited properly

Some articles, research, 
and statistics presented are 
not relevant and not cited 
properly

Lack of relevant articles, 
research, and statistics are 
presented

Relevancy of related 
literatures and resources 
gathered

Articles, research, and 
statistics presented are all 
relevant and cited properly

Some articles, research, 
and statistics presented are 
not relevant and not cited 
properly

Lack of relevant articles, 
research, and statistics are 
presented

Present statistical data
Statistical data are all 
graphically pleasing and 
organized

Statistical data are all 
graphically pleasing but 
some are not organized

Statistical data are not 
graphically pleasing and 
organized
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Lesson 1: What is empowerment technology?
•	 Empowerment Technology: A Definition

•	Empowerment Through ICT

•	 ICT and Society

•	A Peek in the Past

•	 Latest Technology Trends

Portfolio Task 1 - Your main output for this course is a social change project related to the 
track or strand you are pursuing for Senior High School. To help you prepare for this, brainstorm 
for initial ideas.

Lesson 2: How can I use the Internet as a tool for effective 		
		    research?

•	Contextualized Search and Research

○○ What Is Research?

○○ Why Is It Important?

○○ What Are the Research Skills I Need to Develop?

•	 ICT Tools Useful in Research

○○ Google Search

○○ Google Scholar

○○ Online Journals

○○ Academic Websites

•	 ICT Safety, Security, and Netiquette

○○ Verification of Online Source Materials

○○ Computer Ethics and Netiquette

○○ Intellectual Property Rights (IPR)

○○ Avoiding Plagiarism

Portfolio Task 2 - After learning the essential techniques and standards in data gathering 
through the Internet, you should now be able to gather data relevant to your project. Look for at 
least five articles or discussions that will support the claims of your project. Follow the criteria 
for choosing a reference website and use proper citation.
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Lesson 3: How do I use advanced Word tools to develop 		
		    content?

•	References: Citations and Bibliography

•	Checking Spelling and Grammar

○○ How to Run the Spelling & Grammar Tool

○○ Ignoring “Errors”

○○ For Spelling “Errors”

○○ For Grammar “Errors”

○○ Automatic Spelling and Grammar Checking

•	 Finalizing and Protecting Documents

○○ Document Inspector

○○ Protecting Your Document

•	Tracking Changes

•	Comments

•	Comparing Documents

•	Mail Merge

○○ How to Use Mail Merge

○○ How to Insert Recipient Data

Portfolio Task 3 - Prepare the project pitch document that includes the identified problem and 
gathered articles in a document format. Use proper citations and review tools in MS Word.

Lesson 4: How do I use advanced Excel tools to process 		
		    and present data?

•	 Formulas and Functions

○○ Formulas

○○ To Create a Formula

○○ Modifying Value from a Cell Reference

•	 Functions

○○ Parts of a Function

○○ Using a Function
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•	The Function Library

○○ Insert Function Command

•	 Sorting

○○ Types of Sorting

○○ How to Sort an MS Excel Sheet

•	 Filtering

○○ Advanced Filter

•	Charts 

○○ Types of Charts

○○ Inserting a Chart

○○ Changing Chart Types

○○ Moving a Chart	

Portfolio Task 4 - Conduct a survey regarding your chosen project. You are free to use Word to 
prepare printed survey forms or use free online survey tools. Using MS Excel, tabulate the data 
gathered.

Lesson 5: What are advanced PowerPoint tips and tools for 	
		    effective slide presentations?

•	Top Ten Slide Tips

•	 SmartArt

○○ Inserting a SmartArt Graphic

○○ Adding Text to a SmartArt Graphic

○○ Converting Existing Text to SmartArt

○○ Modifying a SmartArt Graphic

Portfolio Task 5 - Prepare a slide presentation discussing your project concept. Your project 
pitch document may serve as a reference for the contents of your presentation. Present it in class.
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LESSon 1 whAT IS EMPowErMEnT 
Target
By the end of this lesson, 
you should be able to 

• Defi ne “empowerment  
 technology.” 
• Explain how Information  
 and Communications   
 Technology (ICT) has   
 been used for people   
 empowerment.
• Describe the current   
 state of ICT    
 technologies, online   
 systems, functions, and  
 platforms. 
• Compare and contrast   
 the nuances of varied   
 online platforms,   
 sites, and content to   
 best achieve specifi c   
 class objectives   
 or address situational   
 challenges.

  EXPLorE
The 21st century is described as the Digital Age because of the emergence 
and development of different technologies that have helped people 
accomplish tasks in a more effective and efficient way. A common 
example is the use of smartphones for communication via text messaging, 
voice call, or video call. You can even use smartphones to send an email 
or post on a website. 

To begin understanding the concept of empowerment technology, think 
of several applications you use every day, whether on a personal 
computer (PC) or a mobile device. Describe how each application helps 
you accomplish everyday tasks at home or in school. Afterwards, form a 
small group and interview each member. Complete the chart shown 
below.

What did you learn about your group members and their use of 
technology? Did you notice some similarities or differences? Did you 
learn something new? 

In the next section, you will read an excerpt of a research paper from 
Stanford Junior University entitled “Obama and the power of social 
media and technology.” Examine the role of technology during Obama’s 
presidential campaign in 2007. Use the marginal questions as your 
guides in examining the article. 

  Applications I      
  Personally Use     How It Helps Me      How Other People

              Use It

Facebook I use Facebook to 
send or post pictures 
to my relatives living 
abroad.

My groupmates use it 
to easily collaborate for 
projects. They create 
group chats and send 
files via Facebook 
Messenger.

TEChnoLogY?

Philippine Copyright 20177



Philippine Copyright 2017 8

  EXAMInE

“A major success factor for Obama’s victory was how Obama’s campaign used 
social media and technology as an integral part of its strategy, to raise money, 
and, more importantly, to develop a groundswell of empowered volunteers who 
felt they could make a difference.” – The European Business Review, “Obama 
and the power of socialmedia and technology”, 2010, p. 1. 

Have you ever thought social networks as an online platform could be 
such influential tools? This article reveals to us the fact that technology 
has become an essential tool for empowerment in the Digital Age. What 
does empowerment mean and why is it important for a student like you 
to understand this concept through the use of technology?

How did US President 
Barrack Obama use 
social media during his 
presidential campaign? 

What made his online 
campaign effective? 

Obama’s presidential 
campaign focused on 
the messages revolving 
around change, respect, 
and inclusion. Why do 
you think the people felt 
empowered by simply 
supporting him in his 
online advocacies?  
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Empowerment Technology: A Defi nition
Empowerment refers to the process of giving yourself, or other 
people, the capacity to achieve a specific end-goal. For example, 
if you want to learn how to cook a dish, you start by studying the steps 
detailed in cookbooks or by watching tutorial videos on YouTube. By 
doing so, you are empowering yourself with the necessary knowledge, 
tools, and skills you need to be able to achieve the end-goal: learn how to 
cook a dish. 

Likewise, empowerment technology refers to computer technology that 
we use almost every day, which enables us to do tasks that, in the past, 
require professional help. Consider the following examples. How does 
technology empower each individual? Other than the target outcome, 
what other results are achieved through the use of technology? 

•	 A	fi	fteen-year-old	owner	of	a	bakeshop	wanted	to	sell	her	cookies	online.	
Knowing that web development is a complex subject, she checked online 
for a free website creation tool. She found WiX and she was able to put up 
her own website in just an hour. 

•	 The student council wanted to create a video for their upcoming 
fundraising project. When they asked for help from videographers, they 
were	surprised	at	the	cost	given	to	them.	So,	the	council	decided	to	fi	nd	a	
video creation tool online. They tried Powtoon and was able to produce a 
multimedia video in a day. 

•	 A	businessman	is	running	late	for	a	meeting.	To	fi	nd	the	fastest	route	from	
his	offi		ce	to	his	home,	he	uses	Waze	and	he	is	able	to	tell	his	estimated	
time	of	arrival	to	the	people	waiting	for	him	at	the	offi		ce.	

Nowadays, there are applications that can be accessed and used for free. 
In the examples given, each individual is able to solve his or her problem 
with less cost, less time, and less effort.

Empowerment through ICT
In the research article you examined, the tools used for Obama’s 
campaign are social media platforms such as Facebook and Twitter. 
These were used to disseminate information and build Obama’s image. 
Messages	 like	 “change,”	 “hope,”	 and	 “making	 a	 difference”	 were	 the	
topics in his campaign posts. As stated in the article, Obama’s social 
media campaign is now considered “the legacy of one of the most effective 
Internet marketing plans in history, where social media and technology 
enabled the individual to activate and participate in a movement.”

Empowerment is a strategy that aims to give individuals the 
tools and resources necessary to take initiative, as well as 
gather and analyze information or situations, thus making 
informed decisions to solve problems and improve services 
or performance. In the context of Information and Communications 
Technology (ICT), empowerment requires being information literate and 
technology literate. 

During President 
Duterte’s campaign, the 
advocacy for change 
was imminent. How 
did his supporters use 
social media to build his 
image?

InTEgrATE



Philippine Copyright 2017 10

In 2000, the Information Literacy Competency Standards for Higher 
Education enumerated the competencies for information literacy:

In 2002, the International ICT Literacy Panel defined technology 
literacy as “the ability to use digital technology, communication tools, 
and/or networks to define an information need, access, manage, integrate 
and evaluate information, create new information or knowledge and be 
able to communicate this information to others.”

Why do you think these two literacies must be linked? In the following 
discussions, you will analyze the current state of ICT and evaluate how 
information and technology literacy work together for an empowered 
individual.

Evaluates information and its sources 
critically and incorporates selected 
information into his or her knowledge 
base and value system

Understands many of the economic, legal, 
and social issues surrounding the use 
of information, and accesses and uses 
information ethically and legally

Accesses the needed information 
effectively and effi ciently

Uses information effectively to 
accomplish a specifi c purpose

Determines the nature and extent of 
information needed
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ICT and Society 
Several studies conducted in different countries of the world have 
pointed out the importance of ICT for sustainable development. 
Significant changes have been observed in four major aspects of life: 
communication, economics, education, and travel. 

Study the list shown. What other examples can you add for each aspect? 

•	 Source of learning, teaching, and 			 
	 research materials

•	 Online learning communities

•	 Recording and computation of grades

•	 Managing records and other 	 	 	 	
	 administrative purposes

•	Online marketing

•	Convenient business transactions

•	Online payment gateways

•	 Social networking sites

•	 Instant messaging and video calls

•	 Forums and webinars (web seminars)

•	Online booking and reservation

•	Online tracking of reservations
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With all these changes, the demands in the workplace have also changed 
dramatically. According to Harvard Business Review (2012), the top three 
requirements for applicants today are (1) ICT skills, (2) communication 
skills, and (3) analytical skills. A competitive applicant for a job today 
must have all of these qualifications. 

Reflect on your own skills. Review this checklist from UNESCO. 
Mark the ones you think you are capable of. How important do you think 
these skills are when you graduate?

ICT Literacy Checklist for Students
Students should be familiar with basic concepts of ICT.

Students should feel confident about using computers.

Students should be able to use graphics appropriately.

Students should be familiar with using computers to 
communicate.

Students should be aware of how ICT changes jobs.

Students can build and use robots to perform experiments.

Students should be able to use computers in art.

Students should be able to use computers in dance and 
music.

Students should be able to use computers for modelling 
and simulation.

Students should be able to use a simple statistical package.

Students should be able to use suitable graphics tools.

Students should be able to create and play music using 
hardware and software.
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A Peek in the Past
The checklist has exposed the demand that every student must have the 
capability to use technology for a variety of purposes and for a wide range 
of domains. The focus of technological advancement today is actually 
on (1) integration of technology knowledge and skills in the 4Cs or 21st 
century skills and (2) students’ college readiness. 

Do you think that these two were also the goals for technology innovation 
and development in the past? Study the organizer shown and review the 
factors that have influenced changes in ICT. 

Evolution of the web
Based on the timeline, the Internet has provided a lot of services that 
users have enjoyed since its creation, one of which is the World Wide 
Web (WWW). But did you know that it also has evolved into something 
which provides users a wide range of services? Look at how the Web has 
evolved.

REALIZATION OF AN 
EDUCATIONAL CRISIS

TIME OF CHOICE 
AND INNOVATION

FOCUS ON 21st CENTURY SKILLS 
AND COLLEGE READINESS

Digital Age

1980s

The Age of Processing

Tech as a Peripheral Tool

Hardware 2.0

1990s

World Wide Web

Tech begins to Supplement

HOW DO WE MEASURE PROGRESS
AND INCREASE ACCOUNTABILITY?

Smart + Portable

2000s

Connectivity

Tech Supplements Instruction

Multifunctual Devices

TODAY

Personalization

Tech as an Integrated Tool

(1982) 
Digital 
Storage

(1997) 
Video &

Data Storage

(2001) 
Apple
iPod

(2002) 
Laptop

(2004) 
GPS

(2003) 
Blu Ray

(2013) 
Microsoft 

Surface Pro

(2016) 
Samsung
Galaxy S7

Edge

(2013) 3D
Printer

(2015) 
Gear VR

(2011) 
Google+

(2011) 
Snapchat

(2015) 
Windows 10

(2010) 
Quora

(2013) 
Edmodo

(2013) 
Moodle

(2010) 
Udemy

(2010) 
Lumosity

(2003)
Linkedin

(2004)
Facebook

(2007)
Dropbox

(2006)
Twitter

(2003)
Haiku LMS

(2004)
Innosight
Institute

(2007)
Knewton

(1993) 
Intel 

Pentium

(1995) 
Play 

Station 

(1991) 
Super

Nintendo

(1997) 
Florida

Virtual School

(1997) 
Blackboard

(1995)
 ebay

(1993) 
MSN

Hotmail

(1995) 
Yahoo 

(1991) 
Windows

98

(1983) 
 Microsoft 

Word

(1981) 
The

Oregon Trail
for Apple II

(1989) 
Math

Blaster

(1983) 
SunGard 

Data 
Systems Inc.

(1985)  
Windows 1.0

(1979) 
Apple II

(1985) 
NES Video

Game Console

(1979) 
Walkman

1969 1973 1976 1982 1990 1994 1995 1998 1999 2003 2004 2005 2007 2009 2010 2012 2014 2016

ARPANET

ETHERNET

WORLD-WIDE-WEB

INTERNETFTP & TCP/IP ?

?
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In 1989, Tim Berners-Lee, a British scientist, invented the World Wide 
Web. Simply known as the Web, it is an open-source information space 
where documents (formatted and annotated using HTML and other 
web resources) are identified by Uniform Resource Locators (URLs) 
interlinked using hypertext links and accessed via the Internet. It is 
considered as central to the development of the Information Age and 
used as a primary tool of people to interact with the Internet.

A big leap came with version 2 of the Web, or Web 2.0 in 2004, as defined 
by tech moguls Tim O’Reilly and Dale Dougherty, though the term was 
originally coined by Darcy DiNucci in 1999. Web 2.0 had no update on 
technical specifications, but rather on the cumulative changes in the 
way web pages were made and used. Web 2.0 was the Read-write Web, 
Web of Interaction, or Participative Web. A Web 2.0 site allowed users to 
interact and collaborate with each other through social media dialogue 
where they could create user-generated content in a virtual community. 
These included social networking sites, blogs, folksonomies, wikis, video 
sharing sites, hosted services, web applications, and mashups. 

Web 3.0 is historically known as the Semantic Web or Web of Data as 
Tim Berners-Lee coined it. The Semantic Web is an extension of Web 2.0 
by virtue of the standards of the World Wide Web Consortium (W3C). As 
stated by the W3C, “The Semantic Web provides a common framework 
that allows data to be shared and reused across application, enterprise, 
and community boundaries.”
 
To some Internet experts, Web 3.0 worked as a personal assistant. 
When you type “tourist spot destination under PHP 10,000” on a Web 
3.0 search engine, the results might include a list of fun activities or 
great restaurants related to the search results along with the results 
themselves. A Web 3.0 search engine could find not only the keywords in 
your search, but also interpret the context of your search. 

The more you browse the web, the more information about you is stored. 
Your search results include your preferences based on your browsing 
history, the songs you like to hear, the food you like to eat, and the places 
you want to see, among others.

Web 1.0/2.0/3.0 Summary
             Crawl              Walk               Run

           Web 1.0            Web 2.0            Web 3.0

Read-Only Read-Write Portable & Personal

Company Focus Community Focus Individual Focus

Home Pages Blogs/Wikis Lifestreams/Waves

Owning Content Sharing Content Consolidating 
Content

Web Forms Web Applications Smart Applications

Directories Tagging User Behavior

Page Views Cost Per Click User Engagement
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Latest Technology Trends 
Gartner, Inc., a leading information technology research and advisory 
company, highlighted the Top 10 Strategic Technology Trends of 2017 
at their Gartner Symposium last 2016 in Orlando, Florida. What follows 
is an infographic summarizing the 2017 trends they identified based on 
three themes, namely, intelligent, digital, and mesh. 

In which way do you 
think Intelligent apps will 
help you in your daily 
tasks?
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AI and Advanced Machine Learning – this is composed of many 
technologies and techniques (deep learning, neural networks, and 
natural-language processing) that make smart things “intelligent.”

Intelligent Apps – virtual personal assistants, like Siri and Google 
Home, that perform some human assistance functions, making 
tasks easier.

Intelligent Things – This refers to the physical things that 
are imbued with machine learning capabilities through rigid 
programming. Examples are autonomous cars, like Google Car, 
drones, Internet of Things (IoT) smart appliances, and many more. 
Gartner sees a future where these devices will have a collaborative 
“intelligent things” model rather than a standalone one.

Virtual and Augmented Reality – this refers to the immersive 
technologies that are now dominating the market. Basic virtual 
reality is now accessible to consumers through different wearables, 
like VR boxes that are cheap, and smartphones capable enough of 
running VR apps downloaded through app stores. Though these 
are more focused right now on gaming, VR and AR technology 
advancements will soon show how these would be useful in other 
aspects of society, like business and research.

Digital Twin – this refers to the dynamic software model of a 
machine or a thing or system that uses data from various sensors 
to do autonomous actions such us comprehension, reaction, 
and improvement of operations. This includes a combination of 
metadata and analytics.

             Crawl              Walk               Run

           Web 1.0            Web 2.0            Web 3.0

Banner Advertising Interactive 
Advertising

Behavioral 
Advertising

Britannica Online Wikipedia The Semantic Web

HTML/Portals XML/RSS RDF/RDFS/OWL
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Blockchain and Distributed Ledgers – according to Gartner, Inc., a 
blockchain is “a type of distributed ledger in which value exchange 
transactions (in bitcoin or other tokens) are sequentially grouped into 
blocks. Each block is chained to the previous block and recorded across 
a peer-to-peer network, using cryptographic trust and assurance 
mechanisms. Blockchain and distributed ledger concepts are gaining 
traction because they hold the promise to transform industry operating 
models. While the current hype is around the financial services industry, 
there are many possible applications, including music distribution, 
identity verification, title registry and supply chain.”

“Distributed ledgers are potentially transformative but most initiatives 
are still in the early alpha or beta testing stage,” said Mr. Cearley of 
Gartner, Inc.

Conversational System – We have Siri on our Apple devices and Cortana 
for Windows devices helping us as Virtual Personal Assistants. Through 
evolution of technologies such as Google Home, these conversational 
devices will not be limited to a single device, but instead be connected 
to a network of multiple Internet of Things devices like house lights, air 
conditioning units, and many more.

Mesh App and Service Architecture (MASA) – According to Gartner, 
Inc., MASA “enables users to have an optimized solution for targeted 
endpoints in the digital mesh (e.g., desktop, smartphone, automobile) 
as well as a continuous experience as they shift across these different 
channels.”

Digital Technology Platforms – these are the platforms that enable a 
digital business. The following platforms are identified by Gartner: 
information systems, customer experience, analytics and intelligence, 
the IoT, and business ecosystems.

Adaptive Security Architecture – Constant processing of information 
requires better, ultra-efficient architectures to handle the demand. 
Field programmable gate arrays, or FPGAs fuel the advanced system 
architecture which allows systems to run at ultra-fast speeds and almost 
mimicking the human brain. These FPGAs will allow smart systems and 
advanced machine learning to be applied to almost all smart devices like 
smart cars, smartphones, and even smartwatches.
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A. Defi	nition	of	Terms.	Write	the	defi	nition	of	the	terms	in	the	graphic	organizer	using	your	own	
words.

B. Situation Analysis. Read the following news items online. Identify the following: (a) the 
challenge or problem, (b) the technology used to address the challenge, and (c) how the technology 
empowered the individuals involved.

http://health.usnews.com/wellness/articles/2017-01-18/how-technology-helps-patients-and-other-visitors-
navigate-hospitals.

1. US News (Health)
    “How Technology Helps Patients and Other Visitors Navigate Hospitals” by Ruben Castaneda

a b c

             Empowerment

Information Literacy  Technology Literacyy

       Empowerment Technology

  ChECK



Philippine Copyright 2017 18

http://www.forbes.com/sites/quickerbettertech/2017/01/22/google-maps-can-now-help-you-park-and-other-
small-business-tech-news-this-week/#1c649511151c

http://www.timesofisrael.com/israel-tech-helps-us-speed-up-passport-procedures/

http://www.rappler.com/business/industries/biztech/142853-carpooling-wunder-metro-manila-transportation

 2. Forbes.com 
     “Google Maps Can Now Help You Park And Other Small Business Tech News
     This Week” by Gene Marks 

a b c

 3. Times of Israel 
     “Israel tech helps US speed up passport procedures” by Shoshanna Solomon 

a b c

 4. Rappler.com 
     “Carpooling app helps Manila commuters create transport fixes” by Katerina Francisco 

a b c
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https://technology.inquirer.net/56108/facebook-brings-digital-halo-halo-hackathon-philippines

C.	 Compare and Contrast. Do an online research to find out the key features, advantages, and 
disadvantages of the technologies shown in the chart. 

Social Media

Discussion and Information Platforms 

5.  Inquirer.net 
     “Facebook brings Digital Halo-Halo Hackathon to the Philippines” by Karl Angelica Ocampo 

a b c

   Key Features      Advantages    Disadvantages         Purpose

Facebook

Twitter

Tumblr

   Key Features      Advantages    Disadvantages        Purpose

Blog

Vlog

Podcast
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File Sharing Platforms

Video Sharing Platforms

  buILD

Your main output for this course is a social change project related to the 
track or strand you are pursuing for Senior High School. To help you 
prepare for this, brainstorm for initial ideas. 

On the chart, list down some issues or challenges that you can observe 
in your community or locality and take note of the individuals or groups 
affected by each. Reflect and write on why you want to address each issue 
or challenge you have noted. 

   Key Features      Advantages    Disadvantages        Purpose

Google Drive

Dropbox

Podcast

   Key Features      Advantages    Disadvantages        Purpose

Youtube

Vimeo

Dailymotion

To get an idea for a 
good social change 
project, you may visit the 
following websites and 
read through the ideas 
already implemented 
around the globe: 

http://www.
socialchangeprojects.
com.au/

http://www.edweek.org/
tm/articles/2013/09/18/
tln_bohstedt.html

https://www.dsc.org.uk/
category/management-
leadership/project-
management/

EQuIP
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Social Issue Who are affected by the 
issues?

Why do I want to address this 
issue?

1

2

3
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  EXPLorE
You learned about the meaning and importance of empowerment 
technologies in the previous lesson. By working on a project, your group 
identified issues to be resolved. Now you will learn about research. What 
is the proper way to do research?

Where do you often get information for your projects? Fill out the 
graphic organizer below.

  Research 
     Topic

Printed reference online reference

LESSon 2 how CAn I uSE ThE InTErnET 
AS A TooL for EffECTIvE 
rESEArCh?Target

By the end of this lesson, 
you will be 
able to
  
• Use the Internet as a tool  
 for credible research and  
 information gathering
• Gain awareness on   
 cybercrimes.
• Practice computer ethics,  
 online safety, and   
 security.

Philippine Copyright 201723
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   EXAMInE

You have an assignment in an Italian Art Appreciation subject in which 
you	are	tasked	to	look	for	artworks	featuring	“Madonna.”	The	only	clue	
given	to	you	by	your	professor	is	the	word	“Madonna,”	which	is	a	word	in	
medieval Italian that refers to a noble or important woman. 
How would you search for it?

 A.

 B.

 C.

Be	honest	with	your	answer	and	do	not	try	to	Google	it.	Most	of	the	time,	
we	 simply	 enter	 the	 word	 Madonna	 without	 considering	 what	 might	
appear. If you answered C, something similar to the following example 
will appear in the search results. 

What if you answered A? Try Googling it and you might get lost.

Contextualized online Search and  
research Skills
Contextualized search can be defined as a skilled or optimized way 
of searching the Internet based on the “context” provided, therefore 
narrowing down the results given back to you by the search engine 
(Feldman, 2012). This increases the chances of you receiving the most 
appropriate reply to your query. 

Often, people search 
Google with the limited 
information we have, 
but it is enough if you 
want to fi nd specifi c 
information. Search 
engines require context 
for it to give you the 
most relevant results.
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What Is Research?
In our world of expanding access to the Internet, research has become a 
common term that is used when “looking for something” online. Whether 
you search for a definition of a word you don’t know, look for car sales 
online, or look for a recipe for food you like, it is now considered research. 
Committing errors when searching for information such as these does 
not matter much because it generally does not affect other people. 
According to the authors of the book, Research Skills for Students, this 
kind of “research” is called personal research. The research we do at 
schools, on the other hand, is called professional research (Allison, et 
al., 2016). 

Although personal research is also important in daily tasks, this lesson 
shall focus on professional research, as it is exceedingly important in the 
academic world, and it is the type of research you will be doing in this 
courseware.

By definition, research is a systematic inquiry that attempts to provide 
solutions to existing problems and questions using facts and data. This is 
usually presented in a form where all methods and procedures conducted 
are recorded so that they can be viewed and accessed by others. 

Why Is It Important?
Although there are several forms of research, such as original research 
(primary source), scientific research (providing explanations about the 
world), humanities research (as in historical and sociological research), 
and artistic research (practice-based research), they all have the same 
purposes: to discover new information, to interpret existing facts, to 
revise accepted knowledge in light of newly discovered facts, or to apply 
theories and laws into practice. (www.merriam-webster.com, 2017)

Thomas Edison is widely known as the inventor of the light bulb, but he 
was not the true inventor. 78 years before Edison’s light bulb became 
popular, Humphry Davy developed the Arc-Lamp, which was the first 
electric light device. Like other inventions, though, it was not without 
flaws. The Arc-Lamp did not stay lit for very long and was too bright. 
The British physicist Joseph Swan discovered that carbonized paper is a 
better filament material for light bulbs, but he could not make his design 
more efficient and last longer than it did. 

With the help of Thomas Edison and after rigorous experimentation, 
Swan and Edison found better materials to use, and their companies 
merged to sell the improved light bulb design. Edison, though, was the 
only one remembered by most people (Skillicorn, 2016). 

Primary sources refer to 
the first-hand acquisition 
of information from 
experiments, events, 
phenomena, and 
observations.

Thomas Edison holding 
his invention
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Professional researchers (inventors included) produce results based 
on the works of their predecessors. Successful inventions, most of the 
time, are products of reworking previously made inventions, or were 
made	based	on	 the	 results	of	 the	previous	 inventions.	Most	 research	 is	
conducted while considering the work of others as references.

Research on healthcare is especially important. Without further research 
or verification, a claim may mislead people or even endanger lives. Even 
in this day and age, there are still gaps in the body of knowledge that man 
has produced, especially in medical science. For every cure, treatment, 
or medicine, intensive research and clinical trials are performed before 
they are approved to ensure the safety of the people who are to avail of 
the benefits.

what Are the research Skills I need to Develop?
Searching for answers to questions you have for your project requires 
more than just a simple Google search. You need to have proper skills 
that will enable you to gather useful and credible information online. 
According to Scholastic, the following are the online research skills 
students need (Hudson, 2017).

Check Your Sources

Evaluate the information you gather from your sources, whether 
they are from books, online articles, news sites, or websites. Consider 
the benchmarks for evaluating a website: currency (is it up to date?), 
security (does it ask for too much private information from you?), scope 
(is the content in-depth or too shallow?), and authority (who wrote the 
content? Is he an expert?).

Ask Good Questions

Be specific when entering queries into search engines. It gives the search 
engine proper context regarding what you are looking for, therefore 
enabling the engine to give you better search results. You can also use 
the special keys to use when searching. See the following infographic.

You can learn more 
about Google search 
engine conventions here:

http://guides.lib.
berkeley.edu/GoogleTips

EQuIP
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Go Beyond the Surface

Be persistent in looking for more information regarding your topic. 
One common lapse of student researchers is that they only look for 
information in the first search result they find on search engines. There 
are times when information in the 10th result is more useful than the 
information in the first one you see. Try looking for other sources rather 
than sticking to one.

site:
Only searches the 
pages of that site

site:nytimes.com ~college ”test scores” -SATs 2008..2010

“   ”
Searches for the exact phrase

and each of he words separately

-
Excludes this term

form the search

-
Excludes this term

form the search

~
Will also search related words, such 
as ‘higher education’ and ‘university’.

filetype:
Searches only results of the file type you
designate. Can use for pdf, doc, jpg, etc.

filetype:pdf air speed intitle:velocity of *swallow 

intitle:
Only shows results with that word in

the title (in this case, ‘velocity’)

*
Replaces itself with common terms in your search (in this case, Red Rumped swallow

and lesser Striped swallow will be both be searched, along with many others). 

How To Google It

How To Google It

jlnepomuceno
Sticky Note
WHY IS THIS THE SAME CONTENT WITH THE "SATs"
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Be Patient

There are times when the Internet does not provide the information you 
are looking for. You may not find the exact answer to your query, but 
bits of data are scattered all over the Internet. You just need to think 
critically and synthesize the data you have gathered until you yourself 
can formulate your own conclusion.

Respect Ownership

Remember that everything on the Internet, be it text, images, ideas, 
audio, or any other form of information, has its own respective owner. 
Illegal acquisition, distribution, or reuse of any of these may result in 
copyright infringement. These will be discussed in further detail in the 
succeeding topics.

Use Your Networks

Social media and other information tools like Wikipedia and online 
forums are useful when doing research. Social media can provide various 
and nuanced perspectives on the information you need. Sources like 
Wikipedia, however, should be evaluated before you use the information 
from it. The sources cited on Wikipedia, however, are a practical starting 
point in gathering credible information. We will discuss other good 
sources of information in the succeeding topics.

ICT Tools useful in research
As stated earlier, it is strongly advised not to limit yourself to the top-
level results provided to you by your search engine. The following are 
websites, webtools, and online documents that may provide you with 
better access to the information you are looking for. 

google Search
By far, Google Search is the most popular and powerful search engine 
in the 21st century. Owned by the multinational technology company 
Google, this search engine has evolved from a simple search engine into 
a smart one, which is capable of searching the web through voice input 
and filtering the results according to your behavioral data gathered by 
the search engine.

google Scholar
Google Scholar, another product from Google, gives users, especially 
researchers, a simpler way to search for scholarly literature on the 
Internet. Using Google Scholar, you can search for research papers, 
articles, books, court rulings, and other sources of information. This is a 
great tool when looking for contents for the Related Literature section of 
your research papers. 

You can learn more 
about Google Scholar 
here:

https://scholar.google.
com/intl/en/scholar/
about.html

EQuIP
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online Journals
A journal is a periodical publication that contains scholarly articles 
relating to a particular discipline or field of study. These are often 
published by academic or scientific institutions (including universities), 
and the contributors are researchers, professors, doctors, and other 
professionals in their respective fields. Articles in journals are different 
from newspapers. Newspapers are intended for general readers while 
journal articles are intended for academics and people who are engaged 
in specialized fields of study. These kind of articles, most of the time, are 
the most useful as primary information sources for research.

Online journals, in turn, are scholarly publications released in a format 
accessible via the Internet. In other words, the journals that are kept 
in your school libraries and other libraries in the world are kept in 
the Cloud or Internet in digital format. Oxford University Press is an 
example of an online journal repository.

In the age of smart 
devices, search queries 
are no longer confi ned 
to keywords. You can 
now search online using 
apps and devices that 
listen in and use audio, 
specifi cally spoken 
voice. Some apps use 
images to look for things 
on the Internet. Here 
are examples of such 
services that expand the 
possibilities in doing 
research:

The MusixMatch app 
recognizes the melody a 
person is singing.

The Pinterest app lets 
users search using their 
cameras or images in 
their devices.

Automated personal 
assistants such as Siri, 
Cortana, and Google 
Now listen to the user 
speak and help them 
search for things online, 
among other things.

EQuIP
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Academic Websites
Wikipedia is a common starting point when conducting research. 
However, the content that you are going to use when writing your paper 
must be taken from the cited references for the Wikipedia article and not 
the article itself. The primary source is not only a more reliable source, 
it may also contain information that you can use to support your claims.

There are many academic websites and libraries that provide electronic 
copies of papers, journals, books, videos, and audio recordings that may 
aid you in the research  process. The following are some of the most 
notable.

Internet Archive

The Internet Archive is a non-profit electronic library that has a free-
to-access collection of digitized materials ranging from websites, 
multimedia files, and academic materials. A large number of books, 
including modern ones, can also be borrowed from the Open Library, 
also run by the Internet Archive.

EBSCOhost

EBSCO is another digital library that offers premium fee-based access 
to mainly academic materials that are normally not available for public 
use. It runs a service called EBSCOhost that provides an online research 
database with full-text digital copies of books, medical references, and 
historical archives.

JSTOR

JSTOR is another digital library that is 
primarily licensed to academic, scientific, 
and other research and educational 
institutions. Like EBSCOhost, it 
provides full-text searches of books, 
primary sources, and other reference 
and scholarly materials. JSTOR is a part 
of ITHAKA, a non-profit organization 
that promotes sustainable research 
and teaching in the academe via digital 
technologies.

ICT Safety, Security, and Netiquette
The Internet is a vast network of computers where many users, content, 
tools, and resources are made accessible. You do homework and research 
papers with the help of the Internet. You communicate with your peers 
through the Internet. You do all of this maybe at home, in computer labs, 
or in computer shops. They make it convenient for you to finish your 
work easily. But at what cost?
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Verification of Online Source Materials
Cramming is one of the many problems of students, especially when 
doing homework. Days pass, and at midnight before the deadline, you 
realize you have homework to do. You fire up your computer and search 
for the answers to your assignment. But are the websites where you get 
your answers reliable? What if they are spoof sites? Or what if they are 
just opinions of the authors and they are not factual? This might get you 
into trouble, especially if you are doing a research paper.

It is best to do your research far ahead of the deadline to allow yourself 
some time to evaluate and verify the sources of your homework. Follow 
the criteria below when evaluating your source material.

•	 Currency – Is the information up-to-date?
•	 Security - Does the site ask too much personal information?
•	 Scope - Is the information in-depth?
•	 Authority – Does the information come from a trusted expert?

Computer Ethics and Netiquette
Computer Ethics is a new branch of ethics that is concerned with 
standards of conduct in the use of computers. It deals with how 
computing professionals should make decisions regarding professional 
and social conduct.

Following the 1987 memo on ethics of the Internet Advisory Board, the 
Computer Ethics Institute created the Ten Commandments of Computer 
Ethics in 1992 which were introduced by Ramon C. Barquin in his paper 
entitled “In Pursuit of a ‘Ten Commandments’ for Computer Ethics.” 
It is a means to create “a set of standards to guide and instruct people 
in the ethical use of computers.” It copies the archaic style of the Ten 
Commandments from the King James Bible.

There are several activities that you can do using online services: search 
topic, read articles, log in to your online accounts, e-banking, write 
comments, post pictures, chat with a friend via social networking sites 
(SNS), and others. But the more information you put or use online, 
the higher the risk placed on your online safety. You can be a victim of 
identity theft, phishing, malware infections, etc. It is your responsibility 
to secure your information online as well as maintain good etiquette 
when using these services.

Internet ethics, or netiquette, is a set of rules that determines how to 
properly communicate and browse the web.

The following are some of the good practices when using the Internet:

1.	 Always keep your software or application updated and uninstall the ones 
that you do not use. 

2.	 Do not divulge sensitive information online, especially on unsafe websites.
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3.	 Be careful when dealing with emails from unknown sources or spam.
4.	 Run your antivirus software before going online.
5.	 Think before you click. What you post on the Internet may stay online 

forever.

Intellectual Property Rights (IPR)
The biggest issue surrounding ICT concerns the violation of intellectual 
property rights (IPR), which is the act of stealing other people’s works 
and ideas, whether knowingly or unknowingly. For example, when you 
buy a book, the author or publisher earns money, but if you borrow a 
book and photocopy it, you technically do not pay for it—the author or 
publisher of the book does not get anything in return for the use of the 
book. The latter is one form of IPR infringement, no matter how subtle.

Another common form of IPR infringement is when you use other 
people’s work, such as images, movies, or music, and alter them or 
combine them into a different work, such as those used in YouTube fan-
created videos and image modifications. There may be no intention on 
profiting from such work but it is still considered as IPR infringement.

Intellectual property laws (IPL) protect the rights of people to maintain 
legal ownership of their works and ideas. It covers their right to control 
how their work can be consumed by the general public, including 
whether their work can be acquired or used for a cost. Someone who 
takes the work or idea of another person and claims it as his own may be 
accused of theft. But IPR is not a given right: they have to be applied for 
and granted to the applicant by the proper authorities. Otherwise, the 
contents of a book that you have written or the blueprint for an invention 
you have made may be claimed freely or used by others for profit without 
your knowledge or permission. There would be no legal basis for you to 
claim ownership of the material.

Granting ownership of an idea to a person is not an easy thing to do. 
There are instances when an idea must be elaborated and organized 
properly before the petitioner can be granted exclusive rights to it. On 
the other hand, a copyright can also be automatically claimed by the 
originator of an idea without the need to apply for rights if he already 
has a record of what he has produced.

Artworks, novels, short stories, poems, music, and movies are only some 
of the copyrighted things that are available on the Internet. These can be 
copied without a single centavo given to the authors of the works. The 
Internet is only one of many platforms where they are distributed. Other 
instruments used for piracy include digital video cameras, MP3 recorders, 
and optical disc burners for CDs and DVDs. In order to minimize the 
incidence of illegal copying of intellectual material, manufacturers have 
been cautioned about making and designing products that allow easy 
and multiple duplication of media files.

THE TEN 
COMMANDMENTS OF 
COMPUTER ETHICS

1.	 Thou shalt not use 
a computer to harm 
other people in any 
way.

2.	 Thou shalt not 
interfere with other 
people’s computer 
work.

3.	 Thou shalt not sneak 
around in other 
people’s computer 
files.

4.	 Thou shalt not use a 
computer to steal.

5.	 Thou shalt not use 
a computer to bear 
false witness.

6.	 Thou shalt not copy 
or use proprietary 
software for which 
you have not paid.

7.	 Thou shalt not use 
other people’s 
computer resources 
without authorization 
or proper 
compensation.

8.	 Thou shalt not 
appropriate other 
people’s intellectual 
output.

9.	 Thou shalt think 
about the social 
consequences of 
the program you are 
writing or the system 
you are designing. 

10.	 Thou shalt always 
use a computer in 
ways that ensure 
consideration and 
respect for your 
fellow humans.

(Computer Ethics 
Institute, n.d.)
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Avoiding Plagiarism
In your project and in other research papers, you will always be asked 
to add information about your paper by citing information taken from 
other research materials. This is very risky especially if you might fall 
into the plagiarism trap. To avoid that, try to follow WriteCheck’s 6 Ways 
to Avoid Plagiarism in Research Papers (WriteCheck, 2017).

Six Ways to Avoid Plagiarism

1.	 Paraphrase - Read the material you wish to use and rephrase it in your 
own words. Using two words consecutively must be avoided. However, in 
a situation wherein it cannot be avoided, quotation marks must be used.

2.	 Cite - Proper citation must be observed when referencing existing material. 
Several guidelines are observed when writing research papers and reports 
depending on the industry standard. Examples are the guidelines established 
by the Modern Language Association (MLA), the American Psychological 
Association (APA), the Associated Press (AP), and the Chicago Manual of 
Style. Citation often requires the name of the author of the material you 
intend to reference and the publication date

3.	 Quoting – Directly quoting the source material is recommended in order 
to avoid misquotation or misinterpretation. However, many institutions 
generally discourage the use of “block quotes.” Block quotes are direct 
quotations that are 40 or more words long and are usually separated from 
the main text. It is still best to paraphrase your source materials and avoid 
quoting directly as much as possible.

4.	 Citing Quotes - The methods of citing quotes and citing the paraphrased 
material generally differ. The former often includes the page number 
written after the name of the author if the source material is a book, a 
magazine, or a newspaper, among several other sources.

5.	 Citing Your Own Material -  Although the reference you may want to use is 
your own work, it is still necessary to cite yourself as you would the work of 
another person. Failure to provide citations for your own material is known 
as “self-plagiarism.”

6.	 Referencing - Apart from citing direct quotes and paraphrased text, it is 
also important to provide a page for references and other materials used 
at the end of your work. Information such as the title of the work (as well 
as the title of the publication or website, in certain cases), the name of the 
author(s), the publication date and place, and the universal resource locator 
of the source (for websites) are among the details that must be provided. 
The format for your references will depend also on the standard required 
by the institution or industry you will present your work to.
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  ChECK

Test I. Explicit Contextualized Search. Write the correct query for 
the following statement using the search engine operators.

           Search Requirements                       Query

1.   A Website mentioning your       
      exact name.

2.   Websites with the keywords and 
      any other word after it such 
      as office productivity tools, office 
      productivity software, etc.

3.   PDF papers on societal change.

4.   Statistics of social media users 
      from year 2007 to 2016.

5.   PowerPoint presentations 
      regarding social change projects.

Test II. Enumeration. List down 6 skills in research you need to have 
and explain what it is.

Skill Description
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    buILD
After learning the essential techniques and standards in data gathering 
via the Internet, you should now be able to gather data relevant to your 
project. Look for at least five articles or discussions that will support 
the claims your project attempts to establish. Follow the criteria for 
choosing a reference website and use proper citation. Use the table that 
follows as your guide to getting the information you need for your study. 
(Use a separate sheet of paper.)

Test III. Essay. How does social networking help you in your daily life?
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Research Journal Specification Table

Topic 1 Topic 2 Topic 3

Title of the 
Research /

Article

Authors/
Copyright/
Source or 
Reference

Abstract

Objective and 
scope
of the
study

Significance

Methods

Results
and 

Conclusion



  EXPLorE
In the previous lesson, you have learned how to gather reliable 
information such as articles and other resources for your project. In this 
lesson, you will learn how to use proper citations for derivative content 
intended for your project pitch. You will also learn the purpose of using 
Track	Changes	and	other	advanced	Microsoft	Word	 tools	 in	publishing	
papers.

Term, research, and thesis papers usually come around at the end of the 
semester. Unlike essays, these papers require extensive research, citation 
of sources, and seemingly endless revisions. You print and submit the 
first draft to your professor or teacher, he/she evaluates it, and later, 
returns it to you with editing and proofreading marks only to find out 
that almost 90 percent of your work need to be revised. You update your 
work and print again, but the teacher still finds writing mistakes in the 
paper. The cycle is painstaking, but, you need not do that because there’s 
MS	Word	to	the	rescue	and	it	already	has	a	proofreading	tool	along	with	
other useful editing tools that you may or may not be aware of. 

To make an assessment of Word tools and know which you have been 
using before, check all that you are aware of in the table below.

Text Basic Headers
Checking 
Spelling and 
Grammar

Formatting Text Picture and Text 
Wrapping

Track Changes
and Comments

Page Layout Formatting 
Pictures

Finalizing and 
Protecting 
Documents

Printing 
Documents Shapes SmartArt

Line and 
Paragraph 
Spacing

Textboxes and 
WordArt Mail Merge

List Tables Styles

Hyperlinks Chart Reference

LESSon 3 how Do I uSE ADvAnCED worD 
TooLS To DEvELoP ConTEnT?Target

By the end of this lesson, 
you will be able to
  
• Create original or   
 derivative content while  
 carefully citing sources   
 using advanced MS   
 Word tools in Citation.
• Proofread existing   
 content using advanced  
 MS Word tools.
• Send customized letters  
 to a large group of   
 people using the   
 Mail-Merge feature of   
 MS Word.
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   EXAMInE

Microsoft	 Word	 is	 a	 word	 processing	 application	 developed	 by	 the	
Microsoft	Corporation.	It	lets	you	create	documents	for	your	assignments,	
term paper or research work, letters, and certificates or 
just edit any text document. It provides several features 
that make your work, like copying and pasting text from 
different sources, inserting objects, laying out content, 
and editing and proofreading documents, much easier. 

In the example above, proofreading marks are written on 
the printed document where the writer will refer to when 
revising his work on the computer. But what if your editor 
is from elsewhere far and sending a printed copy is not practical? What 
if you wanted to save on printing costs because of price hikes in paper 
and	ink	products?		MS	Word	offers	a	feature	that	allows	you	to	proofread	
any document, check the spelling and grammar, track the changes made, 
and add comments. It simplifies not only the checking part but also the 
revision of the document.

The	next	section	discusses	some	of	the	features	of	MS	Word	that	you	can	
use to make you more productive and assist you in the creation of your 
project documentation. These features are:

1. References: Citations and Bibliography 
2. Review: Spelling and Grammar
3. Review: Tracking Changes
4. Mail	Merge

references: Citations and bibliography
In writing a research paper, you will most 
likely get information from the Internet. This 
gives you easy access to needed ideas and 
information but puts you at risk in committing 
plagiarism. To prevent committing that 
offense, you need to learn how to paraphrase 
text and add citations. You can do this 
manually, but if you must regularly update 
your list or use a different style, you will have 
to redo everything. The solution is available in 

Word. All you have to do is to input the sources of information and Word 
will create and update your bibliography or references automatically.

Donald Trump’s 
conservative 
commentator, Monica 
Crowley, soon to serve 
a top role in national 
security communications, 
committed plagiarism 
in her Ph.D. dissertation 
(CNN KFile, 2017). If 
you were asked by Ms. 
Crowley to help her fi x 
her dissertation, how 
would you help her cite 
her sources properly?

InTEgrATE

What can you notice in 
the document?

How did the editor 
proofread the 
document?

Did you know that 
you can proofread 
documents 
electronically?
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Follow the steps in creating your bibliography:

1.	 Choose your reference style. Different 
academic disciplines use their own style 
guides. Better ask your teacher what is the 
required style guide for your document. Style 
guides to choose from are APA, MLA, and 
Chicago. To do this, click the References tab, 
then select the desired style in the Citations 
& Bibliography group.

2.	 Add Citations and Sources. You need 
to cite the authors in your documents for 
the information you got from them. To do 
this, click the Insert Citation command in 
the References tab, and select Add New 
Source. A dialog box will appear. Just enter 
the requested information, like the author’s 
name, title, and publication details. Then, 
click OK.

3.	 Insert the bibliography. You can easily create the bibliography or 
references at the end of your document once you encode the list of sources 
in step 2. In the References tab, select the Bibliography command, 
then choose the desired style. (GCF Learn for Free, 2016)

Checking Spelling and Grammar
In Word, you don’t have to worry about your spelling and grammar. One 
of the features of Word is to correct your spelling and grammar which 
can help you produce a more professional document.
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How to Run Spelling and Grammar Tool
1.	 Click the Spelling & Grammar command from the Review tab.

2.	 The Spelling and Grammar pane will appear. Word will try to give one 
or more suggestions for each error in your document. You can select a 
suggestion and click Change to correct the error.

3.	 Word will move through each error until you have reviewed them all. 
After reviewing all the errors, a dialog box will appear confirming that the 
spelling and grammar check is complete. Click OK.

4.	 If no suggestions are given, you can manually type the correct spelling in 
your document.

Ignoring “errors”

The spelling and grammar check is not always correct. There are many 
grammatical errors Word would not notice. There are also times when 
the spelling and grammar check will say something is an error when it’s 
not. Usually, this happens with people’s names and other words not in 
the dictionary.

If Word says something is an error, you can choose not to change it. 
Depending on whether it’s a spelling or grammatical error, you can 
choose from several options:

For spelling “errors”:

•	 Ignore: This will skip the word in question without changing it.
•	 Ignore All: This will skip the word in question and all other instances 

of the word in the document without changing it.
•	 Add: This adds the word to the dictionary so it will never come up as 	

an error. 
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for grammar “errors”:
•	 Ignore: This will skip the word or phrase without changing it.

For grammar errors, Word provides an explanation for why it thinks 
something is incorrect. This can help you determine whether you want to 
change or ignore it.

Automatic spelling and grammar checking
Word automatically checks your document for 
spelling and grammar errors, so you are informed 
that there is an error without running a separate 
check. These errors are indicated by colored, wavy 
lines.

•	 The red line indicates that the word is misspelled.
•	 The blue line indicates that there is a grammatical 

error, including misused words.

To correct spelling errors:

1. Right-click the underlined word. 

2. Select the correct spelling from the list of suggestions.

3.  The error will be replaced by the corrected word.

To correct grammar errors:

1. Right-click the underlined word or phrase.

2. Select the correct spelling or phrase from the list of suggestions.

3. The error will be replaced by the corrected phrase.

To hide spelling and grammar errors in a document:

If you want to share a softcopy of a document, like a resume, with 
someone, you might not want that person to see the red and blue lines. 
Fortunately, Word has a feature that can hide spelling and grammar 
errors so the lines will not show up on any computer.

Spelling Error Grammar Error
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1.	 Click the File tab to go to Backstage view, then click Options.

2.	 A dialog box will appear. Select Proofing on the left side of the 	
dialog box.

3.	 Check the box of Hide spelling errors in this document only and 
Hide grammar errors in this document only, then click OK.

4.	 The lines in the document will be hidden.

     If you have more than one document, click 
     the drop-down box next to Exceptions 	
     for: and select the desired document. 
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finalizing and Protecting Documents
Want to secure any information you want to keep private and discourage 
others from editing your file?

Fortunately, Word includes several tools to help finalize and protect
your document.

Document Inspector 
Whenever you create or edit a document, certain personal information
may be added to the file automatically. You can use the Document 
Inspector to remove this type of information before sharing a document 
with others.

how to use Document Inspector

1. Click the File tab to go to Backstage view.

2. From the Info pane, click Check for Issues, then select Inspect Document 
from the drop-down menu.

3. The Document Inspector will appear. Check or   
 uncheck the boxes, depending on the content you want  
 to review, then click Inspect. In our example, we’ll   
 leave everything selected.

4. The results will show an exclamation mark for   
 any category found to have potentially sensitive data,  
 and it will also have a Remove All button for each of  
 these categories. Click Remove All to remove   
 the data.
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5.	 When you are done removing, click close.

Protecting your document
By default, anyone with access to your document 
will be able to open, copy, and edit its content 
unless you protect it. Word has several ways to 
protect a document; it all depends on your needs.

How to protect your document

1.	 Click the File tab to go to Backstage view.

2.	 From the Info pane, click the Protect Document 
command. 

3.	 In the drop-down menu, choose the option that 
best suits your needs. Marking your document 
as final will only discourage others from editing 
the file, while they can still view your file. Other 
options allow for even more control if needed.

4.	 A dialog box will appear prompting you to save. Just click OK.
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5.	 Another dialog box will appear. Just click OK. 

6.	 The document will now be marked as final. 

Tracking Changes
When someone will ask you to proofread a hardcopy 
document, the first thing that you might do is to get 
a red pen to cross out sentences, mark misspellings, 
and add comments in the margins. Fortunately, Word 
allows you to do all of these things electronically 
using the two features—Track Changes and 
Comments.

Every change you make to the document will appear 
as a colored markup when you turn on Track 
Changes. If you are going to remove or delete text, 
it will not disappear; instead, the text will just be 
crossed out, and when you add text, it will be 
underlined. This is how Word allows you to see edits 
before saving the changes permanently.
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The good thing here is, if there are multiple reviewers, each person 
will be assigned a different markup color so you can determine which 
changes are from whom.

Turning on Track Changes:

1.	 From the Review tab, click the Track Changes icon.

2.	 Track Changes will now be turned on. Any changes you 
make to the document will appear as colored markups from 
this point.

Reviewing Changes:

The tracked changes are just suggested changes. For these to become 
permanent, they must be accepted. The original author may agree or 
disagree with these changes and choose to reject them.

1.	 First, select the change you want to either accept or reject.

2.	 Click the Accept or Reject command from the Review tab.
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3.	 The markup will then disappear. You may continue accepting or 		
rejecting each change until you have reviewed all of them.

4.	 When you are done, click the Track Changes command to turn off the 
tracking of changes.

If you want to accept all changes, click the drop-down arrow for Accept, 
then click Accept All. If you don’t want to track your changes anymore, 
you can select Accept All Changes and Stop Tracking.
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Track Changes viewing options

It will be distracting if the changes will 
increase rapidly, especially when you will try 
to read through the document. Word provides 
several ways to customize how tracked 
changes should appear. You would have the 
option to hide tracked changes.

To hide Tracked Changes:

1.	 Click the Review tab, then click the Display 
for Review command. You can find this 
command to the right of the Track Changes 
command.

2.	 You can see four options from the drop-down 
menu.

3.	 Choose the desired option from the drop-
down menu. Here, we will select No Markup 
to view the final version of the document 
before we accept the changes..

A simple clickable marker in the left margin is 
also available for you to switch between 
Simple Markup and All Markup.

To show revisions in balloons:

Most of the revisions appear inline by default. 
It means the text itself is marked. In Word, you 
can choose to show the revisions in balloons in 
which the revisions will be moved to the right 
margin. The document will be easier to read 
if inline markups will be removed. Moreover, 
balloons give you more detailed information 
about some markups

1.	 In the Review tab, click Show Markup, then 
Balloons, then Show Revisions in Balloons.

2.	 As you can say, most revisions will be displayed in the right margin.
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If you want the markups to go back to inline, you can choose either Show 
All Revisions Inline or Show Only Comments and Formatting 
in Balloons.

Comments
There are times when you want to add a comment to provide feedback 
instead of changing a document.

To add comments

1.	 You highlight some text, or place the insertion point 	
	 where you want the comment to be displayed.
2.	 In the Review tab, click the New Comment 		
	 command as shown.
3.	 Write your comment, when you are done, close 		
	 the comment box by pressing the Esc key or by clicking 	
	 anywhere outside the comment box. 

You may respond to an existing comment. Just click the Reply button 
and type your response.

To delete comments
1.	 Select the comment you want 	

to delete.
2.	 In the Review tab, click the Delete command.
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3.	 The comment will then be deleted.

If you want to delete all the comments, click the Delete tools folder 
drop-down arrow and click Delete All Comments in Document.

Comparing Documents
If you did some changes in a document without 
tracking them, you can still use reviewing 
features such as Accept and Reject. Comparing 
two versions of the document makes this 
possible. The things you only need are the 
original document and the 	 revised 
document.

To compare two documents:

1.	 In the Review tab, click the Compare 
command, then from the drop down menu, 
select Compare.

2.	 A dialog box should appear. Choose your 
Original document from the list displayed. If the 
file is not on the list, click the Browse button to 
locate it..
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3.	 Select the Revised document, and then click OK.

4.	 Word will then compare the two files to determine the changes and then 
create a new document. The changes will appear as colored markups. You 
can then use the Accept and Reject commands to finalize the document.

The original and revised documents will appear in a 
pane to the right that you can use for reference. Click 
Compare, then Show Source Documents, then 
Show Both, if and only if you don’t see the pane.

Mail Merge
Mail Merge is an effective tool which allows you to 
create multiple letters, labels, envelopes, name tags, 
and more using information stored in a list, database, 
or spreadsheet. When dong a Mail Merge, you must 
have a Word document and a recipient list, which is 
usually an Excel workbook.

How to use Mail Merge?

1.	 Create a new Word document or open an 			 
	 existing one.
2.	 Under the Mailings tab, click on Start Mail Merge 	
	 and select Step-by-Step Mail Merge Wizard…
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3.	 Choose the type of document you want to create. Then click Next: 
Starting document.

4.	 Choose Use the current document, then click 
Next: Select Recipients.

5.	 On the Mail Merge task pane, select Use an 
existing list, then click Browse.

6.	 file and click Open.

7.	 If you are using an Excel workbook, select the worksheet that contains 
the list and press OK

8.	 In the Mail Merge Recipients dialog box, you can control the recipients 
included in the merge by checking or unchecking each box. The default is 
that all the recipients are selected. Click OK when you’re done.

9.	 Click Next: Write your letter from the Mail Merge task pane to move 
to the next Step.

10.	You can now write your letter. When it’s printed, the recipient data will be 
different each copy, but the content of the letter would be the same. You’ll 
need to add placeholders for the recipient data so Mail Merge knows 
exactly where to add the data.
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How to insert recipient data?

1.	 Put the insertion point where you want the information to appear in 		
the document.

2.	 Select one of the four placeholder options: Address block, Greeting 
line, Electronic postage, or More items

3.	 A dialog box may appear with various options, depending on the place 
holder you chose. Select the desired options and click OK.

4.	 A placeholder will appear in your document.

5.	 Repeat the steps each time you want to enter information from 		
your record.

6.	 Click Next: Preview your letters when you are done.

7.	 Make sure that the information from the recipient list appears correctly 
in the letter. You can use the left and right scroll arrows to view 	
each document.
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8.	 Click Next: Complete the merge

9.	 To print the letters, click Print…

10.	A dialog box will appear. Select All, then 	
click OK.

11.	 The Print dialog box will appear. If needed, adjust the print settings, then 
click OK. The letters will be printed
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  ChECK

Test I. Multiple Choice. Read the questions carefully then write the 
letter of the best answer on the space provided.

____1. Using the keyboard only, which buttons would you press to   
    select the entire document?

a. Ctrl + A
b. Ctrl + C
c. Ctrl + F
d. Ctrl + V

____2. What would you click if you want to reverse a recent action?

a. 
b. 
c. 
d. 

____3. To change the font on a Word document, you would need to   
     click which toolbar?

a. Edit
b. Formatting
c. View
d. Tools

____4. What command would you use if you need to change a word in  
     your document to another word?

a. Ctrl + C
b. Ctrl + X
c. F7
d. Shift + F7

____5. You can modify alignment, line spacing, and paragraph spacing  
     in the:

a. Format tab
b. Layout	Menu
c. Paragraph dialog box
d. Styles tab

____6. What will you see if you spell check the phrase “You can check a  
     website and write a document simultanously”?

a. A blue wavy line will appear in the word “simultanously”
b. A green wavy line will appear in the word “simultanously”
c. A red wavy line will appear in the word “simultanously”
d. No errors
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____7. To correct the error in question no. 1, you must 
a.	 select the misspelled word and then delete it.
b.	 select from the list of spelling suggestion
c.	 retype misspelled word and then select the correct spelling 

from the list of suggestion.
d.	 right-click the misspelled word and then select the correct 		

spelling from the list of suggestion.

____8. Mon designed an invitation for their annual thanksgiving and 
	    then emailed it to his supervisor. His supervisor added some 
	    editing suggestions and he agreed with it. How can he finalize 
	    the document?

a.	 Delete the revisions and retype the document.
b.	 In Backstage view, select Proofing, then press OK.
c.	 Under the Review tab, click the Accept drop-down arrow, then select 

Accept All Changes.
d.	 Under the References tab, turn off Spelling and Grammar, then save  

the document.

____9. The Mail Merge feature can be used to address the same letter 
	     to ___________.

a.	 one person
b.	 several different people
c.	 sender
d.	 receiver

____10. Which tab should you use to select the format for your 
	      bibliography list?

a.	 Review Tab
b.	 Page Layout Tab
c.	 References Tab
d.	 Review Tab
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Test II. Challenge yourself. Write	the	sample	letter	in	MS	Word,	then	
find out and correct the errors by using the Spelling and Grammar check 
of	MS	Word.	Be	sure	to	track	also	the	changes	and	add	comments	for	any	
suggestion you like to include in the letter. You may ask teacher if he will 
accept all the revisions you have made before finalizing your document.

You can access various 
references on this 
website:

http://www.
complex.com/pop-
culture/2012/11/the-10-
most-common-internet-
crimes

https://heimdalsecurity.
com/blog/netiquette-
rules-safety/

www.ieeexplore.com

EQuIP
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   buILD

Curate References, Resources, and Solutions

Using all the data that your group gathered for your project, you will 
now prepare your project pitch document. Use the tools and techniques 
you have learned from this lesson and be extra careful in writing your 
content. Refer to the details below.

The Project Pitch document is a 5 to 10 page paper documenting the 
details of your social change project. The following are the elements of 
your project that must appear in the project pitch document. 

Title of the Project 

This refers to the social issue you identified and want to tackle in the 
semester. Your aim is to address this issue by increasing people’s 
awareness about the issue at hand. This should be in question format. 

Objectives of the Project 

This refers to the outcomes your group want to have after the project  
is completed. 

Related Literatures and Resources 

Try to prove your point by presenting articles, researches or statistics. 
Present at least 10 articles here. 



LESSon 4 how Do I uSE ADvAnCED EXCEL 
Target
By the end of this lesson, 
you should be able to

• Construct formulas to   
 manipulate numeric data  
 in an Excel worksheet
• Organize or narrow down  
 data using the Sort and  
 Filter features in   
 MS Excel
• Set up the Chart function  
 of Excel to represent   
 numeric data in multiple  
 formats 

  EXPLorE
In	lesson	3,	you	have	learned	how	to	use	advanced	tools	of	MS	Word	to	
develop, evaluate, and finalize content of your project pitch document. 
You have also refined the details of your project that will guide you 
throughout its development until its end. To proceed, you will now 
learn the advanced Excel tool that will enable you to process the data 
you gathered and present them in a graphical way for easy reference. 
Learning this advanced tool in Excel will help you perform statistical 
tasks that you will encounter in the workplace which are especially useful 
for	 students	 taking	 up	 the	 Accountancy,	 Business,	 and	 Management	
strand.

Here’s a statistical task scenario for you to explore. In a cooking show, 
there	were	two	(2)	finalists	vying	for	the	title	“Master	Pastry	Chef”.	The	
organizers of the show invited five (5) Filipino cuisine experts to judge 
who deserved the title and they also invited you and your friend to 
supervise and tally the scores. Help determine the winner by computing 
the total scores based on weighted criteria. Do this manually and take 
note of the time you have consumed.

Based on your computation, who is the winner? 
 _________________________

How many minutes did it take you to finish the computation?  
 __________________

Judges

Contestant
No. 1

Contestant
No. 2

Taste
(40%)

Presen-
tation
(30%)

Craft/
Technique 

(30%)

Weighted 
Mean

Taste
(40%)

Presen
tation
(30%)

Craft/
Technique 

(30%)

Weighted 
Mean

Judge
1 9 8 8 9 7 8

Judge
2 8 8 8 8 9 8

Judge
3 9 7 8 8 9 9

Judge
4 9 9 9 9 8 9

Judge
5 8 8 9 8 9 9

Total

TooLS To ProCESS AnD PrESEnT 
DATA?
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  EXAMInE

Computing data, especially student’s grades, might take a lot of time 
and effort to do manually on paper using only a pen, a calculator, and a 
separate guide to compute and to identify equivalents of the grades. This 
is the work of a teacher, but what if you were tasked to do something 
familiar?

The computation of grades is arguably more time-consuming than 
computing the scores of a cooking show and it would require more effort 
to do by hand. The following images might have similar content, but the 
input processes and computation requirements are different.

formulas and functions
formulas
Some of the often-used features in Excel are in the Formulas tab. These 
are for calculating numerical information just like a calculator. There 
are two types of formula, simple and complex. A simple formula contains 
only one operation, while a complex formula contains one or more 
operations. You can create formulas by applying cell references.

Mathematical	Operators

Excel uses standard operators for formulas. These are: plus sign (+) for 
addition, minus sign (-) for subtraction, asterisk (*) for multiplication, 
forward slash (/) for division, and caret (^) for exponents. The equals
sign (=) is used to start a formula. A complex formula follows the 
PEMDAS	order.

The P E M D A S Order of Operations
P - Parenthesis (ex. (1+2))
E - Exponential (ex. 2^3)
M	-	Multiplication	(ex.	2*4)	
D - Division (ex 6/2)
A - Addition (ex. 7+3) 
S - Subtraction (ex. 10-5)

			Manual	Computation	 		Computerized	Computation

Think of the advantages 
and disadvantages 
of using the manual 
method of computing 
and computerized 
method of computing.

In what other ways do 
you think you can use 
MS Excel other than 
computing tons of 
numbers?

InTEgrATE
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Cell Reference	

Excel has a feature that allows you to calculate values from 
specified cell addresses. A cell address is combination of a 
column letter (at the top of the spreadsheet) and a row 
number (to the left of the spreadsheet). The cell or set of 
cells involved in a formula is known as a cell reference. 
Using a cell reference will make your formulas more 
accurate.

To create a formula
In our example below, we’ll use a simple formula and cell 
references to calculate the profit gain for a sales report.

1.	 Select a cell that will contain the formula. In our 		
	 example, we’ll select cell B3.

2.	 Type the equals sign (=). Notice how it appears in 		
	 both the cell and the formula bar.

3.	 Click the actual cell or type the cell address of the 		
	 cell you want to reference first in the formula (cell B1 	
	 in our example). A blue border will enclose		
	 the referenced cell.

4.	 Type the mathematical operator you want to use. 	
	 In our example, we’ll type the minus sign (-).

5.	 Type the cell address of the cell you want to reference 	
	 next in the formula: (cell B2 in our example). A red 	

	 border 		 will enclose the referenced cell.

6.	 Press Enter on your keyboard. The formula will be 		
	 calculated and the value will be displayed in the cell. 	
	 Notice that the formula did not change in the 		
	 formula bar.

Modifying value from a cell reference
The advantage of using a cell reference is that you can change the value 
without touching the formula.

1.	 What follows is the example we used earlier.
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2.	 We changed the value of B2 from 250 to 240.

3.	 Press Enter and it will automatically compute the value.

Functions
A function is a predefined formula in Excel that performs calculations 
for a specific value using reference cells. Excel has different functions for 
quickly finding the sum, average, count, maximum value, and minimum 
value for a range of cells. Before using a function, there are parts of it 
which you must first understand and be familiar with.

Parts of a Function
A function consists of the equals sign (=), the function name (an example 
of this is SUM), and one or more arguments. An argument is a range of 
cell addresses or any input that you provide to a function.

Using a function
There are functions already defined in Excel. These are examples of 
functions you would usually use.

1.	 SUM: using this function will add all the values of cells in the argument

2.	 AVERAGE: using this function will get the average of all the values of 
cells in the argument

3.	 COUNT: this counts the number of cells with numerical data in the 
argument

4.	 MAX: gets the highest cell value included in the argument

5.	 MIN: gets the lowest cell value included in the argument

=SUM : (A1:A5)

Equal Sign Function
name

Argument
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The following are the steps in using a function.

1.	 Select a cell where you want the function. In this example, we’ll use the 
cell C5. Type in the equals sign (=)

2.	 Enter the desired function. Excel gives a list of suggested 		
	 functions as you type. In this example, we’ll use SUM.

3.	 Enter the cell range for the argument inside parentheses. In 	
	 our example, we’ll type (C1:C4). Notice that the cells from C1 	
	 to C4 are highlighted. This formula will add the values of cells 	
	 from C1 up to C4. 

4.	 Press Enter. The function will be calculated and will be shown in cell C5.

*Note: Multiple arguments must be separated by a comma. For example, 
the function =SUM(A1, B2:B4, C1:C4 ) will add the values of all the cells 
in the three arguments.
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The Function Library
While there are hundreds of functions in Excel, we do not need to 
memorize them all, but exploring some of the different types of 
function will be helpful as you create new projects. Functions are 
grouped per type of data they manipulate. They are in the Function 
Library under the Formulas tab.

The Insert Function command

If you’re having a hard time finding the right function to use, the Insert 
Function command can help you. It allows you to search for functions 
using keywords. But, while it can be useful, this command is sometimes 
difficult to use. If you are new in the use of functions, you may have more 
success browsing the Function Library. For more advanced users, 
however, the Insert Function command can be a powerful way to find a 
function quickly.

How to use the Insert Function command?

In the example below, we want to find a function that will count the total 
number of students in a class list. We cannot use the COUNT function 
since it only counts cells with numerical information and we only have 
the column with names. 

1.	 Select the cell that will contain the function. In this example, we will use 
the cell B12.

2.	 Select the Insert Function command in the Formulas tab.
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3.	 An Insert Function dialog box will show up. 

4.	 Type a few keywords that would describe what function you want, or 
select a category. Then click Go. In this example, we will use the word 
“count” to describe the function.

5.	 Notice that the list of functions is updated per description.
6.	 Review the results and choose the best function that would suit what you 

need. In this example, COUNTA is used.
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7.	 A Function Arguments dialog box will appear.

8.	 You can either enter or click the cells you want to include. Here, we select 
cells A2 up to A10.

9.	 The function will be calculated and the result will be displayed 
in the cell. In the example, the result shows that the number of 
students is 8.

Sorting
One of the features of Excel is that you can manage information. 
You can quickly sort your data alphabetically, numerically, and 
in many other ways.

Types of sorting
Sort Sheet – sort all data in your worksheet by one column. Related 
information is kept together when sorted. An example of this is a list of 
students to be arranged according to their class number.

Sort Range – sorts the data in a range of cells, which can be helpful 
when working with a sheet that contains several tables. Only the contents 
of the table will be sorted. Sorting a range will not affect other content 
on the worksheet.
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How to sort an MS Excel sheet
In the following example, we will sort a class alphabetically according to 
Last Name. 

1.	 Select a cell in the set you want to sort. In this example, we’ll use cell B3.

2.	 Click the Ascending command to sort from A to Z, or the Descending 
command   to sort Z to A from the Data tab. In this example, we’ll use the 
Ascending command.

3.	 The worksheet will now be sorted. In the example, the worksheet is now 
sorted alphabetically by the last name of the students.
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How to sort a range

In our example, we’ll select a 
separate table in our class 
record to sort the days a student 
was absent.

1.	 Select the cell range you want to 
sort. In our example, we’ll select 
cell range A13:C16.

 
2.	 Click the Sort command in the 

Data tab.

3.	 A Sort dialog box will appear. Select a column you want to sort by. In this 
example, we’ll use Last name.  

4.	 Decide if the sort will be in ascending or descending order. In this 
example, we’ll use ascending. Click Ok.

5.	 The cell range will be sorted in the selected column. Notice that the other 
table in the worksheet is not affected by the sort. 
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Filtering
One of the feature of Excel is to narrow down data in your worksheet, 
allowing you to view only the information you need. This feature is called 
Filter.

How to filter data

Below are the steps in filtering data in Excel.

1.	 In order for filtering to work, your worksheet must have a header row, 
which is used to identify the column. 

 
2.	 Click Filter in the Data tab. 



Philippine Copyright 2017 70

3.	 A drop-down arrow will appear in the rightmost side of the header cell for 
each column.

4.	 Click the drop-down arrow for the column you want to filter.  

5.	 A filter menu will appear. 

6.	 Deselect all the data by unchecking the box next to Select All.

Filters are cumulative, 
which means you can 
apply multiple filters to 
help narrow down your 
results.



Philippine Copyright 201771

7. Check the boxes next to the data you only want to display, then click OK. 

8. Notice that the data was reduced. Don’t worry, it only temporarily hid the 
data that don’t match the criteria.  

To clear a fi lter
1. Click the drop-down arrow for	the	fi	lter	you	want	to	clear.	In	our	

example,	we’ll	clear	the	fi	lter	in	column	B. 

2. The Filter menu will appear. 

How will you use Charts 
in your future work? Can 
you identify the kind of 
data you will present in 
the near future and which 
chart will you use?

InTEgrATE
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3.	 Choose Clear Filter From [COLUMN NAME] from the Filter menu. 
In our example, we’ll select Clear Filter From “TYPE”.

4.	 The filter will be cleared from the column and previously hidden data will 
be displayed.

Advanced Filter
Advanced number filters allow you to manipulate 
numbered data in different ways. In this example, we will 
display only certain types of equipment based on the range of 
ID numbers.

1.	 Select the Data tab on the Ribbon, then click the Filter 
command. A drop-down arrow will appear in the header cell 
for each column. Note: If you’ve already added filters to your 
worksheet, you can skip this step.

2.	 Click the drop-down arrow for the column you want to filter. 
In our example, we’ll filter column A to view only a certain 
range of ID numbers.
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3. The Filter menu will appear. Hover the mouse over Number Filters, 
then	select	the	desired	number	fi	lter	from	the	drop-down	menu.	In	our	
example,	we	will	choose	Between	to	view	ID	numbers	between	a	specifi	c	
number range.

4. The Custom AutoFilter dialog box will appear. Enter the desired 
number(s)	to	the	right	of	each	fi	lter,	then	click	OK.	In	our	example,	we	
want	to	fi	lter	for	ID	numbers	greater	than	or	equal	to	1003	but	less	than	
or equal to 1007, which will display ID numbers in the 1003-1007 range.

 

5. The	data	will	be	fi	ltered	by	the	selected	number	fi	lter.	In	our	example,	
only items with an ID number between 1003 and 1007 are visible.

How will you use Charts 
in your future work? Can 
you identify the kind of 
data you will present in 
the near future and which 
chart will you use?

InTEgrATE
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Charts 
Sometimes, it is difficult to interpret Excel workbooks which have a lot of 
data. A chart is a graphical representation of your workbook data that’s 
easier to visualize for comparisons and trends.

Types of charts

Column – this chart uses vertical bars to represent data. They are most 
frequently used for comparing information.

Line – this chart is ideal for showing trends. The data points are 
connected by lines, making it easier to see the increase or decrease of 
value over time.

Pie – this chart is used to compare proportions. It depicts the values 
that make up a percentage of the whole and are shown as slices of a pie.

Bar – this chart is just like the Column chart but uses horizontal bars 
instead.

Area – this chart is like the Line chart, except the areas under the lines 
are shaded.

Surface – this chart allows you to display data in 3D landscape. It lets 
you see a variety of information at the same time. This works best with 
large data sets.

Inserting a chart
1.	 Select the cells that you want to include in your chart, including the 

column titles and row labels. 

2.	 Select the desired Chart command from the Insert tab. 
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3.	 Select the desired chart type from the drop-down menu.

4.	 The chart will be inserted in the worksheet.

Changing Chart Types

If you think your chart is not suited for the data you have, it’s just easy to 
change to a different chart type.

1.	 Click the Change Chart Type command from the Design tab. 
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2. A Change Chart Type dialog box will appear. Select a new chart type and 
layout then click OK.

3. The new chart will be displayed.

Moving a chart 
Whenever you insert a new chart, it will appear as an object in the same 
worksheet that contains its source data. You can move the chart to a new 
worksheet to help keep your data organized.

1. Select the chart you want to move.  
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2. Select	Move	Chart	from	the	Design	tab.

3. The	Move	Chart	dialog	box	will	appear.	Select	the	desired	location	for	the	
chart. Then click OK. In our example, we choose to use New sheet, which 
will create a new worksheet. 

4. The chart will appear in the selected location. In our example, the chart 
now appears in a new worksheet.

  ChECK

I.  By Pair. Do this with a friend from the Explore activity. This time, use 
MS	Excel	to	create	the	tabulation	given	in	the	activity.	Add	appropriate	
formulas and functions to compute for the weighted mean and total. 
Record the time you consumed in this activity and compare with the 
Explore activity. Which is faster? Which has more accurate results?
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II.   Multiple Choice. Read the questions carefully then write the 		
        letter of the best answer beside the number.

1.	 Microsoft Excel is an example of which software application?
a.	 Database
b.	 Word Processor
c.	 Spreadsheet
d.	 Presentation

2.	 You can get the total of a large range of data by simply selecting which 
tool button?
a.	 Auto format
b.	 Auto correct
c.	 Auto fill
d.	 Auto sum

For numbers 3-5, refer to the given table:

3.	 Which formula will get the total number of website visitors during the 
months of May and June?
a.	 A3+A4
b.	 B3+B4
c.	 =A3+A4
d.	 =B3+B4

4.	 Which function should you use to get the average number of your website 
visitors from April to August?
a.	 =SUM(B2:B6)
b.	 =AVERAGE(B2:B6)
c.	 =COUNT(B2:B6)
d.	 All of the above

5.	 Which function should you use to get the least number of customers you 
have for a month from April to August?
a.	 =MIN(B2:B6)
b.	 =MAX(B2:B6)
c.	 =SUM(B2:B6)
d.	 None of the above
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6.	 Which of the following do you think is the advantage of using cell 
references in your formula instead of writing values?
a.	 It allows you to format your cell faster.
b.	 It automatically creates a sparkline in the next cell
c.	 If the cell is changed, the result in the formula will be updated.
d.	 There is no advantage.

7.	 Which chart is best used for comparing proportions making up the 
percentage of a whole?
a.	 Bar
b.	 Pie
c.	 Line
d.	 Area

For numbers 8-10:

You own a small cake shop 
located in front of your 
house that offers a variety 
of cakes for your customers. 
To better manage your 
business, you use an Excel 
worksheet to record the 
orders of your customers 
which are as follows:

8.	 You want to see how much sales you have generated so far and you added 
a new column “Amount” placed in Column E to compute for the sales per 
customer. Which formula should be set to accomplish this?
a.	 =C2*D2 then hold the fill handle to copy the formula to the entire 

column
b.	 =C2/D2 then hold the fill handle to copy the formula to the entire 

column
c.	 =price * quantity ordered
d.	 =SUM(C2:C11)

9.	 The next step is to get the total amount to determine your sales data for 
selling cake slices. Which formula is correct to do this?
a.	 =SUM(C2:C11)
b.	 =SUM(D2:D11)
c.	 =SUM(E2:E11)
d.	 =AVERAGE(E2:E11)

10.	In particular, you also want to determine the items ordered by a 
customer, specifically the items bought by Yuan Carreon. What actions 
should you do to accomplish this task?
a.	 Highlight the data then click the Filter icon in the Data tab, click 

the drop-down arrow in the Item Ordered column, then select only 
Chocolate Cake.

b.	 Highlight the data then click the Filter icon in the Data tab, click the 
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drop-down arrow in the Customer Name column, then select only the 
Yuan Carreon.

c. Highlight the data then click the Filter icon in the Data tab, click 
the drop-down arrow in the Price Ordered column, then deselect all 
except for 40 and 45 in the list.

d. None of the Above

III. Laboratory Practice. Create a new worksheet in Excel and   
 name it as E-Tech_ClassRecord_<your_surname>.xlsx. Encode  
 the following data. Use appropriate functions to determine what  
 is asked for. Sort the records alphabetically. On a separate sheet,  
 list the top 6 students in the class based on quiz average.

  buILD

Project Survey 

Part I. Depending on your chosen project, prepare a questionnaire that 
you	will	use	to	gather	data	from	different	target	audiences.	Use	MS	Word	
for your questionnaire, print it and ask at least 20 students to answer the 
survey form. You can also use online survey tools that you are familiar 
with.

Part II.	 Using	 MS	 Excel,	 tabulate	 the	 answers	 of	 your	 respondents.	
Create a tally sheet and come up with a chart to present your data. Add 
a title and properly label the x and y axes. Place this information in a 
Word document. Discuss the results and your interpretation about the 
frequency of usage and most-used social media sites.

E-Tech Class Record
Name Quiz 1 Quiz 2 Quiz 3 Average Quiz Passed or Failed

John 88 91 96 ? ?

Peter 84 86 90 ? ?

Andrew 94 90 93 ? ?

Matthew 82 86 85 ? ?

Jude 73 76 72 ? ?

James 91 94 93 ? ?

Ezra 89 92 91 ? ?

Luke 90 99 90 ? ?

Esther 73 72 75 ? ?

Jeremiah 92 87 90 ? ?

Average Per Quiz ? ? ? no. of Students ?

Lowest grade per Quiz ? ? ? Total Passed ?

highest grade per Quiz ? ? ? Total failed ?



LESSon 5 whAT ArE ADvAnCED 
Target
By the end of this lesson, 
you should be able to

• Apply the tips in   
 effective slide    
 presentations
• Use SmartArt graphics to  
 present content instead  
 of bullets

  EXPLorE
In the previous lesson, you learned advanced Excel tools that enabled 
you to process the data you gathered and present these using charts. In 
this lesson, you will learn tools in PowerPoint that will help you make 
effective slide show presentations. 

Do you remember anyone you saw or watched who presented to you in 
the past? What made these remarkable to you? In the graphic organizer 
below, write the name of the presenters/teachers you remember on the 
left column, and why they are remarkable on the right column.

PowErPoInT TIPS AnD 
TooLS for EffECTIvE SLIDE 
PrESEnTATIonS?

Presenter’s Name Remarks

Philippine Copyright 201781
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  EXAMInE

Using charts, images, or infographics can add value to your presentations, 
particularly since we human beings are visually wired. (According to 
Merieb	and	Hoehn’s	Human	Anatomy	and	Physiology,	around	50%	of	our	
brain is involved in visual processing and most of our sensory receptors 
are	in	our	eyes	(Merieb,	E.	N.	&	Hoehn,	K.,	2007)).	This	means	that	we	
humans understand and learn faster through visual aids and graphics, 
and with this in mind, you can develop slide presentations that would 
be as effective as they are visually appealing. Before going any further, 
it would be well to first discuss the Top Ten Slide Tips according to Garr 
Reynolds, a known communications consultant and presenter in TED 
conferences who is also the author of many best-selling books including 
Presentation Zen.

Top Ten Slide Tips
1. Keep it simple

Complex slide designs tend to distract your audience from your talk and 
keep them from understanding your message. White space in the slide 
helps the audience focus on what you want to talk about. Remember, the 
people in front of you came to listen and to be informed, so the less the 
clutter in the screen, the better.

2. Limit bullet points and text

Which is better between the two examples below?

Take a guess. What tool 
did the designer use to 
make this infographic?

Take note of the amount 
of text used compared to 
graphics. What can you 
say about it?

Which specifi c parts of 
the tool did the designer 
use?

TED, with the tagline, 
“Ideas worth spreading,” 
is a nonprofi t that 
spreads ideas usually 
in the form of short 
videos. Presenters in TED 
conferences and TED 
Talks are known for their 
effective presentations, 
and you can access their 
videos at www.ted.com
Why do you think their 
presentations are as 
effective as they are?

InTEgrATE
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It is not good practice to bombard your audience with lots of text because 
it strains the eyes of the viewers and bores your audience. Remember, 
the slides are just there to support your talk, not to be your script. Focus 
on the star of your talk, which is your audience.

3. Limit transitions and builds (animations)

Keep it professional. Use appropriate animations for text especially 
in bullet points; Swipe Left/Right is enough for bullet points. Use 
transitions sparingly, preferably not one in every slide, and avoid grand 
animations because these could tire your audience out.

4. Use high-quality graphics

This includes using high resolution photographs instead of clip art 
images. The photographs may be taken by using high quality cameras, 
purchased stock images, or taken from online sources (be sure they is 
free from copyright issues). Avoid stretching low-resolution images, 
as doing so will degrade the resolution even more. Be sparing when 
using clip art images, as these usually make the presenter appear less 
professional. Refer to the following slides below, for example; which one 
is more interesting?

5. Have a visual theme, but avoid using PowerPoint templates

It is essential that you create a theme to give your presentation a sense 
of unity and consistency. PowerPoint has several built-in themes and 
templates but, according to Reynolds, PowerPoint templates make 
an audience feel that the presentation is prepackaged and isn’t that 
professional.

As an alternative, try making your own template by preparing images 
using photo editing tools and save your presentation as a Design 
template. You can also purchase templates online or download some that 
are free to use.

6. Use appropriate charts

There	are	many	different	kinds	of	charts	available	in	MS	Office,	so	keep	
from dumping too much information in your charts and tables. (You can 
refer	to	the	previous	lesson	for	the	list	of	charts	available	in	MS	Office.)

You can fi nd free 
templates through 
hongkiat.com

There are also many 
design tips, tricks, and 
articles on that website 
which can help you 
further improve your 
skills.

  EQuIP
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7.	 Use color well

Colors suggest feelings and emotions. The right use of color in the right 
place and the right time increases audience interest and develops better 
understanding and retention of the topic you are discussing. 
Take note of the following:

•	 When presenting in a dark venue, use slides with a dark background 
and a light foreground.

•	 When presenting in a well-lit venue, use slides with a light background 
and a dark foreground.

•	 When presenting in a venue with good ambient lighting, use a light 
background as well as light images, and a dark foreground as well as 
dark text.

8.	 Choose your fonts well

Fonts can deliver subtle messages, which is why picking which to 
use is important. Do not use more than two font faces, and choose 
complimentary fonts which would look great together. Take note of the 
difference between Serif and Sans Serif fonts, as Serif fonts are usually 
used in documents that are text-heavy because these kinds of font are 
easier to read, particularly in smaller point font sizes. The font used in 
this book, for example, is a Serif font type.

San-serif fonts, on the other hand, are usually better for slide 
presentations because they appear friendlier to the audience.

This is a Sans Serif font called Arial Black.

9.	 Use video or audio

Videos and audios help increase the audience’s interest in your topic and 
they also help you better make your point. You can play multimedia files 
within the presentation itself, and as much as possible, avoid the built-in 
sound effects of PowerPoint, as these could distract your audience. 

10.	Spend time in the slide sorter

We humans are said to understand better when information is presented 
in small chunks, and PowerPoint can help keep break up large chunks 
of information into smaller ones. When you go into the Slide Sorter 
View, you will see the logical flow of your presentation and can see 
which slide needs to be broken up into multiple slides to improve the 
understandability of your presentation. You can also use the Slide Sorter 
View to spot parts of your presentation that can be made more clear.

SmartArt 
Visualization helps audiences understand messages better, and 
presenters like Hans Rosling use visually-oriented software like 
Gapminder Tools to make their presentations that much more effective. 
Using visualization will be very useful when you present the results of 
your research.
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SmartArt is used in PowerPoint for presenting information graphically. 
This consists of preset layouts that enable you to easily create graphics 
which can effectively communicate information.

Inserting a SmartArt graphic
1. Select the slide where you want to display a SmartArt graphic.

2. From the INSERT tab, select the SmartArt command.
 

3. A dialog box will then appear. Select a category on the left, choose the 
SmartArt graphic you want to display, then click OK.

 

If you want to watch 
some of Hans Rosling’s 
presentations, you can 
access them through this 
link:

http://www.ted.com/
speakers/hans_rosling

  EQuIP
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4.	 The SmartArt graphic will then appear on the current slide.
 

As a shortcut, you may also click the Insert a SmartArt Graphic 
command in a placeholder to add SmartArt.

Adding Text to a SmartArt Graphics
1.	 Select the SmartArt graphic. A SmartArt task pane will then be displayed 

on the left.
 

2.	 Type out text next to each bullet in the task pane. The text will then 
appear in the graphic and will automatically resize to fit.
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3.	 Press Enter to add a new shape. A new bullet will appear in the task pane, 
and a new shape will appear in the graphic. To remove any bullets you 
don’t need, you can delete these in the task pane.

 

Another way to add text is by clicking in the desired shape in the image 
display and then typing. This, however, only works well if you only need 
to add text to only a few shapes. Working in the task pane is often faster 
for more complex SmartArt graphics.

Converting Existing Text to SmartArt
If you already have bulleted text in a slide, you can automatically convert 
this into an eye-catching SmartArt graphic, as explained by following the 
illustrative example that follows.

1.	 Highlight, then right-click, the list or paragraph you want to convert to 
SmartArt.

2.	 Point the mouse over Convert to SmartArt and then select the desired 
SmartArt graphic.
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3.	 The text will then appear as a SmartArt graphic.

If you want to convert SmartArt back to text, you may do so by going to 
the Design tab on the right side of the Ribbon, clicking the Convert 
command, then selecting Convert to Text.

Modifying a SmartArt 
Adding a Shape:

1.	 Select the SmartArt graphic, then click the Design tab, which is located on 
the right side of the ribbon.
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2.	 Select the shape where you want the new shape to appear. In the example, 
this is the shape with Padillo, Terence in it.

 

3.	 In the Graphics group, click the Add Shape command. The drop-down 
menu should then appear.

4.	 Decide whether to select Add Shape 
Before or Add Shape After, relative 
to the same level as the shape you 
selected. If you want to add a shape 
above the shape selected, click 
Add Shape Above, and if you want 
to add a shape below the selected 
shape, click on Add Shape Below. 
For this example, Add Shape Below 
was selected.

5.	 A new shape will then appear.

Promoting and Demoting Shapes:
1.	 Select the SmartArt graphic you want to work on, then click on the Design 

tab.
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2.	 Select the shape which you want to promote or demote. In this example, 
Padillo, Terence will be selected.

3.	 Click the Promote command in the Create Graphic group if you want to 
move the shape to a higher level. Otherwise, click Demote to move it to a 
lower level. In this example, Padillo, Terence will be demoted.

4.	 The shape should have moved one level higher or lower, depending on 
whether you promoted or demoted the shape. In this example, Padillo, 
Terence has been demoted.
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Rearranging Shapes:

1.	 After selecting the SmartArt graphic, click the Design tab.

2.	 Click the shape which you want to move.
 

3.	 Click either Move Up or Move 
Down in the Create Graphic 
group.

 
4.	 The shape should now have 

moved to a new location on the 
same level, and any shape 
connected below it should also 
have moved along with it.

Customizing Look and Feel of 
SmartArt:

To select one of the many color schemes 
used by SmartArt, click the Change 
Colors command to change the color, 
and from the drop-down menu, choose 
the color you desire.
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¾¾ Color schemes are actually based on the theme colors; these will thus 
vary, depending on which theme you will use. 

 

¾¾ You can quickly modify the look and feel of your SmartArt presentation 
by selecting any one of the SmartArt styles available. Simply select the 
desired style from the SmartArt Styles group if you want to change the 
style.

 



Philippine Copyright 201793

¾¾ Add shape effects to your SmartArt, such as Shadow, Reflection, Glow, 
Bevel and 3D Rotation. Select the entire SmartArt graphic by clicking the 
border, clicking on the Format tab then choosing the desired effect under 
Shape Effects. If you want to customize shapes separately, you need to 
click on individual shapes instead.

Changing the SmartArt layout:

In case you don’t like the way information is organized within a SmartArt 
graphic, you can always change its layout to better fit your content.

1.	 Select the SmartArt graphic, then select the Design tab.

2.	 In the Layouts group, click the drop-down arrow.
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3.	 Select a desired layout or click More Layouts to see even more SmartArt 
options.

4.	 The selected layout will then appear.
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B.  Situation Analysis. Keep in mind the tips in slide    
      presentations, sketch a 3-slide presentation on each topic below.

1. You are asked to introduce yourself using a 3-slide presentation.
2. You are going to sell your notebook to your classmate using a 3-slide 

presentation.

1. The colors of your SmartArt presentation vary depending on 
the theme you applied in your presentation.

2. You cannot convert bullet points to SmartArt graphics.
3. You access the Format tab to modify the layout of your 

SmartArt presentation.
4. You access the Design tab to change the colors of your 

SmartArt presentation.
5. The	Move	Up	and	Move	Down	functions	are	under	the	Create	

Graphic group.

  ChECK
A.   True or False. Read the statement and identify which tool you   
        should use to accomplish the task.
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3. You are trying to convince your parent to increase your allowance using a 
3-slide presentation.

  buILD

Project Slide Presentation

Using what you’ve learned in this lesson, each group member will prepare 
a slide presentation, with a maximum of fifteen slides, of your project 
concept; you can use your project pitch document as a basis for what will 
appear on your slide presentation. Present your project concept in front 
of your classmates with the help of the presentation you made.



MODULE 2
How do you create or innovate products and 
processes using ICT Tools?

Learning Outcomes
•	 Create,	manipulate,	and	share	images	on	the	Web

•	 Explore	the	ICT	processes	involved	in	cloud	computing

•	 Produce	an	audio-video	presentation.

Portfolio Output
Project	 Prototype	 –	 this	 is	 the	 prototype	 of	 the	 solutions	 or	 products	
you	have	conceptualized.	The	suggested	module	project	for	the	students	
is	 a	 short	 film	 or	 a	 campaign	 video.	 The	 video	 should	 include	 some	
infographics	or	details	regarding	the	problem	you	have	chosen	to	tackle.	
The	product	should	be	able	to	address	or	raise	awareness	of	the	problem/
issue	that	the	students	chose	to	tackle	in	the	previous	module.

Criteria Excellent
5 PTS

Very Good
3 PTS

Needs Practice
1 PT

Creativity
Very creative in its 
design

Somewhat Creative 
in its design

Common and 
ordinarily seen 
elsewhere 

Presence of 
Elements and 
Principles of Design

Fully applies the 
Elements and 
Principles of Design

Partially applies 
the Elements and 
Principles of Design

Very limited 
application of 
Elements and 
Principles of Design

Audio/Visual 
Presentation Skills

Well prepared Not much prepared
Disorganized and 
not well managed

Philippine	Copyright	201797
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MODULE OUTLINE
Lesson 6: What are ways we can use to create and manipulate 		
	         images to convey information?

•	 The Elements of Design

•	 The Principles of Design

•	 Image File Formats

•	 Image Authoring and Editing Tools

•	 Image Manipulation using GIMP

Portfolio Task 1 – You will create a poster that will inform the people regarding your ongoing 
project/campaign. The poster shall embody elements and principles of design.

Lesson 7: How do we use infographics to present the data we have?
•	 Graphic Design Versus Information Design

•	What Is an Infographic?

•	 Elements of an Effective Infographic

•	 Create Infographics Using Piktochart

•	 Types of Infographics

•	Making a Timeline Infographic 

Portfolio Task 2 – As a group, send a message to your viewers in a poster format to inform 
others of the role you can play as a youth of today to achieve social change. Apply the basic 
principles of infographics and the techniques in image manipulation and design.

Lesson 8: How do we upload and share our files online?
•	 File Management

•	 Online File Management and Storage Services

•	 Image Hosting Platforms

•	 Video Hosting Platforms

Portfolio Task 3 – Upload the posters and infographics you have made to social media sites 
available to your group.

Lesson 9: How to use videos as media to convey information?
•	 Video Production

•	 Storyboarding

•	 Things to Consider in Making a Video

•	 Video Editing Applications

Portfolio Task 4 – Based on the facts gathered in the previous lesson, make a campaign video 
that will raise awareness in your target audience.



LESSON 6 
Target
At the end of this 
lesson, you will be able 
to

• Find appropriate  
 images that you  
 can work on with your  
 project
• Apply the importance  
 of the elements and  
 principles of design in  
 creating images
• Create a document  
 with images that  
 represent the   
 project proposal in  
 relation to promoting  
 social change

  EXPLORE
In	the	previous	module,	you	had	prepared	your	Project	Pitch	Document	
where	 the	 details	 of	 your	 project	 were	 specified.	 Now,	 you	 will	 learn	
design	that	will	help	you	produce	images	that	are	effective	in	conveying	
information	properly.	But	first,	let’s	do	this	activity.

Pretend	that	you	won	an	enormous	amount	of	money	from	a	Lotto	win,	
and	you	wanted	to	invest	it	to	start	your	dream	business.	In	the	business	
permit	form	below,	enter	the	details	of	your	business.

After	 some	 time,	 you	 realize	 that	 you	 need	 a	 striking	 and	 cool	 logo	 to	
represent	 your	 business.	 You	 intend	 to	 use	 it	 on	 your	 Facebook	 for	
Business	page	that	you	are	going	to	set	up	soon.	Based	on	the	details	you	
had	defined	in	the	business	permit,	sketch	the	logo	you	want	to	use	for	
your	business.	Use	the	space	below.

Business Permit

Company/Business	Name:

Type	of	Products/Services:

Location:

Owner:

WHAT ARE WAYS WE CAN USE TO 
CREATE AND MANIPULATE IMAGES 
TO CONVEY INFORMATION?

Philippine	Copyright	201799
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  EXAMINE

What	do	you	think	of	this	poster	inspired	by	Niklaus	Troxler’s	art	style?	
At	 first,	 it	 might	 be	 difficult	 to	 distinguish	 what	 the	 artist	 wants	 to	
portray	 in	 this	 image,	but	because	of	 the	placement	of	strokes,	you	can	
come	up	with	an	idea	of	what	it	is.	

In	 this	 lesson,	 you	 will	 learn	 the	 elements	 and	 principles	 of	 design	 to	
effectively	communicate	an	idea	or	information.

The Elements of Design

Point, Line, and Space

Point,	 line,	 and	 space	 are	 some	 of	 the	 basic	 elements	 of	 design	 that	
have	 limited	 form.	 The	 way	 by	 which	 these	 are	 used,	 especially	 when	
combined	 with	 other	 elements,	 affects	 the	 overall	 perception	 of	 any	
communication.	A	 single	design	element	or	a	 combination	of	 them	can	
help	in	interpreting	the	message	of	a	drawing	or	design.	

At a glance, what do 
you think is drawn in 
this poster? Why do you 
think so?

Is it visually appealing to your 
eyes? Why do you say so? What 
makes it appealing and what 
makes it not?
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Point

A point is simply a dot. A point establishes a position and acts as a visual 
focus. In a blank page, a single point immediately attracts and focuses 
the eye. Several graphical points can make up a line and each point of a 
set of them contributes to suggest the corner of a shape. 

The eye senses a relationship between a point and the edge of the 
paper. Adding another point in the page creates a relative position and 
sets up the relationship with the first point based on the surrounding 
area of the page. As more points are added to the page, grouping and 
subgrouping patterns appear which determine viewing sequence (levels 
of importance), and produce the information communicated and 
interpreted by the viewer. 

Line

A line is created by connecting two or more points. It begins by extending 
one point towards a specific direction. A line can work with other lines to 
create an illusion of distance, space and depth. It can be straight, curved, 
heavy, slim, dashed or dotted. A line can be used to divide a space, direct 
the eye to a direction or two, and also to outline or define figures. Like in 
the example presented in this lesson, certain lines can be placed in such 
way that they work together to resemble an object or illustrate an action. 
Lines placed closer to an area’s edge, for example, will direct the eye 
along the path they create. 

The simplicity, complexity, elegance, and form of line is called contour. 
Contour is also the outline of the exterior edges of a shape. A plain 
contour has a clean, connected line. It may have line textures or be 
contrasted with different designs or styles.

The straight line can separate content and elements in the page layout of 
a magazine, newspaper, and even a website. The use of curved, dotted, 
and zigzagged lines can define or emphasize a unique part of the layout. 
Virtual lines, such as the ones suggested by the flow of text, also affect 
layout in a similar manner. 

Space

Space, or area, refers to the surface that acts as a visual container, 
drawing attention to other visual elements in a layout. Graphic designers 
use space as a means of defining the format and proportion in a layout. 
Empty areas, or white spaces, can create spatial energy within a design, 
and directs the eye from one part to another. 

With the current state of print, broadcast, and web media, designers of 
brochures, catalogues, and promotional print materials always consider 
the effects of size, format, content, and surface quality on the printout. 
 

              . . ..   .  …. .  
..

    .

	    .
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You can learn more 
about the elements of 
design from this link.

http://www.
writedesignonline.
com/history-culture/
AndyGoldsworthy/
overview.htm#form

EQUIP

Shape

The	 shape	 is	 an	 element	 of	 design	 which	 is	 a	 combination	 of	 lines,	
points,	 and	 space	 (which	 can	be	 two-	 or	 three-dimensional).	An	object	
that	has	height	and	width	has	shape.	A	shape	is	mainly	used	in	a	drawing	
to	 represent	 a	 real	 object,	 symbolize	 an	 abstract	 thought,	 or	 define	 an	
artistic	design.	Using	shapes	accordingly	can	help	define	the	mood	of	the	
graphic	 design.	 Softly-curved	 and	 rounded	 shapes	 are	 seen	 differently	
from	 sharp,	 angled	 shapes.	 Unusual	 shapes	 can	 be	 used	 to	 attract	
attention.	

There	 are	 3	 basic	 types	 of	 shapes:	 geometric,	 natural,	 and	 abstract.	
Geometric	 shapes	 include	 the	 triangle,	 square,	 rectangle,	 and	 circle.	
Natural	shapes	are	formed	from	natural	things	like	animals	and	plants.	
Shapes	 such	 as	 leaf	 and	 apple	 are	 examples	 of	 standardized	 natural	
shapes	used	by	 artists.	Abstract	 shapes,	 such	 as	 icons,	 stylized	 figures,	
and	graphic	illustrations,	are	really	modified	types	of	natural	shapes.

The	 following	 are	 some	 of	 the	 meanings	 associated	 with	 some	 basic	
shapes.
	

Having no beginning or 
end, the CIRCLE represents 
infi nity, harmony, community, 

completeness, and perfection. The 
way it encloses what is inside and 
restricts what is outside suggests 

protection and endurance.

The SQUARE and the RECTANGLE 
are two common shapes. They send 
a message of security and stability. 

Each one is an ideal shape for 
companies and organizations with 

a strong market position, and a fi rm 
belief in fi nancial stability. This shape 
is associated with strong character, 

fi rmness, protection, and tradition. Its 
a shape held upright on the fl oor as 

on any of its sides.

Having no beginning or 
end, the CIRCLE represents 
infi nity, harmony, community, 

completeness, and perfection. The 
way it encloses what is inside and 
restricts what is outside suggests 

protection and endurance.

The 
TRIANGLE is 

associated with 
dynamic tension, 

aggression, and energy. 
It can signify stability 

when upright on its base and 
instability when tilted. It illustrates 

progression and direction.

The SQUARE and the RECTANGLE 
are two common shapes. They send 
a message of security and stability. 

Each one is an ideal shape for 
companies and organizations with 

a strong market position, and a fi rm 
belief in fi nancial stability. This shape 
is associated with strong character, 

fi rmness, protection, and tradition. Its 
a shape held upright on the fl oor as 

on any of its sides.

The 
TRIANGLE is 

associated with 
dynamic tension, 

aggression, and energy. 
It can signify stability 

when upright on its base and 
instability when tilted. It illustrates 

progression and direction.
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Color

Color is another element of design that can be associated with any other 
element. All color comes from pure light. A color is produced by an 
object that reflects light. The computer monitor is one source of artificial 
light which is directly transmitted to the viewer’s eyes.  

Color can produce dramatic changes in a design when it is used to 
emphasize things or create images. When used properly, each color 
can produce creative and unique effects. Designs on the web and other 
publications apply color themes that are limited to a particular output 
to produce a unified effect. The use of color for decoration, symbolism, 
expression, and communication is part of human nature.

The properties of color are the following.

Hue is the other name for color, which includes the primary colors, 
namely, red, yellow, and blue. When combined in equal parts, they create 
secondary hues, such as orange, green, and violet. The combination of 
primary and secondary hues creates the tertiary hues. Refer to a color 
wheel to understand more about the primary, secondary, and tertiary 
colors.

Here are the following uses of colors:
•	 Indicate where the eye should look first
•	 Pinpoint the important elements such as headlines and subheads 
•	 Unify a design
•	 Consolidate information 
•	 Isolate or group elements together 
•	 Arouse emotions
•	 Make an image or object stand out within the design

All data that constructs computer imagery is digital. Monitors need 
a method where colors in the spectrum can be simulated quickly. The 
common method displays only the three primary colors, red, green, 
and blue (RGB). When combined in the screen (a grid of pixels), white 
light is produced. By using all 256 intensity levels of each of the primary 
colors to display each pixel, one will arrive at a total of 6.7 million colors 
(256 x 256 x 256). This is good if the intention is simply to view the 
colors on a screen. However, information often needs to be relayed via 
print, and the colors on a screen do not always display accurately in print 
since inked colors are seen by the viewers through the reflection of light 
from the printed surface. Ink colors are seen by the viewers by virtue of 
light reflected off the printed surface, which is why the colored printing 
process applies a color model that uses cyan, magenta, yellow, and the 
key color (black) (CMYK).

Size

Size refers to how large or small something is in a document. Size is 
very important in making the elements of a document coincide with one 
another and makes the layout more attractive and organized. It displays 
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what is most important, attracts attention, and helps to fit the layout 
together. Size makes all things easy to see. It establishes a consistent 
look throughout a printed publication or web page document.

Texture 

The look or feel of a surface is known as texture. Visual texture creates an 
illusion of texture on a printed material or webpage. Printed patterns are 
a type of visual texture. Tactile texture can be felt physically. Nowadays, 
even paper can come in various textures. The wide selection of textures 
used on paper and other materials can be translated accurately into rich, 
layered graphics

Here are the following uses of texture.
•	 Creates a mood or scene in a design
•	 Gives a printed publication, presentation, or web page a personality
•	 Creates contrast for interest
•	 Fools the eye
•	 Arouses emotions
•	 Creates a feeling of richness and depth

 The Principles of Design 

Examples of an asymmetrical and a symmetrical balance design
Symmetrical designs

Balance refers to the equal distribution of weight, which, in design, applies to visual 
weight. Elements such as size, lightness, and thickness can be scaled accordingly in a 
design.

The two kinds of balance are symmetrical balance and asymmetrical balance. Symmetrical 
balance is the even distribution of elements in a design. Asymmetrical balance is the 
uneven arrangement of elements such that one side of a design has more weight. Color, 
value, size, shape, and texture can be used as balancing elements. 

Balance
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Asymmetrical

Image File Formats
Pixel: Another	 name	 for	 a	 picture	 component,	 it	 is	 the	 smallest	
component	of	a	bitmapped	graphic	composed	of	single-colored	squares.	
Each	 image	 is	 made	 up	 of	 these	 very	 tiny	 squares	 and	 each	 pixel	
characterizes	 a	 color	 or	 a	 shade.	 Pixels,	 like	 other	 elements	 of	 design,	
can	be	added,	modified,	and/or	deleted.

Contrast is the placement of heavy and light elements within a page. The larger, darker 
elements appear heavier in the designs than smaller and lighter elements.

This is the difference in value of the colors black and white, between distinct shapes like 
the square and the circle, or between a big and small element. In texture, contrast is 
defi ned by the roughness or smoothness of things in a layout.

Contrast

Emphasis is the distribution of heavy and light elements in a design. It determines 
which elements within the design are focused on the most and which ones are given 
less attention.

Emphasis

Rhythm is the repetition of one or more elements in a design. It creates a mood and a 
sense of movement. Variety in repeated elements makes the rhythm of a design more 
exciting.

Rhythym

Unity refers to the feeling of harmony that is created by all the parts and elements 
of a design. When a particular design is said to be unifi ed, it means that a sense of 
completeness can be felt from the work. 

Unity

You can learn more 
about design principles 
in this web link:

http://www.goshen.edu/
art/ed/Compose.htm

EQUIP
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How can one’s image be related to a 
web graphic?

Nowadays,	 graphic	 designers	 face	 a	 new	 set	 of	
considerations	 when	 working	 with	 graphic	 images	 on	
the	web.	Most	 images	 sent	 to	 and	viewed	on	 the	 screen	
have	a	 low	resolution	or	are	simply	for	monitor-viewing	
purposes	 only.	 For	 web	 page	 elements,	 72	 ppi	 more	
often	 represents	 small	 files	 that	 are	 usable	 over	 a	 web	
page	element.	The	two	dominant	graphic	file	formats	on	
the	 web	 are	 JPEG	 (Joint	 Photographic	 Experts	 Group)	
and	 GIF	 (Graphics	 Interchange	 Format)	 followed	 by	
PNG	 (Portable	Network	Graphics)	which	 extends	 to	 the	
transparency	representation	of	the	images.		

The	 most	 usable	 file	
format	 for	 the	web	 is	 the	
GIF,	 which	 is	 the	 first	

file	format	supported	by	web	browsers.	It	
remains	the	most	popular	web	file	format	
on	the	web	today.	

This	 is	 a	 compressed	 file	 format	
more	often	used	for	the	Web	just	like	
the	graphic	 interchange	 file	 format.	

PNG	 file	 types	 represent	 images	 with	 a	 transparency	
effect	 that	allows	 images	to	overlap,	unlike	a	 jpeg	or	gif	
file	image	that	cover	one	another.	

JPEG	 (often	 typed	 as	 jpg),	
is	 the	 standard	 file	 format	
known	 to	 many.	 This	 file	

format	compresses	high-quality	static	color	images	for	the	
easy	 transfer	 of	 files	 between	print,	media,	 and	 the	web.	

This	 is	 called	 “lossy”	compression,	which	means	 real	 image	
quality	 is	 lost	 as	 file	 size	 is	 reduced.	 The	 Joint	 Photographic	 Experts	
Group	was	the	committee	that	named	this	type	of	file	format.	

Image Authoring and Editing Tools
The	 Adobe	 Creative	 Suite	 includes	 some	 of	 the	 best-known	 image	
authoring	 and	 editing	 applications,	 in	 particular,	 Adobe	 Photoshop.	
These	 applications	 are	 provided	 as	 a	 bundle	 but	 can	 also	 be	 availed	
individually	 for	a	price.	That	said,	 there	are	also	tools	and	applications	
that	are	readily	available	as	free	downloads	on	the	Internet,	and	they	can	
be	used	to	edit	images	and	achieve	similar	results.

GIF (Graphic File Format)GIF (Graphic File Format)GIF (Graphic File Format)GIF (Graphic File Format)GIF (Graphic File Format)GIF (Graphic File Format)GIF (Graphic File Format)

PNG(Portable Network Graphics)PNG(Portable Network Graphics)PNG(Portable Network Graphics)PNG(Portable Network Graphics)

JPG (Joint Photographic Expert Group)JPG (Joint Photographic Expert Group)JPG (Joint Photographic Expert Group)JPG (Joint Photographic Expert Group)

What is a pixel? Why is it important in 
choosing your image fi le format?

Which pixel is appropriate for a print 
document? Which pixel density is good 
for a web-published document?
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GIMP 

GIMP is	 a	 free	 desktop	 photo	 editing	
application.	 It	 is	 said	 to	be	one	of	 the	best	
free	 photo	 editing	 tools	 in	 the	 market,	
on	 par	 with	 the	 industry	 standard	 photo	
editing	 tool,	 Adobe	 Photoshop.	 The	 user	
interface	 of	 Adobe	 Photoshop	 is	 like	 that	
of	 GIMP,	 thus	 proficiency	 in	 one	 means	
proficiency	 in	 the	 other.	 Because	 it	 is	 an	
open-source	application,	more	features	are	
being	added	by	many	different	developers,	
and	they	are	freely	available	to	users.

It	is	not	without	flaws,	though,	because,	unlike	Adobe	Photoshop,	it	lacks	
the	 polish	 and	 quality	 build.	 This	 is	 because	 it	 is	 an	 open-source	
application	 that	 is	 in	 continuous	 development.	 Some	 of	 the	 filters	 and	
other	features	have	been	left	outdated.	In	spite	of	this,	GIMP	is	a	versatile	
image	editing	application.

Pixlr 	

Pixlr is	 an	 ad-supported	 online	 image	
editing	tool,	which	means	that	 it	 is	 free	
to	 use	 but	 various	 advertisements	 are	
displayed	while	the	application	is		
being	used.	

Pixlr	 has	 two	 kinds	 of	 applications:	
Pixlr	 Editor	 and	 Pixlr	 Express.	 Pixlr	
Editor	 offers	 tools	 that	 enable	 the	 user	
to	 manually	 manipulate	 the	 details,	
specific	areas,	and	aspects	of	the	image.	
It	 is	 ideal	 for	 users	 who	 are	 already	
familiar	 with	 advanced	 image	 editing	
tools	such	as	Photoshop.	

Pixlr	 Express	 is	 for	 newbies	 in	 image	 editing	 or	 users	 who	 need	 to	
perform	 quick	 image	 enhancements	 without	 tweaking	 many	 buttons	
or	details.	Preset	 filters	are	available	 in	 the	same	manner	 that	 they	are	
provided	 in	 the	mobile	photo	 sharing	 application	 Instagram.	Pixlr	 also	
has	a	mobile	application	for	users	who	want	to	edit	photos	straight	from	
their	smartphones.

Choosing	 between	 Pixlr	 and	 GIMP	 is	 a	 matter	 of	 convenience	 and	
preference.	GIMP	offers	Photoshop-level	image	manipulation	while	Pixlr	
provides	the	ease	and	comfort	of	quick	image	editing.	All	that	matters	is	
you	 keep	 in	mind	 the	 elements	 and	principles	 of	 design	while	 creating	
your	images,	and	also,	to	be	creative.

Image Manipulation using GIMP
Once	 you’ve	 downloaded	 and	 installed	 GIMP,	 you	 can	 now	 start	
manipulating	images	at	will.	GIMP	can	read	and	write	a	large	variety	of	
graphic	file	formats	but	it	is	most	compatible	with	the	XCF	format.	This	
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is similar to the PSD format in Photoshop which cannot be read by many 
alternative image viewers and media programs. You will not be able to 
edit your picture when you save or export its file in a format other than 
XCF. If you want to edit an XCF image, just export the file to JPEG and/
or TIFF so you can use it in other programs.

GIMP User Interface

The GIMP interface is quite plain and simple. When you run GIMP, three 
windows will pop up. There’s the Image Window, the Main Toolbox, and 
Tool Options box that provide tool-function choices.

The Main Toolbox contains a variety of tools. By clicking any of these, 
you can select, draw, and transform objects, among other things. Also 
found here are the  Tool Options section displays the properties of the 
tool that you chose. For example, when you choose the Paintbrush tool, 
you can adjust its color and diameter. 

The Layers Options shows the layer structure of the currently active 
image. The Brushes/ Patterns/Gradients Options offer options for 
choosing brushes, patterns, and gradients. 

The Image Window is the area 
where you will be primarily working 
in. The one in the following example 
indicates that a layer has not been 
opened yet, thus the image window 
is empty.

Creating a New File

Now that you have familiarized 
yourself with the GIMP interface, it 
is time to dabble with photo editing. 
For you to be more familiar with 
GIMP, you can try to create a logo 
for yourself, for starters. Explore the 
different tools.

1.	 To start, create a new file by going 
to File > New.

2.	 On the Image Size dialog box, type 720 for width and 480 
for height. This aspect ratio is used by the old standard 
TV screen size, which is how your photos will be seen if 
you incorporate them to your final cut. After setting your 
image size, click OK.

3.	 A third window will appear. This is the Image Window. 
Note that each image opened and/or created in GIMP 
will have a separate window. 
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4.	 Use the Brush tool to paint. In the Tool Options, select a brush style. For 
our purposes, use the Pencil Sketch style. Draw a logo on the Image 
Window.

5.	 To add color, click the Color Selection tool in the Main Toolbox.

6.	 After you have created your logo, add some text. Click the Text tool in the 
Main Toolbox. Select a font, font size, and font color in the Tool Options. 
After you have set up your text, click the Image Window. The Text Editor 
window will appear. Type your text. Click Close when done.

7.	 Look at the Layers Options 
window and notice that 
every time you create a new 
text in your image, GIMP 
automatically makes a 
new layer for it. Click the 
Move Layers and Selection 
tool in the Main Toolbox 
and select the layer that 
contains your text. By 
selecting the text layer, you 
may move it on the Image 
Window. Fix the position 
of your text relative to the 
logo. 

8.	 Now that you have made your logo, save your file. On the Image Window 
main menu, go to File > Save. Type a name for your file. Don’t forget to 
put “.xcf ” at the end of the name. Finally, click Save.

9.	 For you to be able to use this file in Movie Maker, you have to export it 
as another file format, let’s say jpeg, click File >Export and select jpeg or 
(.jpg). This action will save it in JPEG file format.

10.	Set the quality to 100 then click OK.

11.	 Close the Image Window.

Rotating and Cropping the Image

Sometimes, it is difficult to capture images in a perfect horizontal 
position. In GIMP, you can fix those tilted photos with the Rotate tool.
Sometimes, holding the camera in a perfect horizontal position is 
difficult. In GIMP, you can fix tilted pictures with the Rotate tool.

1.	 Select the Rotate tool in the Main Toolbox. 

2.	 Click the picture in the Image Window.

3.	 Drag the mouse to adjust the angle of the 
picture and release it when you get the 
right angle. If this is too difficult for you, 
try adjusting the Rotation Slider in the 
Tool Options.
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4.	 After rotating an image, you crop the image. 

5.	 To crop an image, click the Crop tool in the Main Toolbox. 
Then, in the Image Window, create an area for cropping by 
clicking and dragging the rectangle on the image. If you are 
satisfied with the crop area, click Crop.

Color Correction

Altering the color of your picture can cause drastic changes to its overall 
impact. To change the color, you have two options: do it manually (see 
sample below) or use the automated color correction tools. 

You can access the automated color correction tools by going to Colors > 
Auto in the Image Window main menu. The automated color correction 
tools include the following:

•	 The Equalize tool spreads the colors in the image evenly.

•	 The Color Enhance tool is used for saturating or making your colors 
brighter.

•	 The Normalize tool is used for underexposed images. It adjusts the 
whole image to equalize the light and dark areas. 

Manual Color Correction

As much as they are simple and convenient, automated color correction 
tools give you limited freedom with regard to the color of your images. 
For more options, correct colors manually. Select the Color Balance 
tool (go to Layer > Colors > Color Balance). There are three things that 
you can modify in your image: shadow, highlights, and midtone. They 
correspond to the dark, bright, and in between areas, respectively, of 
your image.

You can modify these areas by mixing the red, green, and blue channels. 
To mix the colors, drag the three sliders until you get the combination 
that suits your taste. You can also modify the brightness and contrast 

Crop tool 
Button
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of the image by selecting the Brightness-Contrast tool (Layer > Colors 
> Brightness-Contrast). Move the adjustment slider to the right if you 
want to add more brightness or contrast to your picture. Move it to the 
left if you want less. 

Another way to control the brightness and contrast of your image is 
by using the Levels tool. This gives you more control as it has three 
triangular sliders. These sliders correspond to the Input Levels. Adjust 
them to see how the image is affected.

A more precise way of adjusting your image exposure is through the 
Curves tool. Instead of sliders, what you will manipulate is a curve. 
Just click a point on the curve and drag it. The image exposure will 
immediately change. As with the Levels tool, just experiment by changing 
the curve until you get the exposure you want.
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  CHECK

A.	 Multiple choice. Shade	the	letter	of	the	best	answer.		

				A			B			C
	 	 1.	What	image	file	format	is	mostly	recommended	for		 	
	 	 				published	web	documents?

	 	 	 A.	GIF		 B.	JPEG	 C.	PNG

	 	 2.	A	principle	of	design	that	draws	the	eye	attention	to	a		
	 	 				part	of	the	document.

	 	 	 A.	rhythm	 B.	emphasis	 C.	balance

	 	 3.	The	element	of	design	that	separates	elements	within	a		
	 	 				page.

	 	 	 A.	line		 B.	shape	 C.	color

	 	 4.	Expresses	closeness	and	speed	of	movement.

	 	 	 A.	square	 B.	circle	 	 C.	triangle

	 	 5.	Emphasizes	constant	growth	of	risk	but	gains.

	 	 	 A.	triangle	 B.	circle	 	 C.	square

B.	 Fill in the blanks.	Write	the	answer	on	the	blak	provided.	Choose	from	
the	words	in	the	box.

___________	1.	 The	repetition	of	one	or	more	elements	in	a	design	

___________	2.	 The	feeling	of	harmony	that	is	created	by	all	the			
	 	 	 parts	and	elements	of	a	design	

___________	3.	 Produced	by	an	object	that	reflects	light	

___________	4.	 The	equal	distribution	of	weight	in	a	design

___________	5.	 The	look	or	feel	of	a	surface	

Balance Emphasis Rhythym Unity

Contrast Size Texture Color

The Stretch Contrast 
tool, like the Normalize 
tool, equalizes image 
brightness and contrast. 
But here you have three 
controls: the red, green, 
and blue channels of the 
image. Adjusting these 
will give you more color 
options.

The Auto Levels tool 
can be located by going 
to Tools > Color Tools 
> Levels in the Image 
Window menu. Then, 
click the image to bring 
up its dialog box. Press 
the Auto button. To see 
the effect of this tool, 
click OK. Pressing Cancel 
brings your image back 
to its previous state.

EQUIP
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C.	 Essay.	How	does	social	networking	help	you	in	your	daily	life?

  BUILD

Using	 the	 image	authoring	or	 editing	 tool	of	 your	 choice	 (GIMP,	Pixlr,	
Photoshop,	etc.),	to	create	a	poster	about	your	topic.	While	making	your	
poster,	keep	in	mind	the	elements	and	principles	of	design.
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LESSON 7 HOW DO WE USE INFOGRAPHICS 
Target
At the end of this lesson, 
you will be able to

• Learn the principles   
 of visual message design  
 using infographics or i  
 nformation design
• Apply the basic   
 techniques of    
 image manipulation
• Create images through  
 Piktochart

  EXPLORE
In	lesson	1,	you	have	learned	the	elements	of	design,	uses	of	shapes,	and	
discovered	editing	tools.	Now,	in	this	lesson,	you	will	apply	your	previous	
knowledge	in	design	in	making	infographics	for	your	project.	Before	we	
start,	do	the	activity	below.	

You	 and	 your	 friends	 decide	 to	 sell	 pastillas	 and	 other	 sweets	 in	 your	
school.	You	want	to	see	the	growth	of	your	earnings	since	day	1	and	show	
it	 to	your	friends	without	them	seeing	the	breakdown	of	your	earnings.	
To	do	this,	you	use	a	graphical	representation	of	your	earnings.	Use	the	
data	provided	below.

Earnings 1st Month 2nd Month 3rd Month 4th Month

Pastillas 210.00 150.00 320.00 400.00

Other Sweets 150.00 300.00 300.00 500.00

Draw	a	chart	or	graph	below	representing	the	data	listed	above.

TO PRESENT THE DATA WE HAVE?
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  EXAMINE

Since	the	advent	of	minimalist	design,	we	have	seen	many	infographics	
similar	 to	 the	 one	 above	 in	 every	 area	 of	 our	 society.	 From	 printed	
posters	to	websites,	and	even	in	campaign	ads,	infographics	and	graphic	
organizers	 are	 prevalent.	 But	 no	 matter	 what	 the	 medium	 is,	 they	 all	
represent	 information	 in	 a	 more	 eye-catching	 manner	 than	 full-text	
reports.	 In	 this	 lesson,	 you	 will	 learn	 the	 various	 things	 you	 need	 to	
consider	when	making	effective	infographics.

Before	discussing	this	in	depth,	let	us	first	look	at	the	difference	between	
graphic	design	and	information	design.

Graphic Design Versus Information Design
Graphic	 design	 is	 mostly	 concerned	 with	 elements	 of	 design	 such	
as	 typography,	 color,	 images,	 and	 use	 of	 space.	 On	 the	 other	 hand,	
information	 design	 is	 the	 effective	 presentation	 of	 information	 using	
design	elements	and	techniques.

Infographic from the United States Department of Agriculture

At a quick glance, 
what do you see in this 
poster?

  EXAMINE

What can you say about the 
design?
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The	 absence	 of	 proper	 planning	 and	 research	 in	 the	 development	
of	 information	 disseminated	 via	 images	 may	 cause	 communication	
problems.	

What Is an Infographic?
The	representation	of	data	using	colors,	 shapes,	 lines,	and	other	visual	
elements	 is	 called	 data	 visualization.	 Through	 data	 visualization,	
information	 overload	 caused	 by	 a	 mass	 of	 disorganized	 information	
can	be	 avoided.	Charts	 and	 graphs	were	 the	most	 common	methods	of	
data	visualization	in	the	past,	but	nowadays,	 it	serves	as	but	a	part	of	a	
more	comprehensive	way	of	presenting	not	only	data	but	other	kinds	of	
relevant	information.	This	visualization	is	called	an	information	graphic,	
or	simply,	an	infographic.

Studies	have	shown	that	65%	of	individuals	are	visual	learners.	Most	of	
the	 youth	 today	 learn	more	 through	visual	 interpretation	 and	analysis.	
The	 brain	 processes	 visual	 information	 60	 times	 faster	 than	 it	 does	
information	 delivered	 in	 other	 forms.	 The	 environment	 in	 which	 they	
conduct	 their	 daily	 activities	 and	 the	 media	 they	 frequently	 engage	
with	 exposes	 them	 to	 information,	many	of	which	 come	 in	 the	 form	of	
infographics.	

This	trend	in	visual	communication	is	a	challenge	for	all	graphic	design	
representation.	

Elements of an Effective Infographic
reliable, timely content

theme 
color 
font 
readable

virality, SEO, location, social

problem 
clever 
solution 
message

Hans Rosling is 
widely known for his 
presentations in TED 
conferences regarding 
population where he 
shows his very effective 
data visualization 
techniques. Search the 
Internet for his TED 
talks, especially when 
he used boxes for data 
visualization. 
What do you think 
make Hans Rosling’s 
presentations of data 
very effective?

INTEGRATE
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Look	 at	 the	 previous	 image.	 Here,	 the	 viewer	 can	 easily	 visualize	 the	
different	elements	 that	comprise	a	good	 infographic.	Little	explanation	
is	needed	to	fully	understand	the	image.

Things to Consider When Making Infographics

•	 A	creative	design	needs	careful	planning	and	proper	research.
•	 Explore	possible	areas	where	you	can	gather	data,	then	consolidate	into	

meaningful	information	for	the	viewers.	Keep	it	simple	and	direct	to	the	
point	to	lessen	the	eff	ort	put	into	reading.	

•	 Column	charts	are	used	to	show	changes	or	progress	over	time.
•	 Pie	charts	are	used	to	show	small	sets	of	numerical	data	in	proportions	

of	a	whole	fi	gure.
•	 Line	graphs	are	used	for	data	that	adjust	constantly	over	a	period	of	

time.			
•	 A	doughnut	chart	is	essentially	similar	to	a	pie	chart	but	can	contain	

more	data	than	the	latter	and	can	therefore	have	multiple	rings.
•	 A	bar	chart	is	essentially	similar	to	a	column	chart,	but	instead	of	

displaying	data	vertically,	it	orients	data	horizontally.

Create Infographics Using Piktochart
If	 you	 are	 already	 familiar	with	 image	
authoring	 tools,	 you	 can	 easily	 create	
your	own	infographics.	If	not,	there	are	
tools	that	are	freely	available	for	you	to	
use	to	create	infographics.

One	example	is	Piktochart.	It	is	an	easy-
to-use	 web-based	 infographic	 maker	
that	allows	users	to	create	professional-
grade	infographics	without	the	need	for	
extensive	experience	in	graphic	design.	
Piktochart	 originated	 in	Malaysia,	 and	
besides	 it	 being	 easy	 to	 use,	 almost	
every	 template	 contains	 tips	 that	 help	
in	 the	process	of	 creating	 infographics	
for	 the	 Web,	 print,	 or	 presentations	
and	reports.

An	account	is	necessary	to	access	the	services	Piktochart	provides.	

Features

Simplified	User	 Interface	 -	 Drag-and-drop	 and	 point-and-click	 actions	
make	Piktochart	easier	to	use	than	professional	design	software.	Options	
are	 trimmed	 down	 to	 the	 basics,	 which	 include	 graphics,	 background	
colors	or	images,	and	text.	Moreover,	data	can	be	imported	from	external	

Piktochart Infographics Maker



Philippine	Copyright	2017119

sources	 when	 you	 upload	 files	 from	 your	 computer	 or	 from	 external	
accounts	such	as	Google.

Preset	Templates	and	Graphics	-	Piktochart	offers	hundreds	of	templates	
crafted	 by	 professionals.	 Templates	 are	 classified	 according	 to	 format,	
such	as	 for	 infographics,	 for	presentations,	or	 for	banners,	 thus	 letting	
you	 find	 the	 appropriate	 template	 easily.	 Thousands	 of	 images,	 icons,	
and	frames	are	also	provided	for	you	to	choose	from.

High-Resolution	 Downloads	 -	 You	 can	 download	 your	 work	 in	 high	
resolution.	Available	file	formats	are	JPEG,	PNG,	and	PDF.

Professional-grade	infographics	use	various	shapes,	items,	and	graphics	
in	 order	 to	 be	 effective.	 With	 Piktochart,	 there	 are	 already	 preset	
templates	available	for	you	to	use,	and	all	that	is	left	to	do	is	customize	
the	contents	based	on	your	needs.

How do we use Piktochart?

Piktochart	 is	 a	 fairly	 straightforward	 web	
application	to	use.	Go	to	the	website,	sign	up	for	
free,	and	choose	the	template	you	like.	The	editor	
page	will	then	appear.

Use	 the	 tabs	 on	 the	 left	 side	 to	 choose	 the	
functions	and	 tools	 that	you	want	 to	use.	Do	not	
forget	 to	 enter	 an	 infographic	 title	 in	 the	 bar	
above.

After	you	have	 finished	editing	your	 infographic,	
you	can	download	the	file	as	an	image	by	clicking	
on	“File”	in	the	menu	bar	and	choosing	“Download	
as	 image”.	 A	 dialog	 box	 will	 appear.	 In	 the	 free	
edition,	 you	 can	 download	 the	 file	 in	 original	 or	
medium	size.	These	 sizes	are	 ideal	 for	uploading	
to	 the	 Web.	 For	 now,	 choose	 medium.	 You	 can	
also	 choose	 whether	 you	 want	 a	 JPEG	 file	 or	 a	
PNG	file.	Assuming	you	are	using	the	free	version	
of	Piktochart,	the	infographics	that	you	make	will	
have	a	Piktochart	watermark	on	it.
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Types of Infographics

Visual Article - an infographic in which wordy content is made more 
visual. Best used for information spread via social media. Has a strong 
title and lots of content.

Timeline - outlines events chronologically. Can either be simple 
or complex. Invites the viewer to go on a historical journey through 
interesting and relevant content and design.

Flowchart - designed to make the viewer answer a series of questions 
to reach a particular answer. Often funny and lighthearted, it also works 
well on social media. 

Cheat Sheet - serves as a quick reference for different kinds of 
information. Can also be in the form of a step-by-step process on how to 
do things. 

Comparison -   a visual comparison of two things. Best used with 
effective visual presentation and a large amount of data. 

Numerical - an infographic whose primary content is comprised of 
numbers, charts, graphs, or statistical data.

Photo Infographic - pictures are used to tell the story or message 
of the infographic. Usually designed in a simple manner using actual 
photos to answer questions or describe something.

Data Visualization - also used for large data, but the focus is on 
creative visualization. Highly dependent on design to be effectively 
visualized.

Making a Timeline Infographic
History books always have been guilty of information overload for most 
readers. Though limited in detail, a timeline infographic can improve the 
way by which things that happened in the past are presented. Products, 
brands, or trends can also be subjects of timeline infographics.

Tips
1.	 You cannot create infographics without doing research. 

2.	 Telling a great story requires extensive research. Your infographic 
must include only the most relevant and interesting information, and 
that much work may take weeks or months to do. 

3.	 The longer the timeline period, the more interesting the infographic 
should be. 

4.	 To make it easy, limit the time period. Keep it concise and direct to 
the point. 

5.	 Experiment on new color palettes by searching for free color palettes 
online.  You may also consider using sample objects from Microsoft 
PowerPoint, for example.
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6.	 Take time to arrange the shapes, banners, ribbons, and arrows 
in your infographic. Varying the widths, lengths, or colors of the 
elements can influence the overall message being conveyed.

7.	 Always consider the logical flow of the information you are trying to 
present.  If there is a need to draw branches, do so.

8.	 An image-heavy infographic generally depends on illustrations, 
but photos, when properly arranged, may produce a better effect 
depending on the design and subject matter.
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  CHECK

A.	 Identifi	cation.	Answer	the	following	questions.		
				A			B			C

	 	 1.	Pie	charts	and	bar	charts	belong	to	which	type	of		 	
	 	 				infographic?

	 	 A.	numerical	 						B.	timeline	 					C.	flowchart

	 	 2.	The	type	of	chart	that	displays	data	small	sets	of		 	
	 	 				numerical	data	in	their	respective	proportions.

	 	 A.	line	chart		 					B.	doughnut	chart					C.	pie	chart

	 	 3.	You	cannot	download	your	Piktochart	infographic	in			
	 	 				which	of	the	following	formats?

	 	 A.	line		 						B.	shape	 	 					C.	color

	 	 4.	You	can	do	any	of	the	following	with	your	output	from		
	 	 				Piktochart	except:

	 	 A.	square	 						B.	circle	 		 					C.	triangle

	 	 5.	The	type	of	infographic	whose	main	content	focuses	on		
	 	 					images.

	 	 A.	triangle	 						B.	circle	 	 					C.	square

	 	 6.	The	type	of	infographic	that	follows	and	presents	a		 	
	 	 				series	of	events.

	 	 A.	triangle	 						B.	circle	 	 					C.	square

	 	 7.	The	type	of	infographic	that	compares	two	things.

	 	 A.	triangle	 						B.	circle	 	 					C.	square

B.	 Fill in the blanks.	Write	the	answer	on	the	blank	provided.	Choose	
from	the	words	in	the	box.

___________	1.	 Careful	planning	and	extensive	research	are	needed		
	 	 	 in	the	process	of	creating	infographics.

___________	2.	 Infographics	can	be	done	in	Microsoft	PowerPoint.	

___________	3.	 In	image	manipulation,	the	resolution	is	the	same		
	 	 	 for	both	web	and	print.
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C.	 Essay.	How	eff	ective	are	infographics	in	presenting	information	to	people	
nowadays?

  BUILD
Open	your	school’s	website	and	gather	information	about	its	history.	This	
may	include	the	overall	changes	in	the	school	from	the	past	to	the	present.	
Also	consider	data	such	as	the	total	number	of	students	then	and	now,	the	
administration,	 and	 admissions.	 Afterward,	 create	 an	 infographic	 about	
the	 information	 you	 have	 gathered.	 Follow	 the	 guidelines	 given	 in	 this	
lesson.
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LESSON 8 HOW DO WE UPLOAD AND SHARE 
Target
At the end of this lesson, 
you will

• Get clear on what   
 constitutes a good fi le   
 management system
• Become familiar with   
 some of the more   
 popular image and video  
 hosting platforms

  EXPLORE
Lessons	1	and	2	covered	principles	of	design	and	things	to	consider	when	
making	an	infographic,	as	well	as	how	to	make	images	and	infographics	
using	various	tools.	In	this	lesson,	you	will	now	upload	your	works	onto	
the	 Internet	 and	 share	 these	 with	 others	 on	 at	 least	 one	 of	 the	 many	
online	image	and	video	hosting	platforms	and	social	media.

To	 start,	 write	 on	 the	 boxes	 below	 which	 websites	 or	 platforms	 you	
already	 upload	 your	 images	 and	 multimedia	 files	 on	 (Facebook,	
Instagram,	and	the	like).

OUR FILES ONLINE?

Images

Document

Videos

Others

Your Files
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  EXAMINE

Have	you	 ever	been	 in	 an	 Internet	 café	 to	do	 your	homework,	 finished	
it	 and	 then	suddenly	you	 realized	you	 forgot	your	 flash	drive	at	home?	
What	 did	 you	 do	 to	 get	 your	 homework	 from	 the	 computer	 you	 were	
working	on?

Previous	 generations	 of	 students	 	 attached	 the	 files	 they	 worked	 onto	
an	 e-mail	 message,	 sent	 it	 to	 their	 own	 email	 address,	 and	 voila!	 An	
online	backup	of	the	file	was	available.	But	as	time	passed,	file	sizes	grew	
tremendously,	 and	 at	 present	 most	 email	 services	 support	 only	 up	 to	
25	megabytes	 of	 attachments,	 while	 some	 files	—	 particularly	 those	 of	
images	and	videos	—	can	be	larger	than	this.	What	would	you	do,	if	your	
file	is	larger	than	this	allowable	attachment	size?

File Management
File	 management	 is	 the	 process	 of	 naming,	 editing,	 storing,	 and	
sharing	files.	With	a	proper	file	folder	naming	scheme	and	the	use	of	an	
understandable	hierarchy,	you	can	make	the	most	of	your	image	and	file	
collection.	File	management	is	often	done	in	the	File	Manager	interface,	
where	 files	 and	 folders	 are	managed,	 and	 you	have	 likely	 already	 been	
naming,	 moving,	 renaming,	 editing,	 copying	 and	 deleting	 files	 and	
folders	 using	 this.	 Some	 file	 managers	 are	 like	 web	 browsers,	 in	 that	
these	are	patterned	for	network	connectivity	via	protocols,	such	as	FTP	
and	WebDav.	The	role	of	these	particular	file	managers	is	to	let	the	user	
access	the	file	server	the	way	they	would	an	ordinary	file	system.

Every	file	or	document	worked	on	needs	to	named	and	kept	in	properly	
arranged	 and	 nested	 folders	 or	 sub	 folders,	 the	 organization	 of	 which	

There was a time when 
people stored their fi les 
by sending attachments 
to their own email 
addresses.

How would you save fi les that are 
larger than 25MB?
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is	 fundamental	 in	 file	 management,	 as	 directories	 and	 subdirectories	
follow	the	same	hierarchy.	

A	folder	for	primary,	or	original,	files	or	photos	should	be	kept	intact	for	
future	use	and	processing.	Folders	for	derivatives,	which	are	a	copy	of	a	
file	or	photo	or	a	modified	version	of	the	original	work	or	folder,	are	best	
employed	for	frequently	used,	revised	and	modified	files.		Archived	files	
or	photos	are	those	which	you	think	are	no	longer	in	need	of	the	present	
project	or	time	and	can	be	placed	in	their	own	specific	folders.

An	example	of	naming	conventions	of	 folders	and	files,	as	well	as	 their	
hierarchies,	can	be	as	follows:

•	 Archived
•	 Online	Files
•	 Work	in	progress

 ○ Audio

 ○ Video

 ○ Docs

 □ PDF’s

 □ .docx

 □ .xlsx

 ○ Presentations

 □ .pptx

 ○ Resources
A	well-organized	file	management	system	makes	 it	easy	 to	know	where	
everything	is.	Be	conscious	of	file	storage,	which	is	essentially	what	file	
are	in	your	folder	and	your	folder	names,	and	file	organization,	which	is	
the	hierarchy,	or	level,	of	the	folders	created,	when	you	set	up	your	file	
management	system.

As	 the	 number	 of	 your	 files	 and	 images	will	 grow	 over	 time,	 try	 to	 be	
consistent	with	the	way	you	organize	your	files	as,	in	the	long	run,	doing	
so	will	make	things	easy	on	yourself.

Online File Management and Storage 
Services
Storing	 such	 things	 as	 homework,	 projects	 and	 research	 papers	 has	
become	easier	thanks	to	cloud	storage.	These	services,	which	can	be	free	
and	can	also	be	paid	subscription	services,	give	users	a	certain	allocated	
amount	 of	 memory	 to	 store	 their	 files,	 which	 can	 then	 be	 accessed	
anywhere	by	computers,	tablets	and	even	smartphones.

One	advantage	of	these	online	storage	services	is	that	the	contents	within	
can	be	shared	with	multiple	users	using	related	services.	The	 following	
are	some	of	the	most	widely	used	online	storage	of	files	that	offer	smart	
file	management.
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Google Drive

Google	Drive	is	a	free	file	storage	and	synchronization	service	by	Google	
which	allows	its	users	to	store	and	share	files,	as	well	as	edit	documents,	
spreadsheets,	 slides,	 and	 forms	 with	 other	 collaborators.	 Files	 and	
folders,	 including	the	contents	 in	these,	can	be	shared,	and	restrictions	
can	also	be	set	on	what	the	collaborators	can	do	with	the	folders	or	files	
shared,	 such	 as	 only	 allowing	 them	 to	 see	 the	 file	 or	 allowing	 them	 to	
edit	 the	file’s	contents,	depending	on	the	kind	of	access	you	want	them	
to	have.

OneDrive

SkyDrive,	Windows	 Live	 SkyDrive,	 and	Windows	 Live	 Folders	 are	 the	
old	 names	 of	 OneDrive.	 OneDrive	 is	 an	 online	 storage	 service	 offered	
by	Microsoft,	which	it	makes	available	to	its	customers.	Files	stored	in	a	
OneDrive	account	can	be	synchronized	with	almost	any	other	device	that	
has	a	OneDrive	application	installed	in	it.

DropBox

Dropbox	is	a	service	that	allows	the	user	to	edit	a	file	and	have	that	file	
sent	 to,	 and	updated	on,	 the	 computers	of	 that	 file’s	 collaborators	who	
use	the	same	service.	This	requires	participants	to	download	and	install	
the	Dropbox	software	 into	their	computer,	which	then	creates	a	special	
folder	where	files	collaborated	on	are	stored	and	updated.	Any	changes	
done	to	a	file	are	automatically	updated	onto	the	copies	used	by	the	other	
collaborators,	who	are	also	prompted	about	the	changes.

From	 mobile	 devices,	 Dropbox	 users	 can	 upload,	 re-use,	 manage	 and	
share	selected	photos,	or	even	an	entire	album,	through	the	Internet.	

Dropbox	is	one	of	the	best	providers	for	transferring	and	sharing	specific	
photos	or	 folders	with	others.	 	There	 is	also,	 in	addition,	an	option	 for	
offline	viewing	of	files	and	photos	as	well.	
Inviting	 other	 people	 to	 join	 Dropbox	 will	 give	 an	 extra	 16	 GB	 free	
storage	to	the	subscriber	who	invited	them	in.

Videos	and	pictures	are	often	taken	
to	 remember	memories	 and	 special	
moments,	such	as	family	gatherings,	
org	 events,	 weekend	 getaways	 and	
school	 achievements,	 and	 these	
videos	 and	pictures	 can	be	 brought	
online.	For	example,	have	you	used	
Facebook	 in	 the	 past,	 to	 post	 your	
videos	 and	 images?	 Did	 you	 notice	
anything	about	 the	video	or	picture	
you	uploaded?
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Image Hosting Platforms
Chances	are	good	that	the	resolution,	and	thus	the	quality,	of	your	videos	
and	images	that	you	posted	on	Facebook	wasn’t	as	good	as	the	original,	
since	social	media	sites	need	to	reduce	resolution	of	uploaded	material	
to	ensure	fast	loading	of	content.

This	 reduction	 of	 resolution	 is	 usually	 not	 done	 with	 image	 hosting	
platforms,	which	are	online	services	dedicated	to	uploading,	viewing	and	
sharing	high	quality	 images.	Because	 image	hosting	 sites	maintain	 the	
original	 resolution,	 these	 are	 very	useful	 for	 artists	 and	photographers	
who	want	to	keep	an	online	portfolio.

Not	all	image	hosting	platforms	are	created	equal,	which	means	you	will	
need	 to	 consider	which	 online	 service,	 or	 image	 hosting	 platform,	will	
best	 cater	 to	 your	 specific	 needs.	 What	 follows	 are	 some	 of	 the	 more	
common	image	and	video	hosting	platforms	available.

Instagram

Instagram	 is	an	online	mobile	 social	networking	 service	 that	allows	 its	
members	 to	 share	 life	moments	 through	 photos	 and	 videos	 and	 share	
them	with	 either	 the	 public	 or	 only	 with	 specific	 people.	 It	 has	 a	 web	
application	but	is	mostly	used	in	mobile	devices.	

Imgur

Imgur	is	recognized	as	one	of	the	best	 image	hosting	sites	where	speed	
and	quality	of	upload	are	concerned.	A	user	account	doesn’t	have	to	be	
created	 for	 someone	 to	 use	 its	 service	 to	 quickly	 upload	 high	 quality	
images.	Imgur	is	especially	useful	if	you	want	to	share	pictures	on	social	
networking	sites	like	Facebook	but	don’t	want	to	lose	image	quality.

Google Photos
Picasa	was	 once	 a	 popular	 image	 organizer	 and	 viewer	 tool	 of	Google,	
but	 the	 company	 then	 decided	 to	 focus	 on	 creating	 a	 photo	 app	 that	
works	seamlessly	on	all	devices	—	Google	Photos.	Google	Photos	is	one	
of	the	best	applications	around	where	accessing	and	backing	up	photos	
is	 concerned.	 It	 can	 be	 synchronized	 directly	 to	 a	 personal	 account	
through	a	device	and	has	a	feature	designed	to	organize	photos	according	
to	such	descriptors	as	places,	 food,	 things,	events	or	people.	Unlimited	
free	 storage	 is	 available,	 but	 the	maximum	size	 of	 photo	 storable	 is	 16	
megapixels,	with	 larger	 sized	pictures	 being	 reduced	 to	 16	megapixels.	
An	interesting	feature	of	Google	Photos	is	that,	when	you	use	a	term	to	
search	in	the	library	of	photos,	it	will	identify	which	images	contain	the	
word	searched	for.	Using	Google	Photos	 is	a	good	way	to	manage	 files,	
especially	if	you’re	a	fan	of	Android	devices,	because	it	will	then	already	
be	built	in	to	your	phone.
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Flickr

Flickr	 allows	 for	 free	 photo	 sharing	 and	 hosting	 amongst	 social	
networking	users,	has	editing	features	to	enhance	photos	and	organizes	
these	photos	into	albums	for	later	sharing.	Flickr	also	has	such	security	
features	as	making	the	photos	and	albums	available	to	only	to	a	selected	
audience.

Photobucket

Photobucket	 is	 a	 site	 where	 images,	 photos,	
videos,	 and	 slideshows	 can	 be	 stored	 and	 shared,	
even	 if	 those	 shared	with	 don’t	 have	Photobucket	
accounts.	 Some	 of	 its	 functional	 features	 include	
allowing	for	collaboration	with	friends	and	families	
on	a	photo	album;	a	built-in	organizer	that	enables	
easy	 placement	 of	 photos	 into	 albums;	 an	 integrated	 photo	 editor	 that	
lets	 users	 fix	 their	 photos	 and	 add	 stickers,	 frames,	 and	 the	 like;	 a	
scrapbook	builder;	a	slideshow	builder;	and	a	remix	builder,	which	users	
can	use	to	put	together	photos	and	videos	and	music	for	online	posting.

Video Hosting Platforms
Youtube

Perhaps	 the	 most	 popular	 video	 hosting	
website	 today	 is	YouTube,	which	 is	a	website	
where	 users	 can	 upload,	 view,	 and	 share	
video	 clips.	 Most	 of	 the	 content	 found	 on	
YouTube	 has	 been	 voluntarily	 uploaded	 by	
members	 and	 can	 be	 watched	 or	 embedded	
into	 websites	 of	 both	 registered	 and	 non-
registered	 users.	 A	 video	 that	 has	 been	

uploaded	to	the	site	can	be	immediately	watched	by	millions	of	viewers,	
thanks	to	 its	ease	of	use,	and	due	to	the	resulting	enormous	number	of	
uploaded	videos	on	the	site,	YouTube	has	developed	a	user-moderation	
system	 of	 “flagging”	 and	 labeling	 to	 rank	 its	 videos	 as	 “most	 viewed,”	
“most	discussed,”	“favorites,”	and	so	on.

Vimeo

Founded	 by	 Jake	 Lodwick	 and	 Zack	 Klein	 in	
2004,	 Vimeo	 is	 the	 first	 global	 video	 sharing	
website	 to	 support	 high-definition	 video	 user	
uploads,	shares,	and	views.	Vimeo	users	enjoy	
unlimited	 bandwidth,	 minimal	 video	 buffering,	 can	 sell	 or	 rent	 their	
videos	 and,	 best	 of	 all,	 enjoy	 accounts	 that	 are	 ad-free	 for	 uploaded	
videos.

Vimeo,	however,	is	not	without	flaws.	It	might	give	you	a	choice	between	
free	 and	 paid	 account,	 but	 as	 of	 now,	 there	 is	 not	 much	 difference	
between	paid	and	free	accounts.	That	said,	you	should	not	expect	much	
from	Vimeo’s	customer	service	if	you	only	have	a	free	account.

Felix Arvid Ulf Kjellberg, 
widely known as 
PewDiePIe, is one 
popular YouTuber known 
for his comedic game 
commentaries, and 
vlogs.  His vlogs were 
so viral that in 2012, he 
already surpassed one 
million subscribers, and 
in 2017, he reached over 
53 million subscribers 
(“PewDiePieChannel”. 
YouTube. Retrieved 23 
February 2017).  He now 
earns a lot and helps a 
lot of charities from the 
proceeds because of his 
videos.

But how did he do this?

1. What factors do 
you think makes his 
videos viral?

2. How do you think 
does PewDiePie earn 
his fi nancial growth?

3. How can you surpass 
his achievements on 
YouTube?

INTEGRATE
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How to upload your fi les and images

1.	 First,	sign	up	with	any	image	hosting	website.
2.	 Look	for	the	folder	in	your	computer	where	the	fi	le	or	photo	you	want	to	

share	can	be	found.
3.	 Select	the	chosen	photos/fi	les	you	want	to	upload.	Pressing	Shift	enables	

you	to	select	more	than	one	fi	le.	
4.	 Click	and	drag	the	selected	fi	les	to	the	image	hosting	website	to	upload.	

Click	the	Share	button	for	purpose	of	allowing	others	to	see	or	edit	such	
fi	le/photo.	

5.	 Lastly,	enter	the	email	addresses	of	the	people	you	want	to	share	your	
fi	les/album	with.

Sharing Files with Google Drive

Sharing Files

There	 are	 two	 ways	 to	 share	 files	 stored	 in	 Google	
Drive.	 The	 first	 method	 requires	 you	 to	 enter	 the	
email	addresses	of	 the	people	you	want	 to	share	 the	
file	with.	To	do	this,	just	click	the	arrow	down	beside	
folder	 (if	 it	 is	 a	 file,	 right	 click	 the	 file)	 and	 select	
Share.	
	
Enter	 the	 email	 addresses	whom	 you	want	 to	 share	
the	 folder	 (or	 file),	 then	 on	 the	 combo	 box	 on	 the	

side,	choose	which	kind	of	access	you	want	to	give	them.

The	 second	 way,	 if	 you	 don’t	 want	 to	 manually	 enter	 tons	 of	 email	
addresses,	 is	 to	 share	using	 a	 “Shareable	Link,”	which	 is	 automatically	
generated	by	Google.	You	can	also	specify	needed	access	limits.
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  CHECK
A.	 Identifi	cation.	Answer	the	following	questions.	

___________	1.	This	is	an	online	storage	service	by	Microsoft.		 	
	 	 										Previously	know	as	SkyDrive.
___________	2.	This	is	an	image	hosting	site	that	was	preceded	by		
	 	 										Picasa.
___________	3.	This	is	a	video	hosting	site	whose	users	have		 	
	 	 										unlimited	video	bandwidth.
___________	4.	He	is	a	famous	YouTuber	that	gained	millions	of		 	
	 	 										subscribers	in	a	span	of	five	years.
___________	5.	This	image	hosting	site	is	known	for	quick	uploading		
	 	 										of	images.	You	don’t	even	have	to	register	an	account		
	 	 									to	do	so.
___________	6.	The	purpose	of	this	is	to	let	the	user	access	the	file		
	 	 										server	like	an	ordinary	file	system.
___________	7.	This	is	an	online	storage	service	where	you	can	give	a		
	 	 										shareable	link	and	set	limits	on	its	user	access.
___________	8.	This	is	the	process	of	naming,	editing,	storing,	and		
	 	 										sharing	files.
___________	9.	This	is	an	image	hosting	site	widely	used	in	mobile			
		 				 										(Android)	devices.
___________10.	This	online	storage	service	allows	a	user	to	edit	a		
		 	 											file,	which	will	then	be	updated	on	the	computers	of		
	 	 											other	collaborators	of	that	file	using	the	same	service.

B.	 Enumeration.	List	down	5	popular	social	networking	sites.

1.	

2.

3.

4.

5.

   BUILD

Choose	 any	 photo	 hosting	 web	 site	 and	 upload	 your	 poster	 and	 other	
images	for	your	proposed	project.	Make	sure	to	apply	proper	permission	
usage	 so	 your	 groupmates	 can	 access,	 edit	 and	 share	 your	 poster	 and	
images.	

Optional: Organize	 your	 photos	 and	 upload	 these	 onto	 a	 free	 image	
hosting	site	for	future	sharing	with	friends	and	loved	ones.



LESSON 9 HOW TO USE VIDEOS AS MEDIA 
Target
At the end of this lesson, 
you will

• Get clear on what   
 constitutes a good fi le   
 management system
• Become familiar with   
 some of the more   
 popular image and video  
 hosting platforms

  EXPLORE
In	the	previous	lessons,	you	have	learned	to	create	your	own	posters	and	
images	and	share	them	over	the	Internet.	

Almost	every	one	of	us	 likes	 to	watch	movies,	TV	shows,	 cartoons,	and	
many	other	forms	of	video	entertainment.	We	also	have	our	own	opinion	
or	rating	of	a	video	depending	on	how	much	it’s	worth	watching,	and	the	
same	goes	for	movie	reviews	and	other	form	of	evaluation	on	how	good	a	
show	is.	But	what	exactly	are	the	things	you	are	looking	for	to	say	that	a	
show	or	movie	is	good?	What	are	the	things	that	make	you	say,	no,	that	
is	not	a	good	film?	Write	down	your	answers	below.

TO CONVEY INFORMATION?

Philippine	Copyright	2017133
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  EXAMINE

Video Production
“As of March 2015, creators fi lming in YouTube Spaces have produced over 
10,000 videos which have generated over 1 billion views and 70+ million hours of 
watch time.” (YouTube, 2017)

Previous	 generations	 of	 students	 	 attached	 the	 files	 they	 worked	 onto	
an	 e-mail	 message,	 sent	 it	 to	 their	 own	 email	 address,	 and	 voila!	 An	
online	backup	of	the	file	was	available.	But	as	time	passed,	file	sizes	grew	
tremendously,	 and	 at	 present	 most	 email	 services	 support	 only	 up	 to	
25	megabytes	 of	 attachments,	 while	 some	 files	—	 particularly	 those	 of	
images	and	videos	—	can	be	larger	than	this.	What	would	you	do,	if	your	
file	is	larger	than	this	allowable	attachment	size?

Videos	are	undeniably	an	excellent	platform	to	communicate	information	
to	 a	 large	 audience.	 Different	 sectors	 of	 society	 try	 to	 exploit	 this	
medium	to	maximize	its	potential	and	purpose.	Businesses	use	video	ads	
on	 television	and	on	 the	 Internet	 to	 reach	consumers	 in	a	manner	 that	
promotes	 brand-retention	 in	 the	 consumers’	minds.	 This	 is	 often	done	
with	 the	 use	 of	 a	 story	 or	 format	 that	 viewers	 can	 relate	 to,	 and	 that’s	
how	views	are	perpetuated.

Successful	videos	often	require	the	services	of	tenured	video	production	
companies	 to	 provide	 great	 results,	 but	 that	 doesn’t	 mean	 you	 cannot	
produce	 your	 own	 quality	 video.	 By	 carefully	 studying	 the	 following	
elements	and	practices,	you	can	also	make	your	own	effective	and	quality	
videos.

Captain America: Civil 
War is one of the more 
popular Marvel movies.  
It involved many actors 
and actresses who 
fi t in to the character 
so snugly, they have 
become the “face” of 
the superhero characters 
themselves. 

Cast of the Marvel movie, “Captain America: Civil War”

Are you familiar with 
James Cameron movies 
like Titanic and Avatar? 
If yes, how do you think 
careful planning helped 
Cameron win various 
awards for his fi lms?

INTEGRATE
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Elements of a Video/Film

The	 following	 are	 the	 five	 categories	 that	
are	critical	to	effective	videos.

Sight	–	 this	 refers	 to	 the	visual	 aspect	of	 a	
video,	whether	captured	by	a	camera	or	animated.	Each	frame	in	a	video	
is	crafted	in	a	certain	way	to	convey	a	message,	mood,	or	situation.

Sound –	 this	 complements	 the	 video	 as	 sound	 effects,	 music,	 and	
synchronized	 sounds	 (conversations	 and	 natural	 sounds).	 There	 was	
a	 time	 when	 movie	 productions	 couldn’t	
synchronize	the	audio	with	the	video	so	they	
used	live	music	to	complement	the	film.	

Sight	 and	 sound	 are	 the	 two	 elements	 that	
basically	constitute	a	video.

Color	 –	 creative	 use	 of	 color	 imparts	
underlying	impressions	to	a	certain	scene.	

Motion	–	 through	movement,	 filmmakers	 lead	 the	audience’s	attention	
on	the	purpose	of	each	scene.

Emotion	 –	 this	 refers	 to	 the	 “feels”	 of	 the	
video	 that	 allow	 the	 audience	 to	 relate	 to	
the	 video.	 This	 makes	 the	 presentation	
engaging	and	interesting	to	its	audience.

Stages of Video Production

Whatever	video	you	are	making,	be	it	a	one-minute	promotional	video,	a	
vlog,	a	documentary,	or	a	film,	the	stages	of	video	production	are	usually	
the	same.	They	are	divided	into	three	stages:	pre-production,	production,	
and	post	production.

Pre-Production

This	is	the	planning	stage	where	all	the	crucial	preparations	are	done.	This	
is	where	the	vision	of	the	outcome	of	the	video	production	is	 identified	
and	 the	 specifications	of	 the	production	are	defined.	The	 following	are	
the	 things	 involved	 in	 professional	 pre-production	 according	 to	 Amy	
Ferzoco	of	Catmedia.com	(Ferzoco, 2015).

•	 Project	kickoff	
•	 Production	schedule
•	 Script	development
•	 Storyboards
•	 Graphics	concepts
•	 Location	scouting
•	 Prop	and	wardrobe	identifi	cation	and	preparation
•	 Post-production	preparation
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Production

This is where the fun part or the actual shooting of scenes take place. 
This is also the important part where the director keeps a keen eye on 
every detail during the shooting, making sure that the intended scene or 
message is relayed by the cast with the support of the crew.

Post Production

This is the editing stage where the recorded video and audio footage are 
assembled in relation to the script. Music, synchronized sounds, and 
visual effects are added along with color or audio correction to suit the 
requirements of the director and the script.

Storyboarding
Storyboarding is part of the pre-production stage. But what is a 
storyboard?

 A storyboard is the visual representation of your video. It illustrates each 
important scene that can be found on your audio-visual presentation 
(AVP).   From the beginning, to the rise of action, to the conflict or 
climax, and down to the resolution or end, this is the essential mapping-
of-illustrations step in the pre-production process. This ensures there 
will be no more changes in the actual video shoot and there’s adherence 
to the budget.
But how do we develop the storyboard? Let’s first know the five elements 
of a story.

Setting 

It is the time and location where the story occurred. This may cover a 
certain period, like an event from the past and covers the general mood 
of the time, such as the gloom of wartime or the thrill of age of discovery. 
Some movies are content to show the geographical location of the story.

Character 

Character is the personality that moves within the story. It can be a 
character or the characteristic of a person, animal, or thing that is 



Philippine	Copyright	2017137

followed	in	the	story.	It	may	embody	the	qualities,	morals,	 intellectual,	
or	emotional	qualities	of	a	person	which	may	be	expressed	in	the	action	
or	dialogue.

Within	 a	 story,	 character	 is	 comprised	 two	 sides—one	 that	 exemplifies	
good	or	moral	righteousness—the	protagonist	or	hero,	and	another	that	
is	often	selfish	and	cruel—the	antagonist.	or	villain.

Plot

This	 is	 the	 sequence	 of	 events	 within	 the	 story;	 the	 logical	 series	 of	
happenings	including	the	conflict,	or	stress	part,	of	the	story.	In	a	short	
story,	there	is	only	one	basic	plot	so	that	the	reader	can	read	or	view	the	
events	 in	 one	 sitting.	The	 conflict	 or	 problem	 is	 presented	 early	 in	 the	
story	 and	 the	 unexpected	 event	 or	 surprise	 is	 part	 of	 the	 events	which	
unfold.	

In	a	plot,	every	part	of	a	story	should	be	closely	related	and	 link	to	 the	
next	unconcluded	scene,	as	these	comprise	the	order	and	sequence	of	the	
story	 that	will	engage	and	excite	 the	audience.	The	plot	starts	 from	the	
beginning	 of	 the	 story,	 to	 the	 rising	 of	 actions	 of=r	happenings,	 to	 the	
problem	or	 conflict/turning	point,	 to	 the	 recession	or	 falling	action,	 to	
the	final	resolution	and	closing	of	the	story.

Conflict

This	is	the	struggle	between	two	things	or	people	in	a	story.	On	the	other	
hand,	a	character	may	struggle	not	only	against	another	person,	but	also	
against	the	forces	of	nature,	society,	or	even	to	himself.

Theme 

It	 is	 the	 central	 point	 or	 belief	 of	 the	 story.	 It	 is	 the	main	 idea	 being	
revealed	or	interpreted	in	the	story.

Storyboard Template

No:
Scene/Location:
Character/Dialogue:
Animation:
Transition:
Camera Shot:
Audio/Background:

No:
Scene/Location:
Character/Dialogue:
Animation:
Transition:
Camera Shot:
Audio/Background:

No:
Scene/Location:
Character/Dialogue:
Animation:
Transition:
Camera Shot:
Audio/Background:

No:
Scene/Location:
Character/Dialogue:
Animation:
Transition:
Camera Shot:
Audio/Background:

No:
Scene/Location:
Character/Dialogue:
Animation:
Transition:
Camera Shot:
Audio/Background:

Beginning Rise Middle/Confl ict Fall End

For more ideas on how 
an AVP storyboard is 
constructed here is the 
website you can visit. 

http://www.
storyboardthat.com/
storyboards/trebrooks/
storyboard-1-avp

INTEGRATE
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No.	is	the	number	used	for	the	series	or	sequencing	of	events.

Scene	is	for	the	location	setting	where	the	event	would	take	place.

Character	is	for	the	person,	animal	or	thing	that	will	act	in	relation	to	the	
scene.	It	may	follow	through	with	the	conversation	of	the	character(s)	as	
needed.

Animation	is	the	visual	effect	that	you	usually	apply	like	in	a	PowerPoint	
presentation	which	includes	fade,	wipe,	fly	in,	or	slide.

Transition	 is	 how	 a	 slide	 or	 frame	would	move	 in	 relation	 to	 the	 next	
one.	Transitions	include	wipe,	push	a	split,	or	dissolve,	to	name	a	few.

The	 Camera	 shot	 is	 categorized	 between	 three	 to	 four	 kinds,	 namely	
close	up,	extreme	close	up,	middle	or	medium	shot,	and	long	shot.

The	background	sound	and	audio	are	the	sound	effects	or	audio	backdrop	
that	sets	the	locale.

Microsoft	Movie	Maker	is	a	popular	video-editing	program	for	Windows.	
You	can	use	 it	 to	apply	various	effects	 in	making	your	own	mini	movie	
clip.	 With	 the	 use	 of	 its	 timeline,	 you	 can	 view	 the	 exact	 and	 precise	
application	of	certain	effects	in	a	video.	You	can	save	your	movie	like	its	
an	editable	storyboard.

Things to consider in making a video 
Planning	 is	 the	 key.	 Spend	 more	 time	 on	 pre-production	 to	 save	 on	
money.	

Every	 time	 you	 work	 on	 something,	 preparations	 are	 needed.	 Think	
of	 the	purpose	of	 this	project.	Will	 it	be	 just	 for	 the	classroom	with	no	
intention	to	be	used	in	a	film	festival	or	exhibit?	Do	you	plan	to	upload	
it	later	on	YouTube	or	other	some	other	video	sharing	site?	Would	it	be	a	
commercial	or	promotional	material	or	is	it	simply	for	fun?

Knowing	what	 is	expected	at	 the	end	will	 lead	the	 focus	of	 this	project.	
Make	a	schedule	to	follow	for	the	shoot.	Track	things	needed	in	the	shoot	
and	find	out	what	are	essential	to	trim	the	list	down.	A	mini-clip	does	not	
require	much,	so	get	the	character	and	the	appropriate	locale	right	from	
the	start,	so	that	you	don’t	have	second	thoughts	during	production.	

Well-crafted	scenes	are	 important	 for	 them	to	be	dynamic	and	vibrant.	
Camera	 angles	 and	movements	 can	 help	 the	 eye	 follow	 through	 to	 the	
next	 scene.	They	 can	motivate	 and	 inspire	 the	 viewers	 to	be	 interested	
and	be	hooked	until	the	end	of	the	video.	

Rushing	ideas	can	give	you	inadequate	possibilities	so	write	 it	all	down	
and	 know	what	 you	want.	 Every	 aspect	 of	 production	 is	 related	 to	 the	
budget	and	you	can	only	do	so	much	where	money	is	concerned.	

Keep	 in	mind	 the	number	or	days	 allotted	 for	 the	project.	 Its	due	date	
and	presentation.

Visit this website for 
some tips in storyboard 
making: 

https://www.
youtube.com/
watch?v=LgDwNxGIuCQ

EQUIP
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Don’t	be	discouraged	about	criticism.	This	is	your	production	and	what	
better	way	to	learn	and	share	this	exciting	experience	than	in	a	showcase	
for	 critics?	 	 Years	 from	 now,	 you	 may	 view	 your	 mini-clip	 and	 laugh	
about	 it	or	maybe	 this	would	 lead	 to	you	getting	 fame	and	 fortune	 if	 it	
goes	viral	online.	But	don’t	get	ahead	of	yourself.	Just	finish	the	job	and	
enjoy	whatever	 is	 there	 to	 experience	 in	 the	making	 of	 your	 AVP.	 The	
show	must	go	on.

Video Editing Applications
Video	editing	comes	last	in	the	stages	of	production	but	even	so,	during	
the	 logistics	 planning	 in	 the	 pre-production	 stage,	 your	 team	 should	
already	 have	 identified	 which	 tool	 to	 use.	 Do	 you	 want	 to	 use	 Adobe	
Premiere	 Pro?	That	would	 be	 a	 great	 tool	 for	 professional	 editing.	 But	
as	 a	 student,	 can	 you	 afford	 it?	 Does	 it	 suit	 your	 need	 and	 is	 the	 cost	
worth	 it?	 Professional	 editing	 tools	 are	 expensive	 because	 they	 offer	 a	
variety	of	editing	capabilities	over	free	tools	that	are	downloadable	from	
the	Internet.	But	this	doesn’t	mean	you	can’t	create	quality	videos	from	
those	free	tools.	

Windows	Live	Movie	Maker	for	example,	in	conjunction	with	a	creative	
mind,	 can	 be	 used	 to	 create	 quality	 edited	 videos.	 Unfortunately,	
Microsoft	 is	 officially	 ending	 its	 support	 for	 this	 program	 in	 2017.	But	
there	are	lots	of	free	video	editing	tools	out	there	that	are	just	as	good,	if	
not	better	thab	Movie	Maker.	

Here	are	some	of	the	popular	video	editing	software	that	you	can	use	for	
free.	(Wilson, 2017)

Adobe Premiere Pro CC
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Lightworks

Dubbed	 as	 a	 professional	 video	 editor	 for	
everyone,	 Lightworks	 is	 indeed	 powerful	
because	 it’s	not	 just	 a	 simple	 tool	 for	 cutting	
video	 clips.	 It	 works	 on	 all	 major	 operating	
systems	(Windows,	Linux,	Mac)	and	supports	
almost	every	format	you	can	think	of	without	
the	need	 for	 transcoding.	 It	 is	also	optimized	
for	 speed	 in	 rendering	 and	 offers	 various	
powerful,	real-time	effects	with	inbuilt	presets	
and	many	features	that	are	often	only	present	
in	 paid	 professional	 video	 editors.	 In	 other	
words,	it	is	truly	a	powerful	professional	video	
editor.
	
Above	 is	 a	 scene	 from	 the	movie,	 The	King’s	
Speech,	 a	 2010	 British	 biographical	 drama	
film	 directed	 by	 Tom	 Hooper	 and	 written	
by	 David	 Seidler,	 starring	 Colin	 Firth,	 as	 King	 George	 VI,	 and	Helena	
Bonham	Carter	as	Queen	Elizabeth.	It	won	an	Academy	Award	for	Best	
Picture	 in	 2010.	 You	 wonder	 why	 it	 was	 mentioned?	 Because	 Tariq	
Anwar,	 the	 editor,	 used	 Lightworks	 in	 cutting	 the	movie.	 (Lightworks,	
2017)	

Image taken from Softonic.com - https://screenshots.en.sftcdn.net/en/scrn/318000/31
8077/54bd2773bd0e7scr_1421675338-700x355.png

Scene from the film, The King’s Speech (2010)

You can learn more 
about Lightworks on 
their website. You have 
an option to download 
the free app or buy the 
professional subscription-
based license.

EQUIP
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VideoPad Video Editor

VideoPad	 is	 a	 beginner-friendly	 video	 editor	 that	 offers	 excellent	
features.	 It	 does	 a	 great	 job	 in	 achieving	 a	 balance	 between	 being	 an	
“easy-to-use”	and	“professional”	video	editor.	It	does	not	offer	as	much	
features	as	Lightworks,	but	 it	 still	offers	an	excellent	array	of	practical	
editing	tools.

Shotcut

Shotcut,	originally	an	app	made	for	Linux,	had	an	unusual	user	interface	
which	 is	 friendly	 for	 users	 to	 find	 their	 way	 (most	 of	 the	 time)	 when	
using	the	app.	Shotcut	has	a	steep	learning	curve	which	requires	a	great	
deal	of	patience,	but	according	to	TechRadar,	“…real	rewards	will	only	be	
reaped	by	those	willing	to	invest…”	(Wilson,	2017).	Shotcut	nevertheless	
is	a	powerful	professional-feeling	video	editor.

Image taken from Softonic.com - https://screenshots.en.sftcdn.
net/en/scrn/78000/78069/videopad-video-editor-01-700

x525.png

Shotcut App



Philippine	Copyright	2017 142

  CHECK
A.	 Multiple Choice. Encircle	the	letter	of	the	best	answer	from	the	choices	

given.	

1.	 The	stage	in	video	production	where	the	actual	footage	is	shot
a.	 Production
b.	 Pre-production

c.	 Post-production
d.	 Production	compilation

2.	 The	stage	in	video	production	when	all	of	the	editing	is	done	
a.	 Production
b.	 Pre-production

c.	 Post-production
d.	 Production	Presentation

3.	 The	one	who	is	responsible	for	composing	the	words	that	will	be	said	on	
camera
a.	 Actor
b.	 Director

c.	 Illustrator
d.	 Scriptwriter

4.	 Videos	in	today’s	generation	are	very	helpful	in	many	ways,	except	one.
a.	 Present	real-life	examples	and	situations
b.	 Can	be	a	medium	of	instruction
c.	 Makes	understanding	subjects	and	ideas	complex
d.	 Attention-catching	when	presenting	information

5.	 The	act	of	making	graphic	organizers	in	the	form	of	illustrations	or	images	
displayed	in	sequence	for	the	purpose	of	pre-visualizing	a	motion	picture.
a.	 Planning
b.	 Sequencing

c.	 Storyboarding
d.	 Visualizing

6.	 The	act	of	recording	scenes	based	on	the	storyboard
a.	 Video	editing	
b.	 Video	organizing

c.	 Video	shooting	
d.	 Video	sorting	

7.	 The	process	of	manipulating	and	rearranging	video	shots	to	create	a	new	
work
a.	 Video	editing	
b.	 Video	shooting

c.	 Video	production
d.	 Video	transitions

B.	 True or False.	Write	TRUE	if	the	statement	is	correct	and	FALSE	if	the	
statement	is	incorrect.	Write	your	answer	before	each	number.	

1.	 Videos	are	very	helpful	in	the	sense	that	they	provide	a	
detailed	and	interesting	means	of	presenting	ideas	that	
text	and	graphics	cannot	give.

2.	 A	video	production	is	divided	into	three	phases:		
pre-production,	production,	and	post-production.

3.	 Video	editing	applications	allow	you	to	assemble	
diff	erent	media	assets	to	create	a	fi	nal	output.
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C.	 Fill the Pyramid. Complete the Video Production Pyramid by 
classifying which stage of video production the following actions occur in. 
Write your answers inside the triangle. 

D.	 Prove It. Discuss why video editing is considered both a technical 
process and an art. (4 points) 

Audio Narration
Color Correction
Concepts
Crew
Dub

Equipment
Field and Studio Shooting
Final Edit
Location
Objective

Props
Research
Script
Storyboard

Talent
Visualization

Post Poduction

Poduction

Pre-Poduction

VIDEO PRODUCTION PYRAMID

jlnepomuceno
Cross-Out

jlnepomuceno
Inserted Text
Production

jlnepomuceno
Cross-Out

jlnepomuceno
Inserted Text
Production

jlnepomuceno
Cross-Out

jlnepomuceno
Inserted Text
Production
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E.	 Compose Your Own. Think of a trailer of a latest movie you have 
recently seen and create a storyboard on it. The flow of the story is up to 
you. 

SETTINGS

CHARACTER

PLOT

CONFLICT

THEME
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  BUILD

With	 the	 video	 production	 techniques	 you	 learned	 in	 this	 lesson,	 your	
group	 is	 tasked	 to	 create	 a	 2	 to	 3-minute	 video	 (TV	 commercial,	 short	
video,	 informational	 video)	 that	will	 present	 the	 cause	 of	 your	 project.	
You	must	be	able	to	make	a	script	and	storyboard	and	use	these	two	as	
your	director’s	first	steps	in	producing	your	video.

Choose	who	will	 be	 the	director,	 scriptwriter,	production	 staff	 (camera	
man,	props),	and	casts.
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MODULE 3
How do We use ICT to Collaborate in Project 
Development?

Learning Outcomes
•	 Use	online	platforms	to	publish	content	online.

•	 Collaborate	with	peers	using	online	collaboration	tools.

•	 Recognize	the	importance	of	good	web	design.

•	 Observe	how	web	hosting	and	domain	names	work.

Portfolio Output
Digital Reflection Paper

In	this	module,	you	are	expected	to	create	a	blog	on	what	you	have	learned	
in	this	module.	You	will	also	showcase	the	websites,	the	documents	you	
have	made	n	all	the	lessons	in	this	module.	

Choose	a	blogging	platform	of	your	choice	(blogger.com,	wordpress.com,	
etc.)	and	write	a	post	about	the	 learnings	you	acquired	for	each	 lesson.	
Also,	provide	a	link	and	attach	screenshots	of	each	of	your	Build	output	
to	this	blog	site.
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 Criteria Excellent
5 PTS

Very Good
3 PTS

Needs Practice
1 PT

Personal Reflection

Entries are high quality 
consisting of personal 
reflections that connect 
real-life, learning, and 
technology.

Connects ideas and 
thoughts to personal life.

Lack of connection to 
personal life.

Accuracy of Information 
All the information 
discussed are accurate and 
true.

Some information 
discussed are not true.

Lack of information 
discussed. 

Quality of Content
Rich in content and provide 
an insightful analysis on 
each acquired learning.

Has substantial content 
and provides moderate 
analysis on some acquired 
learning.

Has superficial content 
and provides unfinished/
incomplete analysis on 
some acquired learning.

Links 
All outputs are correctly 
linked to the correct work.

Some outputs are correctly 
linked to the correct work.

No output is correctly 
linked to the work.

Showcasing of Skills
All outputs are complete 
and creatively done.

Only some outputs are 
complete but creatively 
done.

Only a number of outputs 
are complete and some 
of them are not creatively 
done.
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Lesson 10: Which online content platforms 	
		      should I use?

•	 Rich Web Content and Platforms for Content Development

•	 Social Networking Sites

•	 Blogging Sites vs. Content Management Systems

•	WordPress – Content Management System

Portfolio Task 1 – At the end of this lesson, you will create your own 
WordPress.com website. You are free to choose any topic you want to 
share in your WordPress site. To do this, you need to accomplish the 
following: outline of site content, sitemap, and finished WordPress.com 
site.

Lesson 11: What tools can I use to 			 
	  	     collaborate online?

•	 Tools for Collaboration

•	 Online Collaboration Tools

•	 Trello and Kanban

Portfolio Task 2 – At the end of this lesson, you will build your 
own Kanban board using the materials specified in the Build section. 
Afterwards, you will translate it to a digital Kanban board using Trello.
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Lesson 12: How do we use web design 		
		      to effectively communicate 		
	    	     our cause?

•	What is Web Design?

•	What makes a Good Web Design?

Portfolio Task 3 – With the knowledge you have learned about web 
design, you should now be able to apply it to make your own effective 
web design. In this lesson’s Build activity, you will find various websites 
that are “Good” and those that are not so good.

Lesson 13: How do we publish our website 	
		       to reach our audience?

•	Web Hosting and Domain Name System

•	Web Page Design Using Templates and Online WYSIWYG Platforms

Portfolio Task 4 – At the end of this lesson, you will prepare a report 
document listing three web hosting platforms of your choice, and provide 
the following: list of Features (each hosting platform), pricing, and pros 
and cons.



LESSON 10 WHICH ONLINE CONTENT 
Target
At the end of this lesson, 
you will be able to

• Differentiate available   
 online content platforms
• Identify which online   
 content platform suits in  
 each need
• Create your own unique  
 WordPress website

  EXPLORE
In	web	 3.0,	 social	 and	 content	 platforms	 took	 the	world	 by	 storm	 and	
Facebook	became	the	most-used	of	them	all	compared	to	other	platforms	
like	MySpace,	Multiply,	Twitter,	Instagram,	and	many	others.	Alongside	
these	social	media	platforms	are	the	popular	blogging	sites,	like	Blogger.	
With	so	many	services,	do	you	have	an	idea	which	of	them	are	the	better	
ones	for	you	to	use?	

In	 this	 activity,	 you	 need	 to	 ask	 your	 classmates’	 opinion	 on	 which	
platform	they	think	is	better	to	use	for	sharing	their	content,	ideas,	and	
stories.	Categorize	 them	between	blogging	 sites	 and	 social	media	 sites.	
Write	their	opinion	on	why	they	prefer	social	media	or	blogs.	Afterwards,	
write	an	essay	on	the	platform	which	is	the	best	for	you	to	use	personally.

PLATFORMS SHOULD I USE?

Social Networking Sites Blogging Sites

Conclusion

Philippine	Copyright	2017151
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  EXAMINE

The	 Internet	 made	 content	 publishing	 possible	 online.	 Many	 content	
platforms	 like	 blogs,	 self-hosted	 websites,	 and	 social	 networking	 sites	
have	emerged	to	answer	individual	consumers’	content	publishing	need.
In	 the	 previous	 modules,	 we	 have	 discussed	 various	 online	 platforms	
that	we	can	use	to	create	content,	images,	and	videos.	In	this	lesson,	we	
will	discuss	 in	detail	web	platforms	where	we	can	 lay	out	our	products	
made	in	the	previous	modules.	

Rich Web Content and Platforms for 
Content Development
Since	 the	 emergence	 of	 Web	 3.0,	 various	 platforms	 for	 web	 content	
creation—from	 blog	 sites,	 to	 social	 media,	 have	 had	 their	 day	 in	 the	
spotlight,	but	they	all	have	their	pros	and	cons	relative	to	your	needs.	Let	
us	now	see	which	tools	will	fit	your	future	content	publishing	needs.

Social Networking Sites
Through	 the	 Internet,	 people	 can	 communicate	 instantly	 with	 anyone	
anywhere	 in	the	world	using	available	tools	 like	social	networking	sites	
or	 SNS.	 The	 evolution	 of	 SNS	 changed	 the	 way	 we	 communicate	 and	
collaborate	with	people.	Here	are	commonly	used	SNS	today:

Look at the website 
screenshot. Do you have 
any idea which tool or 
software the developer 
used to create this 
website?
Cite your guesses below.
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Facebook

Facebook	 is	 a	 popular	 social	 networking	 site	 that	 makes	 it	 easy	 to	
connect	 with	 your	 family	 and	 friends.	 It	 allows	 you	 to	 share	 content,	
news	 articles,	 thoughts,	 photos,	 videos,	 send	 messages	 and	 so	 much	
more.	Facebook	was	originally	designed	by	Mark	Zuckerberg	for	college	
students	in	2004	while	he	was	studying	at	Harvard	University.

Aside	from	a	personal	account,	you	can	also	create	a	Facebook	page	for	
your	 organization,	 school,	 or	 even	 business.	 Once	 your	 friends	 “like”	
this	page,	they	will	get	updates	on	the	things	you	post	in	it,	 just	 like	in	
a	 personal	 Facebook	 account.	 They	 can	 post	 comments,	 react	 on	 your	
post,	and	send	you	private	messages.	There	is	also	an	option	for	business	
owners	to	promote	their	business	via	paid	targeted	advertising	to	reach	
a	bigger	audience.

Twitter

Twitter	 is	 a	 	 social	 networking	 platform	 that	 is	 characterized	 by	 the	
posting	 of	 short	 messages	 up	 to	 140	 characters.	 These	 messages	 are	
called	“tweets”	which	can	be	 read	by	anyone	by	default.	Tweets	can	be	
accompanied	by	images.	

Twitter	is	perhaps	the	most	resilient	in	terms	of	maintaining	itself	as	a	
short-message	content	sharing	service,	although	there	had	been	rumors	
about	 the	 company	 increasing	 the	 number	 of	 characters	 allowed	 in	 a	
tweet,	 it	 still	 has	 remained	 practically	 the	 same,	 which	 distinguishes	
itself	from	its	more	complex	competitors.	

Instagram

Between	 textual	 content	 and	 photographs,	 it	 used	 to	 be	 generally	
accepted	 that	written	 content	were	meant	 to	 be	 shared	more	 than	 the	
latter,	which	was	more	often	only	used	to	support	written	material	and	
shelved	in	storage	sites	with	little	social	features.	A	few	social	platforms	
changed	 that	and	put	 the	 image	at	 the	 forefront,	perhaps	owing	 to	 the	
proliferation	 of	mobile	 cameras.	 Services	 like	Pinterest	 and	 Instagram	
made	the	image	as	integral	as	text	when	it’s	about	content	being	king.	

Instagram	 is	 the	 selfie	 platform	 preferred	 by	 celebrities	 who	 would	
rather	shoot	and	share	photos	of	themselves	instead	of	typing	messages.	
It’s	 fast,	 a	 no-brainer,	 and	 does	 not	 ask	 a	 lot	 of	 your	 time,	 which	 is	
perfect	 for	 people	 who	 want	 to	 show	 themselves	 and	 share	 their	 life	
to	 the	world	without	 the	complicated	stuff.	 It	also	allows	users	 to	 feed	
posts	to	other	social	media	sites	such	as	Facebook,	Twitter,	Tumblr	and	
Flickr.	 According	 to	 Dreamgrow.com	website,	 Instagram	 is	 one	 of	 the	
most	popular	SNS	worldwide.
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Youtube
YouTube	 is	 a	 free	 video	 sharing	 website	 that	 makes	 it	 easy	 to	
share	and	watch	videos	over	 the	Internet.	Users	can	create	 their	
own	channels	for	others	to	follow	and	subscribe	to.	YouTube	has	
evolved	into	a	video	distribution	company	that	offers	a	premium	
service	 with	 no	 ads	 and	mainstream	 shows.	 It	 also	 allows	 live-
streaming,	which	is	a	boon	for	amateur	reporters.	But	in	spite	of	
the	changes,	it	still	remains	as	the	platform	of	choice	for	ordinary	
people	 to	 share	 in	 the	 spotlight	 and	 become	 celebrities	 in	 their	
own	right	by	launching	their	own	shows.	

Video	 is	 now	 considered	 an	 essential	 ingredient	 in	 cementing	 one’s	
presence	online,	which	makes	YouTube	one	of	the	most	popular	websites,	
especially	 for	businesses.	Billions	of	hours	of	 videos	are	watched	every	
month	and	as	more	videos	are	 created	and	uploaded,	 this	will	 only	get	
larger	with	no	end	in	sight.

Blogging Sites vs. Content Management 
Systems
There	 are	 many	 services	 that	 allow	 you	 to	 publish	 your	 content	 on	
the	 Internet	 other	 than	 social	 media	 platforms.	 If	 you	 are	 looking	 for	
services	 that	 give	 you	 a	 level	 of	 customization	 that	may	 enable	 you	 to	
more	 effectively	 reach	 your	 target	 audience,	 then,	 blogging	 sites	 and	
content	management	systems	are	the	ones	you	are	looking	for.	Through	
paid	plans	or	extensive	customization	of	the	service	or	websites,	you	can	
boost	your	presence,	views,	subscribers,	and	even	earnings.	Expectations	
aside,	 there	are	notable	differences	between	blogging	sites	and	content	
management	systems.	

Blogging

Blogging	is	an	activity	that	involves	posting	your	thoughts,	memorabilia,	
or	works	 in	a	kind	of	web	 log	or	online	 library.	 In	 its	 infancy,	blogging	
was	 something	 done	 only	 by	 people	 who	 loved	 to	 write	 and	 who	 had	
regular	access	to	the	Internet.	Today,	it	seems	that	we	have	reached	the	
“blogging	age”	where	almost	everyone	who’s	ever	wished	 for	his	or	her	
own	work	 to	be	published	 can	do	 so	without	 investing	anything	 except	
time	(and	Internet	fees,	of	course).	Blogging	encourages	user-generated	
content	 or	 UGC,	 which	 allows	 anyone	 to	 contribute	 to	 information	
accessible	on	the	Internet.	Blogs	are	ubiquitous,	perhaps	even	more	so,	
than	 news	 sites.	 But	 unlike	 news	 features	 and	 articles,	 blog	 posts	 are	
more	like	editorials	or	opinion-based	articles.
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Uses of Blogging

1.	 Self-Expression

Blogs are like online diaries which can be read by anyone who visits 
them. Blogging is an activity where you can publish content with 
anyone who might be searching for the kind of content you are writing 
about—pictures, your memoir, and other snippets of your life that you 
are willing to share.

2.	 Online Portfolio

Another use of blogging aside from self-expression, is for building your 
own online portfolio to promote your skills and talents or showcase 
your works in the form of articles, reports, and presentations which 
you can link to your other sites, if you have them. Portfolios, which 
can be graphically-oriented, can be useful indicators of your capacity 
to work in fields like photography, graphic illustration, and ad 
campaigns.

According to Scott Belsky of Behance, an online portfolio platform, 
portfolios can be used to highlight your creativity and thought 
processes, how you execute your work, collaborate, and test ideas. 
Blogger.com	

First developed by Pyra Labs, Blogger was eventually bought by 
Google in 2003. Blogger is one of the widely-known blog-publishing 
service or blogging platforms on the Internet. Google has integrated 
proprietary monetization features in Blogger which include AdSense, 
AdWords, and Analytics. But in spite of all the additions, the service 
hasn’t changed that much.

With a simple yet useful interface, Blogger offers beginners an easy 
and comfortable user experience. It is also a free, yet reliable service 
so everyone can publish their own blog if they already have an account 
with Google. 

One downside of it being simple and good for newbies is that it doesn’t 
offer advanced customization sought after by advanced bloggers. 
Also, since this is a blog, it has no features designed specifically for 
selling products and online registrations that are standard in content 
management systems.

Pros
•	 Easy to get started
•	 One-size-fits-all interface
•	 Ready for Google AdSense and Analytics

Cons
•	 Not suited for full-fledged websites
•	 Everything owned by Google
•	 Can’t sell or resell the blog within Blogger
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Blogger is best suited for

•	 Individual	bloggers	(group	permissions	are	optional)
•	 Authors
•	 First	time	online	publishers

WordPress – Content Management System

WordPress	 is	 a	 content	 publishing	 platform	 that	 appeals	 to	 site		
developers	because	of	 its	customizability	and	plug-ins.	 It’s	actually	 two	
platforms:	wordpress.com	(fully	hosted	by	WordPress)	and	WordPress.
org	 (a	 freely	 downloadable	 self-hosted	 version).	 Both	 are	 great	 for	
content,	but	which	of	the	two	do	we	need?

Feature WordPress.org WordPress.com

Admin Responsibility

Self-hosting (may be 
free or paid)

Self-Installation
Write your content

Write your content
Let WordPress handle 

the rest

Core Features and 
Upgrades

Find a host and 
depend on its tools for 

maintenance or
look for plugins that can 

help you

Paid premium hosting 
in WordPress.com gives 
you a variety of premium 
tools and even a custom 

domain name like 
“YourSwagDomain.com”

Themes

Install custom themes, 
modify them, or create 

new ones using PHP and 
CSS

Choose from a selection 
of premade themes 

provided by WordPress

Social Media Integration
Install plugins to share 
content to social media 

apps

Offers social media 
integrations

Functionalities Install plugins to extend 
your site’s functionality

Popular features 
like sharing, stats, 

comments, and polls 
are included. There’s no 
need to install plugins.

Support Has support forums Has support forums

Account No account needed to 
download WordPress

Need to register 
account to use

Other than WordPress, 
there are also other 
content management 
systems that you can 
customize to suit your 
needs like Joomla. 
WordPress however, 
offers a self-hosted 
version called 
WordPress.com

One common idea 
of people is that 
WordPress cannot be 
used for commercial or 
professional purposes. 
We commonly think that 
WordPress is only for 
blogging but actually, 
www.sonymobile.
com and https://www.
mercedes-benz.com/
en/ are both powered by 
WordPress with the help 
of their developers.
How do you think they’ve 
developed such sites? 
What tools and plugins 
do you think they’ve 
used?

EQUIP

INTEGRATE
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As provided in the previous table, you can see that WordPress.org is an 
exciting way to explore the creation of your own WordPress site, albeit, 
one that will require paid hosting, technical knowledge (HTML, PHP), 
and the installation of various plugins that will expand its features. 
WordPress.com, on the other hand, is great for bloggers and other people 
who have no technical knowledge in web development but interested in 
setting up a professional website for themselves, for free.

Setting-up your First WordPress.com Site

For the purposes of learning, you will be setting up a WordPress.com 
site. For starters, what do you want to make? A blog or a website? It all 
depends on your purpose, really. If you just want a blog where you can 
share your articles and writings, just follow the simple steps according to 
WordPress.com.

1.	 Register an account and your blog
2.	Update your title and tagline
3.	 Pick a theme you love
4.	 Add a header or background
5.	 Add a site icon
6.	 Add a widget

If what you want to make is a website, there is also a simple steps to 
create your first one on WordPress.com. 

1.	 Register an account then register a site on wordpress.com

Open wordpress.com and click “Get Started”. The window that follows 
will appear. Here you will be asked which kinds of design you like to 
see. Follow the instructions until you’re done. Choose a theme you 
prefer. Don’t worry, you can still change this in the future, or you can 
choose “Skip” on the bottom.
 
Enter a domain name (the URL or link you want to use for your site). 
The standard is <your unique site name>.wordpress.com. There is 
“wordpress.com” because your site is hosted for free by WordPress. If 
you want to remove wordpress.com, you’ll need pay to upgrade your 
account. If you do not wish to pay the fee, choose the “Free” domain 
name. 
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After this, you will be asked to select a plan. Since we do 
not want to upgrade, click “Select Free”. You are now done 
preparing your first WordPress.com site. You will now need to 
register an account by filling out “Create your account” form.
 
After creating your account, WordPress.com will send you a 
confirmation email. Press Continue.

You are now done prepping your first WordPress site.

2.	 Outline your site’s content

A common mistake most of us do is to focus our initial efforts in 
choosing the themes first before writing the content. Yes, while it is 
important to have a beautiful theme that is very pleasing to the eye, 
it should not drive the content. The theme should complement the 
content because that is what we are publishing for other people to 
consume—the content, not the fancy colors. What is the use of a fancy 
website if no one is even looking at it because it’s useless in terms of 
content?

First, try to identify the purpose of your site. Then, with your goal 
in mind, write a content outline of what you want to show to your 
audience. For instance, you might want to make a blog or site on 
must-try food places in the Philippines. Specifically, you want to write 
about food places you’ve already been, restaurants you haven’t tried, 
food trip guides, and proprietary recipes. 

Food Places in the Philippines

•	 Food Places I’ve Tried
•	 Food Places I want to Try
•	 Food Trip Maps/Guides
•	 Recipes Learned

If you have identified these, you can now proceed to making a sitemap. 
Refer to the following image.
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This will help you design the pages and the flow of how the audience 
will see your content. Organize pages in a neat and simple manner to 
ensure a good user experience. 

3.	 Create pages

Based on the sitemap you’ve drawn, add the pages and insert images, 
videos, and content you already have in your possession. You don’t 
need to get everything in at once. You can fill in the blanks as you 
progress. What’s important for you right now is that you have a main 
page and another for your blog posts. By default, they should already 
be there since they are premade for you by WordPress. Now, proceed 
in making the other pages that you want in your site.

To add a page, click on the “Add” button of Pages under Publish.
 

Fill in the details needed.
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4.	 Configure your site to use a static home page

Open your site and click 
“Customize” in the bottom right 
corner of the screen.
 
This will bring you to a page 
where there is a sidebar on the 
left which you can use to modify 
properties of the page. 
 

Edit the Site Title to show the name you want for your site, then click 
Save and Publish. That will automatically update your website and 
make the changes live. 
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Go back and click on Static Front Page.
 

Depending on the design and 
theme you chose during site 
registration, the settings should 
look like what’s shown in the 
example. We want a “Static page” 
set if you want to make your 
“Welcome” page as the homepage 
while hosting your latest posts on 
a different page. In this theme, we 
chose a layout that has a welcome 
page and a separate blog page. 
Click Save and Publish.

5.	 Pick a theme you love

If your content doesn’t go well with your current theme, you can 
choose a different theme.

 

6.	 Create a menu

You can create your custom menu based on the sitemap you drew 
earlier. To do this, go to My Sites. Click Menus. 
You will find that tthe Primary Menu area for 
your theme will already be selected for you. The 
Default Menu should also be initiated.

To change the name of your Default Menu, click 
on the pencil icon and give it a new name, like 
“Main Menu.” 
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Pages that were already previously published on your site will be listed 
in your initial menu. If you want another menu page to be added, you 
need to create and publish that page first.

Reordering your menu is as easy as moving the items in there with your 
mouse/cursor or by modifying the settings for each item to be relocated:

1.	 Click on the pencil icon next to it.
2.	 In the menu item details, click the Move button.
3.	 Click the Move here link nearest where you want to move the item.
4.	 Select Move Item Above or Move Item Below.

WordPress is considered as a serious platform for serious websites. 
From the creation of personal blogs to e-commerce sites, your skills and 
imagination are the only limits to what you can make for yourself. 
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   CHECK
A.	 Multiple Choice. Match	column	A	with	column	B.	Write	the	letter	of	the	

correct	answer	on	the	space	provided	before	each	number.

1.	 Considered	today’s	leading	video	
sharing	platform

2.	 An	online	website	creation	tool	that	
allows	users	to	create	and	modify	
digital	content

3.	 A	micro-blogging	site	where	one	
can	access	content	shared	using	140	
characters	or	less

4.	 A	platform	that	allows	users	to	
publish	informal	diary-style	text	
entries	to	express	themselves

5.	 The	most	popular	SNS,	which	
provides	a	venue	for	users	to	interact	
and	build	social	networks	with	other	
users	who	share	the	same	interest	or	
life	connections

a.	

b.	

c.	

d.	

e.	

f.	

g.	

B.	 True or False. Write	TRUE	if	the	statement	is	correct	and	FALSE	if	the	
statement	is	incorrect.	Write	your	answer	before	each	number.	

1.	 Through	blogging,	you	can	build	your	own	offl		ine	portfolio	
to	showcase	your	talents,	skills,	and	work.

2.	 WordPress	has	two	platforms:	WordPress.org	and	
WordPress.com.	WordPress.org	is	a	platform	which	is	
fully	hosted	by	WordPress	while	WordPress.com	is	a	free	
downloadable	self-hosted	platform	version.	

3.	 Social	networking	sites	provides	a	venue	for	people	to	
interact	and	build	social	networks	with	other	people	who	
share	the	same	interest	or	life	connections.	

4.	 A	content	management	system	is	a	software	application	
used	to	create,	modify,	and	manage	one’s	website	content	
even	without	touching	the	code.

5.	 Instagram	is	an	online	photo	sharing	network	that	allows	
its	users	to	share	their	life	with	their	friends	through	a	
series	of	pictures.
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C.	 Similarities	and	Diff	erences.	Using	the	graphic	organizer	below,	
compare	and	contrast	these	popular	social	networking	sites.	



Philippine	Copyright	2017165

D.	 Prove It.	Is	using	a	content	management	system	the	best	way	to	develop	
a	site?	Justify	your	answer.	(5	points)
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  BUILD

With	 what	 you’ve	 learned	 in	 this	 lesson,	 create	 your	 own	 WordPress.
com	website.	You	are	free	to	choose	any	topic	you	want	to	share	in	your	
WordPress	site.	You	can	choose	from	the	following	kinds:

a.	 Blog	or	online	diary

b.	 Selling/Promotional	site

c.	 Online	Resume

You	need	to	accomplish	the	following:

1.				Outline	of	Site	Content

2.	 Sitemap

3.	 Finished	WordPress.com	site



LESSON 11 WHAT TOOLS CAN I USE TO 
Target
At the end of this lesson, 
you will be able to

• Discover the importance  
 of collaboration and   
 coordination in project   
 development
• Differentiate various   
 online collaboration tools

  EXPLORE
In	 the	 previous	 lesson,	 you	 learned	 how	 to	 create	 your	 own	 website	
using	WordPress.	 But	 the	 continuous	 development	 of	 the	 content	 and	
functionalities	 of	 	 a	 website	 may	 require	 a	 helping	 hand.	 Handling	
bigger	 sites	also	 require	a	 lot	more	planning,	 and	designing,	 it	 is	more	
efficient	 to	 develop	 and	 maintain	 them	 with	 the	 help	 of	 others	 than	
handling	 everything	 by	 yourself.	 Collaboration	will	 help	 you	 fast-track	
the	development,	and	ease	some	of	the	work	off	your	shoulders.

Some	examples	of	projects	that	require	collaboration	are	theses	writing	
and	case	studies.	Most	of	the	time,	these	kinds	of	projects	have	members	
of	3-5	people.	For	some	projects,	there	may	be	up	to	10	members.	There	
is	 also	 time	 constraint,	 and	 the	distance	between	 the	members’	houses	
makes	meeting	 up	 a	 difficult	 thing	 to	 do.	Given	 the	 circumstances,	 try	
answering	the	questions	below.

Which	tools	do	you	use	to	collaborate	with	your	group	mates?	(Facebook,	
phones,	landline)

Give	a	scenario	in	the	past	in	which	you	extensively	communicated	with	
somebody	using	the	tools	you	mentioned	above.

COLLABORATE ONLINE?
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  EXAMINE

The	 lack	 of	 resources,	 available	 time	 and	 place,	 communication,	
coordination,	and	management	are	common	project	development	issues	
encountered	 by	 most	 students.	 Professionals	 in	 the	 corporate	 world	
share	similar	problems.	From	case	studies	to	big	software	development	
projects,	these	issues	are	imminent	and	threaten	the	output	of	the	work	
that	they	do.	Despite	these	issues,	projects	are	an	inevitable	part	of	your	
curricular	activities	in	school.	They	are	designed	so	you	can	collaborate	
with	 other	 people,	 communicate	 with	 them,	 and	 hence,	 enhance	 your	
interpersonal	 skills,	 which	 is,	 most	 of	 the	 time,	 a	 requirement	 in	 the	
corporate	world.	But	how	do	you	face	the	said	issues?

This	is	where	online	collaboration	software	and	tools	come	in	to	help	you	
with	project	management.	This	 lesson	will	 show	you	the	various	online	
project	management	and	collaboration	tools	divided	according	to	uses.

Tools for Online Collaboration

Communication

There	 are	 many	 ways	 to	 communicate	 through	 the	 Internet,	 and	 new	
tools	 and	 platforms	 are	 always	 being	 released	 in	 the	 market.	 The	
following	 are	 some	 of	 the	most	 common	 tools	 used	 in	 communicating	
updates	with	people.

E-mail 

One	 of	 the	 oldest	 forms	 of	 online	 communication	 and	 the	most	widely	
used	 service	 to	 date,	 e-mail	 can	 help	 you	 create	 a	 message	 to	 your	
recipient	and	send	files	as	an	attachment.	Almost	any	type	of	file	such	as	
text,	graphic,	sound,	video	or	others,	may	be	sent	as	an	attachment	to	an	
e-mail.	E-mails	can	be	sent	to	one	or	more	people	at	the	same	time,	and	
the	conversations	are	usually	threaded	upon	exchange.

You are tasked to be 
the leader of a group 
project with its members 
randomly chosen by 
your teacher. There are 
obstacles.
Your members, because 
they were chosen 
randomly, naturally 
will have differences in 
capabilities, availabilities, 
and character. Look at 
the image on the left 
and try to identify other 
problems that may arise 
in group work activities.
_____________________
_____________________
_____________________
_____________________

Miscommunication often 
lead to various problems 
in project development. 
How can you address this 
kind of issue if you don’t 
have Internet access?

INTEGRATE
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Chat and Instant Messaging 

Instant	 messaging	 (IM)	 is	 a	 faster	 and	 simpler	 alternative	 to	 e-mail.	
Conversations	are	held	in	virtual	“chat	rooms,”	generally	among	family,	
friends,	colleagues,	or	acquaintances.	Public	chat	rooms	also	exist	online.

Voice Chat

You	 can	 make	 free	 or	 inexpensive	 calls	 using	 the	 Internet.	 Some	 IM	
and	chat	services	include	voice	chat	and	several	other	services	may	also	
allow	you	to	call	any	phone	number.	These	services	use	VoIP	(Voice	over	
Internet	Protocol),	which	delivers	voice	communications	and	multimedia	
sessions	via	the	Internet.

Mobile Messaging Apps

WhatsApp,	 Viber,	 and	 WeChat	 are	 the	 three	 best	 applications	 when	
it	 comes	 to	 Internet	 communication.	With	 these	 apps,	 users	 can	 send	
messages	 and	 make	 free	 calls	 anywhere	 in	 the	 world.	 These	 apps	 are	
available	in	iOS	and	Android	platforms.	
	
WhatsApp	 started	 in	 2009	 and	 since	 then,	 it	 has	 become	 the	 most	
popular	 application	 in	 the	 instant	 messaging	 realm.	 This	 application	
is	 free	 for	 the	 first	 year	 and	 costs	 $0.99	 annually	 for	 the	 succeeding	
years.	WhatsApp	 released	 its	PC	version	 in	2016	and	now	 there	 is	 also	
WhatsApp	for	mobile	devices.

Viber is	a	free	instant	messaging	and	calling	application.	In	addition	to	
the	basic	features,	it	also	offers	a	large	collection	of	stickers	to	tickle	up	
text	conversations.	Viber	is	available	on	PC	and	mobile	devices.

WeChat	is	operated	by	Chinese	Internet	giant	Tencent.	This	application	
also	offers	 free	exchange	of	messages,	 free	calls,	and	allows	you	to	 find	
new	 friends.	 Just	 like	 Viber,	 you	 can	 also	 use	 stickers	 to	 make	 your	
conversation	livelier.

Video Chat

Video	 chat	 is	 a	 type	 of	 instant	 messaging	 service	 that	 also	 makes	 use	
of	audio	and	video	 features.	 It	 is	 commonly	used	between	 two	or	more	
people.	 Video	 calls	 held	 by	 more	 than	 two	 people	 are	 called	 video	
conference	calls.	It	is	often	used	in	the	workplace,	collaborative	projects,	
and	webinars	(web	seminars).	Examples	of	video	chat	services	are	Skype	
and	Google	Hangouts.

Coordination Tools

It	is	much	easier	to	organize	a	project	when	every	member	of	the	group	
knows	their	tasks	and	adjusts	the	way	they	handle	the	work	accordingly.	
The	ability	 to	coordinate	with	each	other	 is	an	essential	part	of	project	
management.	 	 The	 following	 tools	 enable	 you	 to	 prepare	 a	 list	 of	
deliverables,	the	schedules,	the	different	milestones,	and	the	assignment	
of	the	tasks	assigned,	which	you	can	then	track	later	on.	Shared	calendars,	
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spreadsheets,	 time	 trackers,	 and	other	 specialized	project	management	
tools	fall	under	this	category.		The	following	are	some	examples:

Bitrix24

Bitrix24	 is	 a	 project	management	 system	 that	 provides	 free	 storage	 of	
up	 to	 5GB.	 Users	 can	 avail	 of	 a	 larger	 storage	 by	 upgrading	 for	 $39/
month.	It	provides	the	option	of	using	either	the	Bitrix24	cloud	server	or	
a	company’s	own	server	to	host	content,	as	well	as	features	such	as	Gantt	
charts,	 layered	 task	 options,	 time	 tracking	 and	management,	workload	
planning,	group	chat,	and	video	conferencing.	
	
MindMeister
	
MindMeister	 is	 a	 collaborative	 web-based	 tool	 that	 enables	 users	 to	
create	mind	maps	 for	 brainstorming	 and	 planning	 activities	 and	 share	
them	 with	 others.	 It	 also	 offers	 a	 number	 of	 other	 features	 such	 as	
templates,	SWOT	analysis,	project	planning,	and	live	group	chat.
	
Google	Apps,	 in	general,	are	a	collection	of	 free	collaborative	tools	that	
you	can	use	almost	on	any	job	or	task	you	have.

Google Calendar

Scheduling	meetings,	appointments,	and	conferences	in	one	place	is	now	
simpler	with	Google	Calendar.	This	scheduling	tool	is	downloadable	for	
both	Android	and	Apple	devices.	Accessing	Google	Calendar	using	your	
Gmail	 account	 is	 also	 possible	 so	 you	 can	 keep	 track	 all	 the	 important	
events	 in	 your	 life,	 manage	 your	 time	 wisely,	 and	 improve	 your	
productivity.

With	Google	Calendar,	you	can	create	events	and	notifications	depending	
on	when	and	how	often	you	need	to	be	reminded	of	them,	and	time	zones	
can	be	adjusted	accordingly.	Google	 can	also	determine	 the	 location	of	
an	event	automatically.	

To	add	an	event,	 just	 select	 the	 range	of	 time	 in	which	you	want	 to	 set	
your	event.	If	you	created	an	event	with	no	specific	time,	Google	Calendar	
will	organize	the	event	in	the	next	possible	window.	To	delete	an	event,	
click	 the	 event	 you	want	 to	 remove	 and	 it	 will	 show	 you	 the	 option	 to	
choose	it.

Sending	 an	 invitation	 for	 a	 specific	 event	 using	 Google	 Calendar	 can	
easily	 determine	 whether	 the	 recipients	 were	 able	 to	 respond	 to	 your	
invitation	or	if	they	can	make	it	or	not.	

To	send	an	invitation,	all	you	have	to	do	is	to	type	their	respective	e-mail	
address	 and	 modify	 your	 event	 details.	 The	 suggested	 time	 displays	
whether	they	are	available	in	your	event	schedule	or	if	they	have	a	prior	
commitment.	 If	 Google	 Calendar	 cannot	 access	 a	 specific	 person	 you	
invited,	you	will	see	an	asterisk	sign	next	to	their	names	letting	you	know	
that	the	person	is	not	included	in	your	suggested	time.

Screenshot of 
MindMeister’s web 

application UI. Version: 
MindMeister 9 (2014), 

Screenshot by Raphaela 
Brandner

To know more about 
Google Calendar, you 
can access the support 
site.

https://support.google.
com/calendar/

EQUIP
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The	 use	 of	 collaboration	 tools	 is	 not	 the	 single	 solution	 to	 all	 project	
development	issues.	There	are	still	many	other	factors	that	can	affect	the	
progress	 of	 your	 project,	 but	 a	 project	 management	 and	 collaboration	
tool	 that	 is	 used	 effectively	 will	 help	 you	 and	 your	 team	 manage	 and	
work	through	your	project.

Online Collaboration Tools
As	 a	 student	 taking	 up	 many	 subjects	 in	 a	 year	 or	 semester,	 you’ll	
probably	 face	 two	 or	more	 projects	 at	 the	 same	 time.	 This	 can	 be	 very	
frustrating	especially	 if	 the	deadline	 is	near	and	your	project	 tasks	and	
members	 are	 disorganized.	 Communication	 through	 Facebook	 or	 texts	
might	not	work	for	you	and	it	doesn’t	help	to	speed	up	the	process.	

It	is	much	easier	to	organize	a	project	wherein	every	member	of	the	group	
knows	their	tasks	and	adjusts	the	way	they	handle	the	work	accordingly.	
The	ability	 to	 coordinate	with	each	other	 is	an	essential	part	of	project	
management.	 You	 need	 tools	 which	 enable	 you	 to	 prepare	 a	 list	 of	
deliverables,	the	schedules,	the	different	milestones	and	the	assignment	
of	the	tasks,	which	you	can	track	later.	But	even	so,	why	bother	using	a	
new	thing	for	managing	your	projects?	

Reasons to Use Online Collaboration

Here	are	some	of	the	good	reasons	for	you	to	use	an	online	collaboration	
tool.

Delivery Speed	 -	 Faster	 to	 deliver	means	 less	 time	 spent,	 less	waiting,	
and	getting	more	projects	done	faster.

Centralized Virtual Working Space -	Since	you	can	add	up	multiple	users	
in	 an	 online	 collaboration	 software,	 those	 users	 can	work	 on	 the	 same	
task	and	idea	and	will	lessen	miscommunications.	They	will	be	regularly	
updated	on	the	progress	of	the	development.

Bigger Review System -	More	members	engaged	in	online	collaboration	
means	 bigger	 access	 to	 reviewing	 the	 work.	 Instead	 of	 sending	 a	 copy	
of	your	work	via	e-mail,	you	can	upload	your	content	to	the	online	tool,	
or	provide	a	link	so	that	multiple	users	can	access	it	and	give	you	useful	
insights.

Trello and Kanban 
Trello,	pronounced	as	Trell-o,	is	a	relatively	easy-to-use	software	that	is	
perfect	 for	the	Kanban	board	methodology	of	project	management.	The	
Kanban	 board	 is	 a	 variation	 of	 the	 traditional	 Japanese	Kanban	 cards.	
This	board	utilizes	sticky	notes,	plastic	chips,	magnets,	etc.	to	represent	
work	 items	 in	 a	 production	 process,	 and	 how	 each	 item	 moves	 along	

Kanban is a Japanese 
word that means 
“signboard.” Toyota 
applied Kanban 
methodology which 
boosted their production 
in the 1950s.
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the	process.	With	 these	materials	as	 representation	of	work	 items,	 this	
method	 is	highly	 visual	 and	 focuses	more	on	 the	 stages	of	 process	 and	
the	quality	of	execution	rather		than	deadlines	only.	
	
A	basic	Kanban	board	is	composed	of	3	elements:

Board	–	a	board	represents	the	whole	project.	

Lists	–	a	board	is	divided	into	lists	which	represent	the	stages	of	project	
development	i.e.,	waiting,	doing,	and	done.

Cards –	lists	are	composed	of	cards	where	your	team	tasks	are	written.	
This	may	be	written	on	sticky	notes	or	sign	boards.

Basically,	 the	Kanban	process	requires	moving	a	card	(or	a	single	 task)	
from	left	to	right	on	the	board,	starting	a	task	from	the	To Do	list,	until	
it	reaches	the Done	list.

With	 this,	 you	 can	 have	 a	 visual	 way	 of	monitoring	 which	 is	 pending,	
what	 is	 currently	 being	 worked	 on,	 and	 which	 tasks	 are	 done.	 This	 is	
especially	useful	for	offices	where	a	physical	board	or	wall	can	be	used	as		
a	Kanban	board.

Now	where	does	Trello	come	in?	Trello	is	a	free	online	project	management	
tool	 that	 is	perfectly	 suitable	 in	applying	Kanban	methodology	because	
it	applies	the	three	basic	elements	of	Kanban,	namely:	board,	 lists,	and	
cards.	

Trello	offers	you	the	following:

•	 Kanban-compatible	components
•	 Highly	visual	graphical	user	interface
•	 It’s	free	to	use
•	 Allows	you	to	attach	fi	les	up	total	of	250MB
•	 You	can	attach	external	links	for	attachments
•	 Allows	you	to	add	many	team	members
•	 It	also	has	a	mobile	app	you	can	use	to	access	the	boards		 	

anywhere,	anytime.

To learn more about 
the advantages of using 
the Kanban method of 
project monitoring, visit 
this page:

https://zapier.com/learn/
project-management/
kanban-board/

EQUIP
Board List Card
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In	Trello,	you	can	create	different	boards	for	different	projects	that	you	
have,	or	customize	boards	to	fit	with	different	sets	of	activities	that	your	
group	needs	to	do.	Within	its	boards,	you	can	create	lists	like	a	Kanban	
board.	Within	those	lists,	you	can	create	cards	with	the	specific	details	for	
a	 task,	 like	 team	members	 assigned,	 checklists,	 deadline,	 attachments,	
and	many	more.	You	can	start	with	a	free	account	in	trello.com.

Creating your First Trello Board

After	creating	your	Trello	account	(or	signing	it	with	your	e-mail),	
click	Create new board,	 or	 if	 you	 already	 opened	 the	Welcome 
Board,	click	on	Boards,	then	click	Create new board.

Step 1. Choose a name for you board based on the activity 
you will manage. In	 our	 case,	 enter	 your	 project	 title	 in	 the
Create Board	 dialog,	 which	 in	 this	 case,	 it’s	 “Research	 Project	
2017.”	

You	may	also	specify	a	certain	team	that	will	work	on	the	project.	
Doing	 this	will	 add	 all	 the	members	 of	 that	 team	 to	 this	 board,	
who	 therefore	will	 be	 able	 to	 see	 all	 the	 contents	 of	 the	 board.	
You	may	 create	 your	 own	 team	 by	 adding	 email	 addresses.	 For	
now,	leave	it	empty.	

Step 2. Write your workflow with lists.	Like	we	mentioned	earlier,	
lists	 represent	 stages	 of	 the	 development	 of	 the	 product.	 Include	 the	
basics:	 To	 Do,	 Doing,	 and	 Done.	 It	 is	 helpful	 to	 add	 a	 beginner’s	
documentation	 list	 in	 the	 first	part	where	all	 cards	with	 resources	 that	
will	help	a	beginner	 in	your	Trello	board	are	present.	You	can	also	add	
more	lists	based	on	your	needs.	

Basically,	 Beginner’s Guide is	 for	 newbies	 on	 your	 board.	 To Do
contains	the	tasks	that	are	yet	to	be	done.	Doing	is	for	tasks	you	and/or	
your	team	are	currently	doing. Done	is	for	finished	tasks.

Step 3. Add cards (tasks) to your lists.	 In	 Kanban,	 one card 
represents one task.	 You	 should	 also	 do	 the	 same	 in	 Trello	 to	
implement	Kanban	methodology	 in	 your	project	management.	You	 can	
add	cards	by	either	clicking Add a card,	or	by	clicking	the	Option button	
and	then	clicking	Add Card…
	
Enter	a	task	name	for	each	card.	Click	on	the	card	to	enter	more	details	
for	the	task	e.g.,	description,	deadline,	assigned	members,	attachments,	
etc.

You	 can	 also	 add	 checklists	 or	 your	 members	 can	 add	 Checklists	 in	 a	
card	for	you	to	be	able	to	review	if	a	task	is	nearing	completion.
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It	is	advisable	that	you	provide	all	the	necessary	details.

After	writing	a	description,	you	now	need	to	assign	people	to	work	on	it.	
How	would	a	process	go	without	people	driving	it?	If	you	can	recall,	we	
haven’t	added	any	teams	nor	members	since	Step	1.	To	add	members	to	
your	 board,	 close	 the	Card	 dialog	 box	 and	 click	 on	Add Members…	 on	
the	Menu	in	the	right-hand	corner	of	the	screen.	Here	you	can	enter	the	
email	addresses	of	the	people	who	are	to	be	involved	in	your	project.

You can also create a 
Team when you click 
the plus sign. Just click 
Create Personal Team
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After	 adding	 other	 information	 like	 deadlines,	 attachments,	 checklists,	
and	labels,	your	card	should	look	like	this.	

	
Step 4. Move cards across the lists 
until each task is done.	 Remember	 that	
lists	 are	 stages	 of	 development	 and	 this	
means	all	tasks	that	are	written	in	the	To Do 
list	should	progress	until	they	are	done.	You	
can	 move	 a	 card	 by	 clicking	 and	 dragging	
your	chosen	card.	

Step 5. Add Stickers on Cards or customize your Background. 
Stickers	can	serve	as	decoration	on	each	card,	but	most	can	be	used	 to	
reward	accomplishments.	To	do	 this,	 click	Stickers	on	 the	menu	 in	 the	
right-hand	corner	of	the	screen.	Choose	a	sticker	and	drag	it	to	the	card.

You can use Labels 
(Color labels) as a 
representation of task 
categories. Task is a 
Writing and Editing work, 
and is also an immediate 
task. WITH is a writing 
and editing task that is 
immediate.

One great thing about 
Trello is that you can 
write comments on 
cards even on card 
attachments

Click on Subscribe if you 
want to get notifi cation 
e-mails when something 
on this card is changed. 
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These	 are	 free	 stickers.	 If	 you	want	 to	 use	 better-looking	 stickers,	 you	
can	buy	a	business	class	Trello	license.

Step 6. Subscribe to the Board. A	 team	 lead	 would	 like	 to	 know	
everything	that	happens	in	the	development	of	the	project.	He	needs	to	
be	updated	on	 the	 changes	 that	happen	because	 every	detail	 can	affect	
the	 outcome	 of	 the	 project.	 He	 should	 be	 able	 to	 make	 necessary	
adjustments	when	needed.	To	subscribe	to	the	board,	click	on			
then	 choose	 .

You	now	have	the	necessary	knowledge	to	apply	the	Kanban	method	in	
your	 project	management.	Make	 sure	 to	 have	 your	members	 subscribe	
to	 each	 card	 they	 are	 assigned	 to	 so	 they	 will	 have	 updates	 on	 task	
movements.

the	 outcome	 of	 the	 project.	 He	 should	 be	 able	 to	 make	 necessary	
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   CHECK
A.	 Spot Which Is Not Like the Others.	In	each	of	these	groups,	cross	out	

the	item	that	is	not	like	the	others.	On	the	right	side	of	each	group,	state	
what	makes	it	diff	erent	from	the	others.
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B.	 Compare and Contrast. With the use of the graphic organizer below, 
state the similarities and differences of the following sets.

a.	 e-Mail and Instant Messaging

b.	 Video Chat and Voice Chat

INSTANT MESSAGING

VOICE CHAT

EMAIL

VIDEO CHAT

jlnepomuceno
Cross-Out

jlnepomuceno
Inserted Text
Email
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C.	 FILL THE BOX OF QUESTIONS.  Read and answer the following 
questions inside the box.

WHAT ARE COLLABORATION TOOLS?

WHY USE COLLABORATION TOOLS?

WHERE SHOULD I USE COLLABORATION TOOLS?

WHEN SHOULD I USE COLLABORATION TOOLS?

HOW CAN COLLABORATION TOOLS HELP ME IN DEVELOPING MY 
PROJECT?

HOW CAN COLLABORATION TOOLS EMPOWER ME TO TRANSFORM 
MY LEARNING?
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  BUILD

Trello Kanban Board

In	 this	Build,	you	will	create	your	own	Kanban	board	and	migrate	 it	 to	
Trello.	To	do	this,	you	need	the	following	materials.

•	 ¼	illustration	board
•	 colorful	sticky	notes
•	 marker
•	 reusable	adhesives	(Tack	It)

Using	 these	 materials,	 make	 your	 own	 Kanban	 board.	 You	 may	 use	
your	 existing	project’s	 tasks	 for	 the	 cards	 and	 the	 lists.	After	doing	 so,	
translate	 this	Kanban	board	 to	Trello.	Add	your	group	members	 to	 the	
Trello	 board,	 and	 assign	 each	 one	 to	 a	 task	 to	 handle.	 If	 there	 are	 no	
existing	tasks	and	members,	you	may	add	filler	content.



LESSON 12 HOW DO WE USE WEB DESIGN TO 
Target
At the end of this lesson, 
you will be able to

• Discover the importance  
 of effective web design
• Identify the things that   
 make a good web design
• Evaluate existing website  
 designs

  EXPLORE
In	the	previous	 lesson,	you	identified	various	content	platforms	readily	
made	 available	 to	 you.	 Content	 management	 systems	 like	 WordPress	
gives	 you	 the	 ability	 to	 publish	 your	 content	 online	without	 the	 hassle	
of	creating	your	own	template	and	design,	with	 the	help	of	 its	 libraries	
of	 thousands	 of	 templates.	But	what	 if	 you	 could	not	 find	 the	 one	 that	
suits	 your	 needs?	What	 if	 you	wanted	 something	 unique,	 original,	 and	
branded	 for	 you?	 In	 this	 lesson,	 you	 will	 discover	 the	 importance	 of	
web	design	and	the	principles	that	will	guide	you	in	creating	a	“perfect”	
design	that	will	make	your	website	appealing	and	useful	to	your	viewers.

What	is	the	difference	between	Design	and	Art?

According	to	you:

According	to	your	friend:

According	to	the	Web:

EFFECTIVELY COMMUNICATE OUR 
CAUSE?
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  EXAMINE

You	have	probably	seen	many	websites	that	showcase	some	of	the	most	
stunning	 webpage	 designs,	 but	 the	 Web	 Pages	 That	 Suck.com	 owner	
gives	you	a	 list	of	websites	that	are	below	the	standard	look	and	feel	of	
webpages.	 But	 how	 can	 we	 distinguish	 good	 and	 bad	 web	 design?	 To	
discover	how,	let’s	start	by	learning	what	web	design	is.

What is Web Design? 
Web design is	 a	 process	 of	 planning,	 creating,	 and	 maintaining	
websites.	 Designing	 an	 effective	 website	 requires	 more	 than	 just	
gathering	 relevant	 information	 and	 sharing	 it	 on	 the	 web.	 Quality	
website	projects	need	more	attention	to	the	selection,	organization,	and	
presentation	of	material.	In	every	aspect	of	the	site	design,	your	website	
must	be	both	clear	and	engaging.	Knowing	the	elements	and	principles	
of	web	design	will	help	you	in	making	your	very	own	website.

What Makes a Good Web Design?
Web	designers	do	not	only	focus	on	how	the	website	looks	and	feels	but	
also	 about	 how	 it	 works	 and	 responds.	 They	 incorporate	 not	 just	 the	
elements	of	a	website	but	they	also	make	it	functional,	highly	responsive,	
quick,	and	useful.	

Conversion rate is the 
number of users who 
stayed at your site who 
completed your website 
goal (purchase a product, 
subscribe to your 
newsletter, follow your 
posts)

EQUIP
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Determine Your Audience

Simply	 put,	 you	 need	 to	 identify	 who	 your	 audience	 is	 and	 how	 they	
behave	before	engaging	in	the	development	of	the	website.	Keep	in	mind	
that	different	users	have	different	needs	and	expectations.	For	instance,	
two	 people	 looking	 at	 the	 latest	 smartphone	 reviews	 might	 expect	
different	sets	of	information.	

A	businessman	who	constantly	travels	and	calls	clients	will	place	greater	
importance	 in	 attributes	 like	battery	 life,	 screen	 size,	 and	durability.	A	
student	 studying	 in	 a	 prime	 school	 and	 active	 on	 social	media,	 on	 the	
other	 hand,	 will	 focus	 on	 storage	 capacity,	 camera	 quality,	 and	 other	
extravagant	features.	

Highlighting	wrong	information	to	the	wrong	audience	will	not	yield	your	
desired	outcome.	That	is	why	you	need	to	tailor	your	website	content	to	
the	group	of	users	you	care	about	the	most.	Identify	their	behavior	and	
design	a	user	experience	that	will	get	them	hooked	on	your	website	and	
add	up	to	your	conversion	rate.	You	will	want	to	determine	the	attributes	
of	 the	 audience	 you	 are	 trying	 to	 target,	 their	 goals	 for	 accessing	 your	
website,	 the	 values	 that	 they	 possess,	 and	 the	 concerns	 they	 have	 that	
may	convince	them	to	stop	visiting	your	website.	The	sum	total	of	these	
four	aspects	of	behavior	 is	 called	a	persona.	Persona	sketches	help	you	
define	 who	 and	 what	 kind	 of	 user	 you	 care	 about	 the	 most.	 Take	 the	
following	 as	 an	 example.	 You	 have	 a	 blog	where	 you	 offer	 smartphone	
reviews.	You	have	this	one	user	named	Irene.

Battery Life
Voice Quality
Keyboard

Camera Quality
Brand
Storage Capacity

Attributes
Values
Goals
Concerns

Battery Life
Voice Quality
Keyboard

Camera Quality
Brand
Storage Capacity

Attributes
Values
Goals
Concerns

Battery Life
Voice Quality
Keyboard

Camera Quality
Brand
Storage Capacity

Attributes
Values
Goals
Concerns

Conversion rate is the 
number of users who 
stayed at your site who 
completed your website 
goal (purchase a product, 
subscribe to your 
newsletter, follow your 
posts)

Note	to	artist:	be	consistent	with	the	style	of	the	previous	
sketches.
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Once	you	have	identified	Irene’s	attributes,	values,	goals,	and	concerns,	
you	will	need	to	produce	content	that	targets	these.	As	you	move	through	
the	design	process,	always	refer	to	the	persona	you	have	envisioned.	Ask	
yourself	this	question,	“Does	my	persona,	Irene,	feel	like	the	website	was	
made	specifically	for	her?”	If	the	answer	yes,	then	you	are	more	likely	to	
create	 a	website	 that	 is	 enjoyable	 and	 relevant	 to	 your	 target	 audience	
precisely	because	you	focused	on	their	needs.

You	must	also	 take	a	user-centric	approach	to	your	design.	This	means	
that	your	website	must	be	both	usable	and	useful.	It	must	be	structured	
and	organized	in	a	way	that	is	simple	to	understand	and	self-explanatory.	
Navigation	 plays	 an	 important	 role	 in	 the	 website.	 It	 must	 exhibit	
consistency	 and	 uniformity	 all	 throughout	 your	 web	 design	 because	 it	
enhances	the	overall	user	experience.

Information is Key

People	 who	 access	 the	 Web	 are	 often	 in	 search	 of	 information.	 This	
means	 that	 when	most	 people	 come	 to	 your	 website,	 they	 have	 a	 goal	
in	mind.	They	 either	 reached	your	website	 from	a	 search	engine,	 or	by	
following	 a	 link	 from	 another	 website	 instead	 of	 knowing	 your	 actual	
URL.	There	 are	 typically	more	 visitors	 that	 have	 been	 referred	 to	 your	
website	by	search	engines	because	most	people	“google”	answers	to	their	
problems.	

Make	it	a	point	to	help	the	people	who	come	to	your	site	quickly	find	what	
they	need.	But	keep	in	mind	that	if	people	come	to	your	site	from	search	
engines	and	links,	they	will	probably	end	up	on	a	page	on	your	site	that	
is	 not	 the	 home	page.	 The	 first	 page	 they	 see	 on	 your	 generally	 allows	
visitors	to	gauge	whether	they	are	getting	closer	to	the	information	they	
are	looking	for.	It	is	important	to	make	the	nature	of	your	website	clear	
to	your	visitors,	as	well	as	the	manner	by	which	information	is	arranged	
in	it.	You	can	do	this	by	having	a	clear	and	concise	website	tagline,	and	
make	sure	your	navigation	is	descriptive.	Each	page	of	your	site	should	
also	have	a	descriptive	page	heading	with	relevant	pictures	and	summary	
text	(where	applicable).
Also,	 remember	 that	 good	 credible	 information	 served	 by	 your	 site,	
received	 well	 by	 your	 visitor	 is	 a	 satisfied	 user.	 You	 give	 your	 visitor	
quality	information,	and	he	gives	you	his	trust,	and	probably	referral.	

What to Avoid When Designing a Website

There	 are	 pointers	 above	 on	 how	 to	 provide	 your	 visitors	 with	 their	
needs,	but	 there	are	also	 things	 that	web	designers	do	 that	make	users	

The word “google” 
offi cially became a verb 
when it was added to 
Oxford dictionary in 
2006. An example of 
its usage would be the 
following:
“Jean googled the 
defi nition of conversion.”

Bounce rate is the 
number of visitors who 
immediately leave a 
website without reaching 
the website goals. 
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leave	a	website	quickly,	adding	to	its	bounce	rate.	One	good	example	is	
hiding	the	information	they	are	looking	for.	But	how	does	that	happen?	

The	following	are	some	examples.

1.	 Using technical product names

Using	 product	 models	 as	 product	
names,	 especially	 in	 navigation	 links,		
prevents	users	from	finding	what	they	
are	 looking	 for.	 The	 additional	 effort	
of	clicking	each	link	to	find	what	they	
need	tires	visitors	

2.	Using clickbait in your link texts

Do	 you	 use	 Facebook	 often?	 Or	
browse	the	Internet	often?	If	yes,	then	
you	should	have	seen	so	many	ads	on	
different	 websites.	 They	 commonly	
have	the	following	titles:

“Buying a Smartphone? Let us Guide You 
Which to Buy.”

“Watch This “Video” Before Philippines 
Billionaires Destroy It.”
Such	 non-descriptive	 titles	 are	 known	 as	 clickbait.	 This	 advertising	
method	is	ineffective	when	you	are	creating	a	page	or	post	tagline	or	link	
text.	 Search	 engines	 scan	 the	 content	 of	 your	Web	 pages	 and	 use	 that	
information	 to	 check	 if	 your	 content	matches	 with	 what	 the	Web	 user	
is	 looking	 for.	 A	 non-descriptive,	 teasing	 headline	 casts	 doubt	 on	 the	
credibility	 of	 you	 page	 and	 is	 thus	 beneficial	 for	 neither	 you	 nor	 your	
potential	visitors.

Instead,	 use	 a	 clear	 and	 concise	 description	 and	 help	 your	 visitor	
understand	what	they	can	expect	to	see	on	your	page.	

3.	 Using jargon

Using	jargon	as	headers	does	not	help	your	visitor	know	immediately	
what	they	are	looking	at.

For	 example,	 Josh,	 an	 11-year-old	 child,	 got	 bitten	 by	 an	 insect	 at	
home.	His	mom	was	not	 home	 at	 the	 time,	 but	 the	 bite	was	 already	
so	 itchy,	 and	 he	 couldn’t	 resist	 it	 anymore.	 So	 he	 tried	 to	 google	 a	
remedy.

Would	 you	 present	 Josh	 with	 the	 scientific	 names	 of	 all	 the	 insects	
that	might	have	bitten	him?	 Instead,	what	he	wants	 to	 see	 and	 read	
are	familiar	words	that	can	help	him	deal	with	his	bug	bite.

HOME PAGE   ABOUT US  PRODUCTS  CONTACT US

XY200z Series

XY300  Series

XY400i Series
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4.	 Showing blocks of text

As	mentioned	earlier,	web	users	or	visitors	want	information	
as	quickly	as	possible.	They	do	not	have	time	to	read	a	wall	
of	text,	nor	scan	it.	

Instead,	cut	your	text	into	meaningful	portions	and	provide	
a	descriptive	subtitle	 for	each	part.	With	this	you	can	help	
visitors	tell	if	they	are	on	track	on	the	information	they	are	
looking	for.

5.	 Showing too much advertisements

Advertising	 on	 websites	 enables	 web	 designers	 and	
developers	 earn	 revenue	 depending	 on	 the	 number	 of	 clicks	 or	 hits	
a	website	 receives.	 This	 is	 one	 of	 the	 goals	 of	 a	web	 designer.	More	
advertisements	on	a	page	equal	more	revenue.	But	also,	a	web	designer	
wants	their	users	to	stay	long	enough	to	create	the	ad	impressions	he	
needs.	

It	is	not	uncommon	to	see	advertisements	
on	Web	pages,	and	while	there	is	nothing	
wrong	 with	 that	 in	 principle,	 too	 many	
advertisements	 can	 prevent	 a	 visitor	
from	 getting	 the	 ideal	 web	 experience.	
Therefore,	 scattered	advertisements	end	
up	hiding	the	information	your	visitor	is	
looking	for.	

Instead	 of	 placing	 too	 many	
advertisements,	just	choose	certain	parts	
of	 your	website	 that	will	 not	 distract	 or	
overwhelm	your	visitors.	

Conclusion

Effective	web	design	aids	the	visitor	in	their	search	for	information	and	
simplifies	 the	process	 for	 them.	 It	 also	makes	 the	 content	 of	 a	website	
easier	to	digest	and	increases	the	likelihood	of	them	depending	on	your	
site	 for	 information.	A	good	web	page	generates	 interest	 in	 its	visitors.	
Always	 consider	 the	 needs	 of	 your	 potential	 visitors	 when	 designing	 a	
web	page.

To learn more on how to 
effectively place ads on 
your websites, visit this 
website

https://support.google.
com/adsense/

and refer to Optimization 
Tips.

EQUIP
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   CHECK

A.	 Enumeration.	Fill	out	the	chart	by	listing	fi	ve	things	that	need	to	be	
considered	to	have	a	good	and	eff	ective	web	design.

	
	

	
	

WEB DESIGN
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B.	 Dos and Don’ts. On the table below, list down dos and don’ts you 
should keep in mind in web designing.

WEB DESIGNING

DO DON’T

1.

2.

3.

4.

5. 

6.

7.

8.

9.

10.



Philippine Copyright 2017189

C.	 Talk About It. Discuss the quote below. (4 points)

“Design is not just what it looks like and feels like. Design is how it works.”
-Steve Jobs  
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   BUILD

Look	for	some	websites	that	you	think	are	good	and	some	that	you	think	
are	 not	 good.	 List	 them	 on	 a	 separate	 sheet	 of	 paper	 and	 write	 your	
comment	 about	 those	 websites.	 Write	 your	 opinion	 on	 each	 site	 you	
have	found	on	your	own	blog	site.	Include	a	screenshot	for	each	site	you	
reviewed.	Look	for	at	least	five	websites.	Follow	the	template	below.

Website	Name:	

Screenshot:

Comments	and	Review:



LESSON 13 HOW DO WE PUBLISH OUR 
Target
At the end of this lesson, 
you will be able to

• Discover what Web   
 Hosting is
• Identify differences   
 between types of web   
 hosting
• Discover what DNS   
 means

  EXPLORE
In	 the	previous	 lessons,	 you	have	discovered	multiple	 platforms	where	
you	can	publish	your	content	online.	You	can	either	use	blogs	or	content	
management	 systems	 like	 Blogger	 and	 WordPress	 and	 they	 will	 host	
your	content	on	their	own.	But	did	you	know	that	you	can	also	self-host	a	
site	by	choosing	hosting	services	like	GoDaddy.com?	In	this	lesson,	you	
will	learn	concepts	and	examples	of	web	hosting	services	for	self-hosting	
and	freely	available	“already-hosted”	platforms.	But	before	we	proceed,	
take	the	time	to	accomplish	the	activity	that	follows.

Think	of	a	house.	Together	with	your	groupmates,	answer	the	following	
questions:

Why	people	 take	a	 lot	of	 their	 time	planning	where	 their	house	 should	
stand?

Does	the	address	of	the	house	matter?

Why	 do	 people	 invest	 so	 much	 time	 in	 planning	 and	 designing	 their	
house?

take	the	time	to	accomplish	the	activity	that	follows.

WEBSITE TO REACH OUR 
AUDIENCE?
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  EXAMINE

You	won’t	be	self-hosting	your	website	in	this	course,	but	it	 is	essential	
to	have	prior	knowledge	of	web	hosting	and	the	domain	name	system	if	
you	decide	to	self-host	in	the	future.

Web Hosting and Domain Name System
Web hosting	is	a	service	that	authorizes	individuals	and	organizations	
to	 make	 their	 website	 available	 on	 the	 Internet.	 A	 web	 host,	 or	 web	
hosting	 service	 provider,	 is	 any	 person	 or	 company	 that	 delivers	 the	
services	and	technologies	that	are	essential	to	the	website	or	web	page	to	
be	viewed	

If	 people	 want	 to	 view	 your	 website,	 all	 they	 have	 to	 do	 is	 type	 your	
website’s	address	 into	their	browser.	Their	computer	will	automatically	
connect	 to	your	server	and	your	web	pages	will	be	 transported	 to	 them	
and	made	available	through	their	browser.

Types of Web Hosting 

1.	 Shared Website Hosting. It	is	the	easiest	and	common	type	of	web	
hosting.	This	type	of	service	shares	multiple	websites	on	the	same	web	
server.	Shared	website	hosting	is	aff	ordable	than	the	other	hosting	
services	because	the	expense	to	run	the	server	is	shared	between	you	
and	your	co-owners.	The	main	problem	of	shared	hosting	is	security	and	
performance.	Sharing	a	server	with	high-traffi		c	website	could	slow	down	
or	stop	your	server.

2.	 Dedicated Website Hosting.	Allows	you	to	have	full	control	of	your	
website.	This	type	of	service	is	more	expensive	than	shared	website	
hosting	because	you	can	customize	your	hardware	and	software	
specifi	cations	to	meet	your	needs.	You	must	be	knowledgeable	and	
responsible	to	confi	gure	and	maintain	your	own	server.	With	a	dedicated	
server,	you	can	expect	a	high	performance	from	your	website.	

3.	 Virtual Private Server Website Hosting.	Servers	that	are	more	cost	
eff	ective	than	dedicated	website	hosting.	VPS	works	seperately	without	
aff	ecting	the	other	VPS	hosting	of	other	websites	on	the	same	system.	It	
also	allows	you	to	manage	your	server	partition,	delete	or	add	fi	les,	and	
install	or	uninstall	programs	if	you	want.

4.	 Colocation Hosting.	This	type	of	service	is	the	most	expensive	and	
identical	to	dedicated	website	hosting	since	you	have	to	purchase	or	rent	
your	own	server.	You	are	also	accountable	to	all	server	issues	and	its	
maintenance,	unless	your	client	provides	you	with	technical	support	to	
inspect	and	confi	gure	it	on	your	own.

Choosing a web hosting 
service is like choosing 
a land for your new 
home. Careful analysis 
of perks of certain land 
is important especially 
because you will use it 
for a long time, probably 
a lifetime.  

INTEGRATE
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Domain Name System

Domain Name System. This	 is	 an	 Internet	 service	 that	 interprets	
domain	names	 into	 IP	 addresses	 for	 a	 specific	 top-level	 domain	 (TLD)	
such	as	 .net	or	 .com.	DNS	helps	you	find	and	directs	computer	systems	
and	 resources	 on	 the	 Internet.	 For	 instance,	 when	 you	 type	 a	 specific	
web	 address,	 or	 URL,	 the	 given	 DNS	 will	 correspond	 to	 that	 specific	
name	and	the	IP	address	for	that	 location,	and	will	connect	you	to	that	
site.	If	the	server	does	not	recognize	the	answer,	the	server	will	reach	out	
to	 the	DNS	 server	 for	 the	 top-level-domain	 –e.g.,	 for	 all	 .com	 or	 .edu.	
The	request	will	be	delivered	to	the	server	for	a	particular	domain	until	
the	correct	IP	address	is	returned.

First Generation DNS

The	 Advanced	 Research	 Projects	 Agency	 Network	 also	 known	 as	
ARPANET,	the	Internet’s	grandfather,	was	launched	in	1969.	ARPANET	
was	 developed	 to	 connect	 research	 centers	 across	 the	United	 States	 to	
share	 information	 faster.	 The	 efficient	 way	 to	 secure	 continuity	 was	
when	numerous	 servers	answered	numerous	queries	 concurrently.	One	
server	 was	 called	 master,	 and	 the	 rest	 were	 slave	 servers.	 Each	 slave	
must	 follow	 instructions	 to	 keep	 the	 master	 updated	 and	 determine	
changes	in	data	regularly.

Second Generation DNS   

NOTIFY	 was	 the	 game	 changer	 of	 the	 second-generation	 DNS.	 The	
master	would	send	a	notification	to	the	slaves	to	prompt	them	to	obtain	
fresh	data	until,	Incremental	Zone	Transfer	(IXFR)	made	a	change	in	the	
way	data	was	communicated.	If	a	single	record	out	of	many	had	changed,	
the	 original	 specs	 would	 normally	 send	 countless	 messages	 but	 IXFR	
enables	only	the	changes	to	be	sent.																																																																				

Third Generation DNS

If	the	first	generation	allows	the	administrator	to	change	just	one	record	
before	the	slaves	to	update,	the	turning	point	of	the	third	generation	came	
when	dynamic	updates	were	defined	 in	RFC	2136.	Dynamic	updates	 let	
the	administrator	to	edit	the	file	across	the	network	without	logging	into	
the	master.	It	may	be	a	small	success,	but	the	effect	was	quite	impressive	
in	 the	 long	 run.	Updates	 reused	 the	 original	message	 format	 for	 other	
purposes.	Likewise,	additional	efforts	to	describe	extensions	were	added	
that	modernized	 the	entire	system.	 	Structural	 integrity	of	 the	protocol	
enhanced	 after	 the	 code	 was	 added	 and	 this	 directed	 to	 DNS	 security	
which	was	the	next	focus	for	modification	in	the	near	future.

The following are web 
hosting companies that 
are prevalent today.

1.  000Webhost
2.  Freehostia
3.  5GBfree
4.  FreeHosting.com
5.  Zymic

EQUIP
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Web Page Design Using Templates and 
Online WYSIWYG Platforms
Creating your own website requires time and effort to make it appealing. 
Before the WYSIWYG was introduced, every designer used code to build 
websites efficiently. Formatting of the content and design was through 
manual coding, until the first document preparation program was 
launched in 1974. Bravo, as it was called, was WYSIWIG and was written 
by Charles Simonyi and Butler Lampson for the Alto program.

The Best Website Builders

Wix

Wix.com was developed by the Israeli company also called Wix and 
it is one of the most innovative website builders today. The adding of 
new and enhanced designs and tools is one of the best things WiX offers. 
These website builders are made for everyone since it is very easy to use. 
You can easily make your own website by just dragging and dropping 
content, no coding needed. It also provides effective tools to make a 
website more comprehensive.

Weebly

Weebly is a web-hosting service founded in 2006 by David Rusenko, 
Chris Fanini and Dan Veltri. Weebly is easy to use just like WiX. The 
functionalities and features have similarities but they are updated 
independently. Weebly allows you to access HTML/CSS to customize 
your website such as change templates conveniently without having to 
change your content.  

WordPress

WordPress is a popular open-source content management system 
(CMS) written in PHP. It is considered the easiest CMS because of its 
user-friendly interface and flexibility. The reliability of this website 
builder has been proven by many users. WordPress is more than 
just a blogging tool, it can also be used on non-blog websites such as 
e-commerce websites. Customizing your own website is allowed as long 
as you are well-oriented in coding. The flexibility and scalability of this 
platform is the main reason why it has grown in popularity.

Squarespace

Squarespace was launched in 2004 by Anthony Casalena. It allows you 
to control and monitor your website through its interface. Working in 
Squarespace is very impressive since the featured tools are easy to use. 
Seeing your website while it is being created gives you instant feedback 
for a professional-looking website.

WYSIWYG - what you see 
is what you get
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    CHECK
A.	 True	or	False.	Write	TRUE	if	the	statement	is	correct	and	FALSE	if	the	

statement	is	incorrect.	Write	your	answer	before	each	number.	(8	points)	

1.	 Web	hosting	is	a	service	that	allows	an	individual	to	
publish	a	web	page	on	the	Internet.

2.	 The	uploaded	websites	are	hosted,	or	stored,	on	an	
assigned	computer	called	servers.

3.	 Internet	users	cannot	view	your	website	by	just	typing	its	
URL.

4.	 Dedicated	website	hosting	is	a	more	expensive	type	of	
service	that	allows	users	to	have	full	control	of	their	
website.

5.	 Colocation	hosting	is	the	common	type	of	web	hosting	that	
shares	multiple	websites.

6.	 The	domain	name	identifi	es	IP	addresses.

7.	 Squarespace	is	a	website	builder	was	launched	2004	by	
Anthony	Casalena.

8.	 The	third	generation	DNS	requires	the	administrator	to	
manually	change	just	one	record	before	the	slaves	can	
update	all	of	their	records.
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B.	 Enumeration. List down three of the best website builders available 
today and write a concise explanation about each platform. (6 points)
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C.	 Similarities and Differences. With the use of the graphic organizer 
below, compare the generations of Domain. (6 points)
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    BUILD

It	is	important	task	for	a	web	designer	to	evaluate	different	web	hosting	
platforms	that	may	be	used	and	what	can	be	offered	to	clients.	Different	
hosting	 platforms	 offer	 a	 great	 number	 of	 tools	 for	 databases	 and	 file	
management,	 but	 these	may	 differ	 between	hosting	 companies	 and	 for	
each	plan	they	offer.	

Assuming	 you	 are	 the	web	 designer	 for	 a	 big	 client,	 like	 Samsung,	 for	
example,	prepare	a	report	document	listing	three	web	hosting	platforms	
of	your	choice,	and	provide	the	following:

1.	 List	of	Features	(each	hosting	platform)
2.	 Pricing
3.	 Pros	and	Cons

Provide	references	for	each	information	you	get	from	the	Internet.



MODULE 4
How do we implement what we have 
developed?

Learning Outcomes
•	 Publish	a	content	through	a	website.

•	 Recognize	the	importance	of	improving	one’s	online	and	web	presence.

•	 Present	a	project	to	a	dynamic	audience.	

Portfolio Output
Team Portfolio Website –	 At	 the	 end	 of	 this	 module,	 you	 have	 to	
upload	 the	 infographics,	posters,	and	video	on	your	preferred	platform	
(WiX/Wordpress.com).	 Use	 templates	 and	 designs	 which	 will	 fit	 the	
project	 you	 have	 decided	 to	 take	 on.	With	 this	 website,	 you	 can	 show	
the	 world	 what	 you	 have	 learned,	 and	 what	 you	 have	 created	 in	 this	
Empowerment	Technologies	course.

Your	website	should	have	the	following	pages:

•	 A	Home	page	where	you	can	catch	the	attention	of	the	web	visitor	and	
briefl	y	introduce	what	the	website	is	all	about.	

•	 A	Portfolio	page	where	you	can	showcase	all	your	Build	outputs	since	
Module	1.	Provide	descriptions	and	explanation	for	each	output.

•	 An	About Us	page	where	you	can	introduce	who	the	developers	are	and	
what	their	contributions	to	your	projects	since	Module	1.

•	 A Contact Us	page.

Use	all	the	knowledge	that	you	have	acquired	since	the	beginning	of	this	
course	 to	 be	 able	 to	 present	 your	 portfolio	website	 effectively.	Keep	 in	
mind	that	you	should	consider	all	the	guidelines	in	creating	an	effective	
and	 successful	 homepage.	 You	 may	 use	 different	 multimedia	 hosting	
sites,	like	YouTube	and	Vimeo,	to	embed	your	photos	and	videos

Philippine	Copyright	2017199
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Criteria Excellent
5 PTS

Very Good
3 PTS

Needs Practice
1 PT

Content of the website

The website is complete 
(has a Home page, Portfolio, 
About Us, and Contact Us 
section) and the content on 
every section is satisfactory.

The website lacks two 
sections and the content on 
some sections is good.

The website lacks three 
sections and the content is 
somehow complicated to 
understand.

Creativity and Design

Good layout is shown and 
all the graphics and designs 
complement with each 
other.

Good layout is shown but 
some graphics and designs 
do not complement with 
each other.

Layout needs to be 
improved and graphics and 
designs do not complement 
with each other.

Application of 
knowledge

All the knowledge in 
building an effective website 
is applied.

Some knowledge in building 
an effective website is 
applied.

No knowledge in building an 
effective website was shown.

Promptness
Finish the activity on or 
before the submission date.

Finish the activity 1 day after 
the submission date.

Finish the activity 2-3 days 
after the submission date.

Group Participation
All the group members 
participated to complete the 
activity.

2-3 members of the group 
did not participated to do 
the activity.

More than 3 members of the 
group did not participated 
to do the activity.
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Lesson 14: How do we publish our work over the Internet?
•	What Is WiX?

•	 Step by Step Process of WiX

•	 Some Tips for Making a Web Page

•	How to Publish Your Website

Portfolio Task 1 – With a team, create a website using WiX following the given procedures and 
once done, enter the complete Uniform Resource Locator (URL) of your project into a browser 
and show the class your completed and published website.

Lesson 15: How do we create online and web  presence?
•	Do You Have an Online or Internet (Web) Presence?

•	 Your Web of Influence

•	 Love the Traffic

Portfolio Task 2 –After having created a website for yourself in Wix, you can now move to add 
ways to improve your Web and Online presence through that site. In this Build activity, you will a 
number of things to improve your online and web presence.

Lesson 16: How do we present our project outcome to 			
		       a panel? 

•	 Carrying & Delivering the Presentation

•	 Presenting the wix.com Domain and Its Social Issue

•	Giving Feedback on a Project and Its Impact

Portfolio Task 3 – As a group, prepare two presentations for the same content. One will not use 
a presentation tool and the other will be delivered using the presentation software of the group’s 
choice. You can determine the manner of delivery of the details of your documentation for each 
of the presentations.
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LESSON 14 HOW DO WE PUBLISH OUR WORK 
Target
At the end of this lesson, 
you will be able to

• Differentiate available   
 online content platforms
• Identify which online   
 content platform suits in  
 each need
• Create your own unique  
 WordPress website

  EXPLORE
Remember	a	time	when	you	had	a	hobby,	such	as	cooking	or	biking,	and	
you	 wanted	 to	 share	 what	 you	 knew	 with	 other	 people?	 You	 probably	
shared	a	photograph	or	two	over	social	media,	Facebook	in	particular.	It	
probably	resulted	in	plenty	of	likes,	but	these	were	likely	limited	only	to	
people	 you	 already	 knew,	 such	 as	 your	 friends,	 followers,	 and	 family—
people	who	would	actually	want	to	check	out	what	you	post.	You	might	
have	 wanted	 to	 reach	 more	 people	 (including	 those	 not	 connected	 to	
you)	 from	anywhere	 in	 the	world	 so	you	might	have	 thought, I need to 
do more than post and really publish over the Internet.	From	a	content	
developer’s	point	of	view,	this	makes	a	lot	of	sense	because	it	would	make	
it	 much	 easier	 for	 people	 to	 find	 you	 online,	 and	 gives	 you	 a	 credible	
identity	outside	of	social	media.	

Your	Internet	reach	can	generally	be	a	 lot	greater	 if	you	do	not	publish	
solely	on	any	single	social	media	account,	which	means	that,	if	you	want	
to	get	the	attention	of	a	lot	of	people	all	over	the	world,	there	would	have	
to	be	diversity	in	your	publishing.	

Apart	from	your	preferred	social	media	platform	and	a	website,	can	you	
think	of	other	ways	or	platforms	where	you	can	publish	online?

PUBLISHING
PLATFORM

CONTENT YOU CAN 
PUBLISH YOUR AUDIENCE

OVER THE INTERNET?

Philippine	Copyright	2017203
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 EXAMINE

Web Creation Made Easy.	Those	are	the	words	in	the	About	page	of	WiX.	
The	slogan	is	followed	by	“Create	your	own	website	for	free—exactly	the	
way	you	want.”	

You	can	read	those	same	words	in	the	WiX	site	and	if	you	will	go	there,	
you	 can	 check	 out	 the	 details	 on	 how	 the	 service	 can	 deliver	 on	 its	
promise	of	making	it	free	and	easy	for	you	to	successfully	make	your	own	
website.	You	can	examine	what	it	offers	and	make	a	list	of	the	ways	it’s	
able	to	provide	such	a	service	and	make	it	appealing	to	users.	How	does	
WiX	 compare	 with	 other	 services	 you’ve	 used	 before	 to	 post	 content?	
What’s	the	difference	between	WiX	and	Facebook?	

What Is WiX?
Based	 on	 how	 the	 site	 describes	 itself,	 the	 purpose	 of	 WiX	 and	 who	
should	use	it	become	obvious.	It	aims	to	help	you	easily	build	a	website	

and	design	it	the	way	you	want	it	to	be.	
The	key	word	here	is	“easily.”

If	 you	 are	 not	 that	 familiar	 with	 the	
HTML	 code	 and	 website	 production	
processes,	 or	 only	 have	 a	 passing	
interest	 in	 these,	 you	 will	 need	 a	 tool	
to	 help	 you	 to	 create	 a	 website	 where	
you	 can	 publish	 your	 content.	 WiX	 is	
one	of	those	tools	or	platforms	that	can	
also	 serve	 as	 a	 host	 to	 your	 website,	
which	means	it	will	give	“space”	for	you	
and	 the	 means	 to	 publish	 in	 order	 to	
promote	 your	 business,	 showcase	 your	
art,	 set	 up	 an	 online	 shop,	 or	 just	 test	
out	new	ideas.

Based on the text 
displayed, what do you 
think WiX is all about??

By what ways do you 
think this can help you 
publish content online?

You can learn more 
about WiX here: 

http://www.wix.com/

Websites are created for 
a variety of reasons. Here 
are some of them:

• Personal content
• Commerce or business
• Feature your profi le
• News and reviews
• Blogging

If you were to use WiX, 
what would you use it 
for?

INTEGRATE

WiX Templates
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If	 you	 were	 to	 choose	 between	 the	 paid	 website-creation	 services	 and	
WiX,	 which	 is	 free,	 which	 would	 you	 naturally	 be	 attracted	 to?	 If	 you	
don’t	have	tons	of	money	to	burn,	the	answer	would	naturally	be	WiX.	
	
But	of	course,	as	with	all	 free	services,	you	will	need	to	do	the	creation	
yourself	 in	WiX.	The	nice	 thing	about	WiX	 is	 that	web	creation	 is	 easy	
because	of	the	following	features:	

•	 Drag	and	Drop	Interface
•	 Artifi	cial	Design	Intelligence
•	 Designer-made	Templates
•	 Image	Library	
•	 24/7	Support	

Step by Step Process of WiX
WiX	is	basically	a	drag	and	drop	editor,	which	means	that	you	can	select	
the	 options	 offered	 to	 you	with	 your	mouse	 and	 keyboard,	 rather	 than	
actually	 typing	out	 a	 lot	 of	HTML	code.	WiX	offers	 lots	 of	 ready-made	
templates	to	make	a	website	look	great,	and	fully	setting	up	your	website	
using	WiX	shouldn’t	take	more	than	a	few	sessions.

1.	 To	get	started,	click	on	the	Start	Now	button.
	

You	may	 then	be	asked	 to	be	a	member,	which	means	you	will	need	 to	
log	into	the	WiX	website.

WiX official website

Log-on page for first time users of wix.com

WiX templates are just 
like smartphone cases 
which you choose to 
refl ect your individuality. 
For a website, it’s more a 
refl ection of the content 
that you have to offer. 
If you were to choose 
a template, what kind 
would you pick?

INTEGRATE

To get more information 
on how to choose the 
proper templates for 
your website using WiX, 
you may visit:

https://www.wix.com/
support/html5/getting-
started/templates

EQUIP
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You will then be asked about the topic 
you have in mind for the website. 
Here are some of the topics available 
in WiX.

2.	 Once you have logged in and 
selected the type of website you want, 
several templates with categories will be 
presented for you to choose from. Select 
the template that is most applicable to 
you. In this case, for your project. 

If you plan to create an online shop, WiX can easily assist in that regard. 
It will give suggestions on how to manage your store and how to achieve 
a great degree of customer satisfaction.

Suggested topics for your website

Some first-time trial template designs of WiX Actual template designs from WiX

Screenshots of online-store-creation in WiX
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3.	 Once you have chosen a category and template, click on the Edit button. 
This will open several drag-and-drop selections, which are based on the 
WYSIWYG or what you see is what you get (WYSIWIG) concept. You can 
then drag-and-drop elements that you want placed in specific areas of 
your page.

4.	 Text can be also added using the text boxes provided.

Screenshots of online-store-creation in WiX

Food photography theme

A finished website with text and images arranged properly on the page.
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5.	 Add navigation buttons and links as needed. These are used to take the 
viewer from one web page to another. As much as possible, minimize the 
number of navigation links in a page so as not to confuse or overwhelm 
your visitors.

As an added option, use anchor links, which are text with hyperlinks 
attached so that, if they are clicked on, another web page or another 
website will be called up. Note that special links can redirect to another 
section of the same page. The “Back to top” anchor link, for example, will 
enable viewers to easily go back to the top of a very long page.

Some Tips for Making a Web Page
Granted, there is no perfect formula to make a website that is sure to be 
repeatedly visited by visitors. These tips are suggested to make the best 
of the website you will create.

1.	 Make sure your website pages load quickly even at regular Internet 
connection speeds. You can do so by minimizing the number of images 
you have on your page, as images take longer to download than text 
does. A viewer might get annoyed with the long download time and go 
to another website before even seeing what you have to offer. (If you’ve 
searched the Internet before, you’re likely to have done the same thing.)

2.	 Pages should not be too long. After all, you’re not making printed pages 
of a book. Consider that the viewer’s time is precious, so not including 
unnecessary information is certainly helpful. Give the viewers the content 
that they want quickly while making sure that nothing important is left 
out.

3.	 Clickable buttons or links are usually placed on the right side of the page 
to make it easy for the user to click, since most viewers look from left to 
right and most are arguably right-handed, and thus, use their mouse with 
that hand.  

4.	 It is preferable to use thumbnails of images on main pages to shorten the 
time during which a page is downloaded. Full-sized images usually have 
big file sizes which slow down the page-loading time and add to viewer 
boredom. 

5.	 Make sure that your color scheme is suitable for your site. A good color 
scheme reduces eyestrain, which is why muted color schemes, rather than 
bright and neon ones, are preferable. Also, make sure that the dominant 
color is complementary with your product or topic. Using a sickly a green 
and blood-red color scheme to sell cookies, for example, might not be 
appropriate unless you’re selling blood-themed cookies for Halloween.
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How to Publish Your Website

1.	 Make sure you preview all pages in their order of presentation.

2.	 Test your site’s navigation buttons to make sure these go to the pages that 
they’re supposed to connect to.

3.	 Check all your links to make sure these work the way they’re supposed to 
(i.e., clicking on the links brings you to where you want to go).

4.	 Proofread your page, then check the layout, color, images, and other 
elements on it. Once you are satisfied, preview your page on a browser.

5.	 To find your site, enter your domain name into your browser. 

WiXBlog email feature
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CHECK
A.	 True or False.	Write	TRUE	if	the	statement	is	correct	and	FALSE	if	the	

statement	is	incorrect.	Write	your	answer	before	each	number.

1.	 WiX	allows	you	to	create	your	own	website	exactly	the	way	
you	want	it.

2.	 WiX	is	a	platform	that	can	also	serve	as	a	host	to	another	
website	or	to	your	personal	website.

3.	 WiX	requires	a	paid	subscription	to	avail	the	website-
creation	service.

4.	 The	Wix	platform	off	ers	ready-made	templates	to	make	
your	website	look	great.	

5.	 Registration	to	a	member’s	account	is	not	necessary	to	use	
WiX.

B.	 Identifi	cation.	Identify	the	features	of	WiX	that	are	described	in	each	
statement.

1.	 It	is	a	common	action	performed	within	a	graphical	
user	interface	that	allows	you	to	move	the	mouse	
cursor	over	a	selected	object.

2.	 There	is	a	variety	of	creative	templates	to	choose	
from.

3.	 It	is	where	we	can	ask	questions	or	browse	articles,	
and	fi	nd	answers	about	the	platform.

4.	 If	designing	your	page	is	getting	harder,	you	can	
simply	review	the	variety	of	categories	of	pictures	that	
are	free	to	use	from	WiX.

5.	 It	is	an	advanced	technology	that	combines	ideas	in	
creating	an	exceptional	and	personalized	website	
design	instantly.
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C.	 Tips For Making A Web Page. Identify and explain a tip that you can 
give in making a web page according to the given situation.

1.	 Anna was annoyed with the long download time of the web page that she 
just opened, and so, she ended up browsing another page without seeing 
the features of the other one.	
________________________________________________	
________________________________________________	
________________________________________________	
________________________________________________	

2.	 Mark tends to multitask to utilize his limited working time. So, reviewing 
a long web page that has unnecessary information is certainly not helping 
him in finishing on time.	
________________________________________________	
________________________________________________	
________________________________________________	
________________________________________________	

3.	 The average viewers of a Google web page read from left to right and most 
people are arguably right-handed.	
________________________________________________	
________________________________________________	
________________________________________________	
________________________________________________	

4.	 Maximizing the time of your web pages’ views is Andy’s goal as a blogger. 
Page-loading that takes too much time only adds boredom to its visitors.	
________________________________________________	
________________________________________________	
________________________________________________	
________________________________________________	

5.	 5.	The viewers enjoy and appreciate a web page that reduces eyestrain.	
________________________________________________	
________________________________________________	
________________________________________________	
________________________________________________	
________________________________________________ 
________________________________________________
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 BUILD

With	a	team,	create	a	website	using	WiX	following	the	given	procedures	
and	 once	 done,	 enter	 the	 complete	 Uniform	 Resource	 Locator	 (URL)	
of	 your	 project	 into	 a	 browser	 and	 show	 the	 class	 your	 completed	 and	
published	website.



LESSON 15 HOW DO WE CREATE ONLINE AND 
Target
At the end of this lesson, 
you will be able to

• Know the meaning of   
 presence (online, Internet  
 or Web)
• Become conscious of   
 Internet exposure
• Increase or decrease   
 infl uence online
• Monitor and gather web  
 traffi c data using tools

  EXPLORE
Do	you	remember	when	you	were	first	introduced	to	the	Internet—being	
actually	 introduced	 in	 a	 way	 that	 you	 can	 be	 seen	 by	 people	 who	 are	
online?	For	most	of	you	“digital	natives”	who	grew	up	with	computers,	
it	 likely	 involved	either	YouTube	or	Facebook	and	kiddie	videos	of	 you	
made	 public	 and	 shared	 over	 your	 parents’	 accounts.	 Then,	 of	 course	
there’s	 the	 enthusiastic	 elder	 brother	 or	 sister	 who	 graciously	 created	
an	 account	 for	 you	 to	 post	 your	 pictures	 in	 even	 though	 you	 were	 too	
young	 to	 have	 an	 account	 on	 social	media.	 In	 this	 age	 of	 the	 Internet,	
that’s	how	kids	grow	up	and	it	means	that,	even	as	babies,	people	already	
have	 a	 presence	 through	 computers.	 Do	 you	 remember	when	 you	 first	
had	your	own	Facebook	account?	Remember	how	you	felt	when	friends,	
relatives,	 and	 even	 total	 strangers	 “liked”	 something	 you	 posted?	How	
did	your	social	media	presence	affect	your	life?	

List	all	the	sites	and	social	platforms	where	you	can	be	found	in	the	table	
below.	Write	 down	what	 you	post	 in	 each	 of	 them.	Which	 ones	do	 you	
use	to	socialize—reach	out	to	people	and	vice-versa?	

WEBSITE WHAT YOU POST USED TO SOCIALIZE

WEB PRESENCE?

Philippine	Copyright	2017213
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EXAMINE

At	 one	 time	 or	 another,	 you	 might	 have	 followed	 one	 or	 two—maybe	
even	three	or	more	of	your	 favorite	celebrities	over	your	 favorite	social	
media	 platform.	 It’s	 fairly	 common	 practice	 on	 Facebook,	 Twitter	 and	
Instagram,	just	to	name	a	popular	few	sites.	Pictured	here	is	the	Twitter	
page	of	actress	Emma	Watson,	 star	of	 the	 live-action	adaptation	of	 the	
classic	Disney	animation	movie,	Beauty and the Beast.

Who	do	you	 follow	online	and	what	 site	does	 this	person	use?	Did	you	
willfully	search	for	this	person?	Step	outside	of	yourself	a	bit	and	look	at	
yourself	from	a	different	perspective.	Why	do	you	think	it	was	so	easy	for	
you	to	follow	this	person	over	the	Internet?	Does	this	person	attract	tons	
of	 followers	and	 likes?	If	you	compare	 this	person	with	you,	which	one	
do	you	think	has	better	presence?	

Do You Have an Online or Internet (Web) 
Presence?
Presence	 is	 the	 unavoidable	 consequence	 of	 living	 in	 this	 increasingly	
connected	world	of	computing	devices.	Over	the	Internet,	you	can	either	
have	Online	or	Internet	(Web)	presence.	

Based on the images and 
text on this site, what do 
you think draws people 
to it?

How does this Twitter 
page help add to the 
presence of the person 
who owns it?
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Internet or Web Presence

If	you	can	be	found	over	the	Internet	in	at	least	one	
location,	such	as	a	web	page,	you	have	what	is	called	
Internet	 a.k.a.	Web	 presence.	 A	 high	 web	 presence	
means	you	can	be	found	in	many	areas	of	the	Internet	
(website,	 blog,	 ads,	 email,	 publicly-accessible	 files,	
etc.).	 Some	 people,	 mostly	 celebrities,	 business	
people,	 and	 political	 figures,	 have	 a	 huge	 web	
presence.	 Apart	 from	 the	 presence	 they’ve	 created	
for	 themselves,	 they	 also	 benefit	 from	 the	 presence	
created	by	other	people	and	establishments	that	are	
related	to	the	person’s	profession.	

Online Presence 

If	you	are	on	the	Internet	and	are	reachable	by	people	
who	 need	 to	 get	 in	 touch	 with	 you,	 then	 you	 have	
online	 presence.	 In	 other	 words,	 you	 are	 virtually	
present	 online	 with	 the	 means	 to	 communicate	 or	
interact	 with	 others	 over	 the	 Internet.	 If	 you	 can	
answer,	 yes,	 to	 the	 question,	 “Are	 you	 online?”	 or	
“Will	you	be	online?”	then	you	definitely	have	online	
presence.	

Online	presence	requires	the	use	of	communication	
and	 interactive	 tools	 in	 the	 form	 of	 programs	 and	
services	 like	 E-mail,	 Skype,	 Google	 Hangouts,	
Facebook	 Messenger,	 Disqus,	 Reddit,	 etc.	 and	
hardware	 like	 a	 webcam	 and	 microphone.	 	 These	

tools	 can	 allow	 an	 individual	 to	 be	 online	 and	 active	 instead	 of	 having	
just	an	offline	and	passive	Internet	or	Web	presence.	

Exposure Online

One	 way	 or	 another,	 and	 knowingly,	 or	 unknowingly,	 most	 people	 in	
this	 day	 and	 age	 will	 have	 either	 an	 Internet	 or	 an	 Online	 presence.	
Either	way,	people	usually	end	up	having	exposure,	which,	in	this	age	of	
computers	and	connectivity,	means	just	about	anyone	with	a	computing	
device	 has	 the	 capacity	 to	 see	 information	 about	 you	 in	 the	 form	 of	
content	that’s	readily	accessible	with	the	use	of	technology	and	these	are	
text,	 images,	video.	The	ever-popular	social	platform,	Facebook,	makes	
the	most	 of	 all	 three	 content	 types.	Your	 friends	 and	 family	 contribute	
to	your	having	exposure	every	time	they	post	a	message,	an	image,	or	a	
video	about	you	or	with	you	in	it.	

Positive or Negative

Whether	exposure	is	good	or	bad	for	someone	all	depends	on	the	content.	
If,	 for	 example,	 your	 image	 somehow	 “photobombs”	 a	 picture	 taken	
by	 a	 photojournalist	 of	 someone	maltreating	 a	 pet	 dog,	 you	might	 get	

US President Donald 
Trump had a negative 
reputation which gave 
the opposition reason 
to believe he would 
lose the election, but he 
didn’t. How do you think 
Trump’s online exposure 
helped him be elected 
president?

INTEGRATE
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negative exposure in a manner that connects you with 
something that you have no involvement in. If, on the 
other hand, your name is mentioned in an online news 
article as one of the individuals involved in a fund-
raising program for the benefit of homeless people in 
Manila, then, this would create the kind of exposure 
that’s positive. 

Now, it might be impossible to vet every instance of 
your name or image being exposed one way or another 
through the actions of other people, and produce 
negative results, but, however, you can be in control 
of what you post to get more positive exposure. The 
following are a number of ways that supports this goal.

•	 Think before you post 
•	 Observe the law 
•	 Be nice 
•	 Respect copyright rules 
•	 Share and connect 

Your Web of Influence
Having considerable Internet or Online presence serves to boost your 
influence over other people who follow your activities and your posts. 
The more positive is your exposure, the more credibility you collect for 
yourself and your name can potentially become synonymous with the 
kind of content that you post.   In other words, you become your own 
brand that followers can attest to being “legit” or original. 

Having even an ounce of influence online means that people believe 
in you, even if these people are only within your circle of friends or 
are members of your family. But, as they say, everything has to start 
somewhere small before it fans out fare and wide. A kernel of influence 
can become the seed that can grow into your own personal web of 
influence online that would be like a tree with branches that reach out to 
all corners of the Internet. 

Food, 
Drink, and 

Activity 
Choices

Hunger
Money Media

Time

TraditionsHealth

Seasons
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Fast and Furious (Or Not)

A good way to see how fast your influence is growing online is to see 
the number of likes and shares for a post you made and the number of 
people who get added to your list of social followers on a daily basis. The 
now famous Swedish YouTuber, Felix Arvid Ulf Kjellberg, better known 
as PewDiePie, became a worldwide sensation by just posting original 
videos. In just two years from when he joined YouTube, he already had 
over two million subscribers. With so many people under his influence, 
companies started making advertising deals with him. Would you want 
to be like PweDiePie? 

Celebrity-level popularity might not be your cup of tea, but the fact is, 
you can only be as influential as your level of activity on the Internet. 
What, where, and how you post also come into play to affect your degree 
of influence. But with effort and knowhow, you can give it a boost, which 
is often necessary when you’re doing business online, or take it down a 
few notches, which is often necessary when your privacy or reputation is 
at risk. 

Take it Up

It takes effort when you climb a mountain. The same is true for when 
you’ve set your sights on upping your level of influence on the Internet. 
In order to gain influence online, you have to be more present in such a 
way that you regularly post content which may be picked up and shared 
by people. If you want to do more, you can make yourself available for 
online chats and organize informal group meetings where you invite 
people of similar interests as you. If you have a business, you can turn 
this into a regular Q&A where you answer customers’ questions about 
your product or service. As a consequence, you become a subject 
authority and the go-t0 person in your line of business. 

Take it Down

If you’re hungry under a fruit tree and you’re too lazy to climb to get to 
the fruit, the fruit will most definitely not drop for you unless it becomes 
too ripe to remain on its branch, and by that time, you’d likely be dead 
of dehydration or hunger. Inaction can most definitely be the death of 
something, and where Web or Online presence is concerned, it’s your 
influence that’s at risk if you don’t act. Simply put, if you stop posting 
stuff online and cease engagement with the people in your circle, you 
will lose influence. With minimal or no activity over the Internet, you’d 
be like dead online and no one follows a dead person. So, if you want to 
lose influence, just stop posting and socializing online. Your followers 
and likes will also drop. When they are down to your desired levels, you 
can resume normal online and web activities. 

Love the Traffic
Traffic is something that doesn’t really give you a reason to smile, but 
really, if it’s web traffic, the more of it that you have, the better would be 
the life of your site or page.
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Web traffic makes up a large part of Internet traffic, which is essentially 
data coming and going over the Internet. Web traffic is specific to the 
quantity of data sent and received by visitors of a website. Thus, if 
someone visits your website, data or information is transferred. The 
visitor gets your content and your website gets data from the visitor 
such location (IP address) and application data. Such information are 
captured in logs or cookies and are not visible. But such information can 
be put to good use by analytical software which translate them into data 
graphical and other data metrics. 

Search Rank

Search rank is the number produced by a code which determines the rank 
of a website in a search query result. If, for example, you type in the word 
“AuthorStory” in Google Search, it will come up with a list of sites with 
placements determined by the Google PageRank algorithm. The search 
result that’s on top (below any paid placements) has the top search rank 
and has an advantage over all the other search results since it will likely 
be clicked on first. PageRank is Google’s first search algorithm which is 
used to ascertain the significance of websites. What it does to establish 
this basically, is to check for links that come in from other websites. The 
more sites that connect to a website, the higher its PageRank. Google has 
since limited access to PageRank data, telling people that they shouldn’t 
focus too much on it. Nevertheless, it still helps a website to rank higher 
in search results if more websites link to it. 

You can check the popularity of a website by going to website statistics 
and analytics services online, such as alexa.com, which is a paid service 
that ranks websites on its own. But the easiest way to see how your 
website ranks in search results is to look for it yourself in a search engine 
like Google. You can also try using the other popular search engines 
available—Bing, Yahoo! 

Analytics & Stats Galore

Beyond knowing how your website 
ranks in search results, you can 
see the kind of people who visit 
you, what devices they use, and 
what part of the world they come 
from. All these are analytics 
data. The practical definition of 
analytics is the use of analyzed 
existing or simulated future data 
to develop realistic decisions for 
future actions. Web Analytics 
enables you to get an idea of such 
things as the kind of people who 
visit your website.

https://commons.wikimedia.org/wiki/File:Basic_Steps_of_Web_
Analytics_Process.png
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Google Analytics 

This	 is	 a	Google	Analytics	 overview	of	 visitor	 statistics	 of	 a	 blog	 about	
the	Philippines.

Google	Analytics	 is	one	of	the	most	popular	analytics	tools	available.	It	
is	designed	to	be	used	by	experts	and	non-experts	alike	and	has	several	
features	 which	 allow	 you,	 the	 website	 owner,	 to	 track	 the	 number	 of	
visits	and	how	long	people	stay,	among	other	data.	Basically,	Google	will	
give	you	a	code	to	embed	in	your	site	so	tracking	can	be	done.	

Flurry Analytics 

Yahoo’s	 Flurry	 Analytics	 is	 another	 popular	 and	 versatile	 analytics	
tool	especially	 for	apps	that	can	be	used	by	beginners	and	expert	alike.	
Similar	 to	Google	Analytics,	 it	 has	 several	 features	 for	 apps	which	 can	
highlight	specific	 information	that	a	website	owner	would	 like	 to	check	
out	so	he	or	she	knows	the	details	about	visitor	traffic	details.	
If	 you	want	 to	do	your	own	study	of	 your	website	 visitors,	 you	 can	ask	
them	questions	yourself.	Feedback	forms	and	surveys	are	tools	that	you	
can	use	to	get	the	viewpoint	of	visitors	so	you	can	plan	on	how	to	target	
them.
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Alexa Analytics 

Alexa Analytics, owned by Amazon, is another versatile web analytics 
tool which is often compared with Google Analytics. It’s a paid service 
which provides premium data. It’s an especially useful tool for keyword 
research outside of Google Insights and Google Trends.  
If you don’t want to hassle yourself with these analytics tools and simply 
want to know the keywords people are searching for in areas relating 
to your website content, then just try typing in the search field of a 
search engine like Google and you will see that, as you type, it gives 
you suggestions by default. These are actually search terms previously 
inputted by people. It’s a simple way to get basic keywords data. Knowing 
about how people search for websites relating to yours will help you to 
configure your content to reflect popular keywords and phrases, so as to 
make your site more visible when those key terms are typed into search 
browsers. In other words, it will help to boost your Internet presence. 

Analytics Data That Matter

There are plenty of data that can be made available when it comes to 
Internet Analytics, but the following might be the most important for 
you in relation to improving your Web and Online presence. 

Visits – this is the count of the times a specific visitor loads a page of 
your site. If this is high, then that visitor has a specific interest in what 
your site has to offer. 
Pageviews – the number of times a website has been loaded in a 
browser in a particular time period. If this number is high but the time 
on page is low, then something is wrong with your site. It means people 
think they will find what they are looking for in your site but not finding 
it once your main page loads. 

Bounce Rate – this tracks the number of terminated visits after at least 
one page loads. 

Time on Page (ToP) – how long a visitor stays on one page on a site 
before moving on to another page of the same site. 

View/Visit Ratio (VVR) – simply the number of pageviews divided by 
the number of visits to a website. This gives the average time of a visit in 
terms of content consumption. 
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   CHECK
A.	 Defi	ne	Web	Presence.	.	Write	the	defi	nition	of	web	presence	according	

to	its	three	distinct	aspects	of	being	online.	Also,	explain	each	based	on	
your	own	web	presence	and	experience.		

WEB 
PRESENCE

INTERNET 
PRESENCE

ONLINE 
PRESENCE

EXPOSURE 
ONLINE

Rubric:

Technical Defi nition-
Personal Use (Explanation)-
TOTAL

3 points
6 points
9 points
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B.	 Identification. Identify the web presence terminologies described by 
each statement. (11 points)

1.	 It is being present and reachable by people that connect 
or interact virtually with others.

2.	 It is one of the most common goals in having online 
presence.

3.	 It is like a tree with branches that reach out to all 
corners of the Internet.

4.	 It is the number produced by a code which determines 
the rank of a website.

5.	 It enables you to get an idea of such the kind of people 
who visit your website. 

6.	 It is the most popular analytics tools used by experts 
and non-experts to track the number of visits and how 
long people stayed on the website.

7.	 It is another popular and versatile analytics tool owned 
by Yahoo!.

8.	 It is another versatile web analytics tool owned by 
Amazon that offers a paid service.

9.	 It tracks the number of terminated visits after at least 
one page loads.

10.	It is simply the number of pageviews divided by the 
number of visits to a website.

11.	 It is the number of times a website has been loaded in a 
browser in a period.  
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C.	 Prove It. Answer the questions in paragraph form. How does social 
networking help you in your daily life?

a.	 Is web presence important in your life as a student? Why or why not? 
(2 points)	

b.	 In your own understanding, is an online exposure good or bad? Cite 
an example to support your answer. (3 points)

c.	 Can web influence have a lifetime impact on you? If yes, cite a specific 
situation with possible cause and effect. Else, defend and explain your 
answer. (5 points)
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BUILD 

After	having	created	a	website	for	yourself	in	Wix,	you	can	now	move	to	
add	ways	 to	 improve	 your	Web	 and	Online	presence	 through	 that	 site.	
Using	available	tools,	you	need	to	do	the	following:	

1.	 	Create	a	positive	exposure	for	yourself.

2.	 Set	up	or	do	at	least	one	thing	that	will	boost	your	Web	presence.

3.	 Set	up	or	do	at	least	one	thing	that	will	boost	your	Online	presence.

4.	 Set	up	of	do	at	least	one	thing	that	will	improve	your	level	of	infl	uence.

5.	 Determine	how	you	appear	in	search	results.

6.	Do	a	“keywords”	tweak	to	step	up	your	search	results	ranking.

7.	 Try	to	integrate	at	least	Google	Analytics	in	your	site	and	check	out	the	
visitor	data	that	will	be	shown	you.	



LESSON 16 HOW DO WE PRESENT OUR 
Target
At the end of this lesson, 
you will be able to

• Know how to present   
 the developed   
 documentation as a   
 presentation
• Present ideas or products  
 developed

  EXPLORE
Have	you	ever	had	 the	need	 to	present	 something	 to	 someone	 in	order	
to	 drive	 in	 your	 point	 of	 argument?	Try	 to	 recall	 a	 time	when	 you	had	
an	 idea	 that	 you	 had	 to	 defend	 against	 criticisms.	 As	 you	 needed	 to	
make	people	see	things	your	way,	how	did	you	go	about	the	business	of	
convincing	those	around	you	that	they	can	“buy	into”	your	idea?	Did	you	
create	a	presentation?	If	so,	how	did	you	deliver	the	information	in	a	way	
that	 catered	 to	 your	 listeners’	 sentiments	 in	 order	 to	make	 them	 sway	
your	way?

It’s	 normal	 not	 to	 be	 perfectly	 effective	 when	 presenting	 information	
to	people,	but	preparation	can	draw	the	 line	between	being	effective	 in	
implementing	what	you	have	developed	and	not	being	effective,	starting	
with	your	presentation.	You	might	 recall	 a	 time	when	you	were	able	 to	
make	people	follow	you	and	your	idea.	You	might	have	used	a	tool,	such	
as	 a	 whiteboard	 that	 helped	 in	 your	 presentation.	 In	 some	 cases,	 you	
could	have	used	a	method	which	you	had	successfully	used	 in	 the	past.	
So,	 you	 learned	what	 to	 do	 and	what	 not	 to	 do.	 You	 reuse	what	works	
and	what	doesn’t	so	that	you	can	improve	in	presenting	your	case	in	the	
future.

Recall	 the	good	points	and	bad	points	of	a	specific	presentation	or	 two	
that	you	gave	before.	Use	the	table	below.

YOUR 
PRESENTATION GOOD POINTS BAD POINTS

PROJECT OUTCOME TO A PANEL? 

Philippine	Copyright	2017225
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EXAMINE

As	classroom	learners,	you	likely	grew	up	in	grade	school	and	high	school	
writing	 and	 drawing	 things	with	 chalk	 on	 the	 blackboard.	 Those	 items	
which	 you	 used	 are	 actually	 tools	 that	 help	 you	 in	 your	 presentation.	
Now,	 consider	 the	 presentation	 slide	 above.	 Based	 on	 the	way	 it	 looks	
and	 the	 way	 the	 information	 is	 presented,	 what	 do	 you	 think	 are	 the	
tools	that	can	be	used	to	create	it?	List	your	suggestions	below.

1.	

2.	

3.	

4.	

5.	

Carrying & Delivering the Presentation
The	 way	 we	 show	 things	 has	 a	 very	 big	 effect	 on	 how	 the	 audience	
can	 grasp	 your	 ideas	 and	 then	make	use	 of	 such	 information	 since	 the	
audience	will	want	to	know	how	various	aspects	of	a	presentation—such	
as	facts	and	figures—might	apply	to	them	and	their	needs.	The	question	
to	answer,	really,	is:	“How	do	I	get	my	point	across?”	

What	 follows	 is	 a	 short	 list	 of	 applications	 that	will	 enable	 you	 to	 give	
good	 visual	 presentations.	 You	will	 need	 to	 consider	 the	 functionality,	
ease	 of	 use,	 and	 effectiveness	 of	 the	 following	 applications	 where	
presenting	your	material	and	getting	your	point	across	are	concerned.

What do you think this 
slideshow frame is all 
about?

How does this slide help 
the person in delivering 
information?
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1.	 Prezi

Prezi	 is	 a	 web-based	 application	 for	 presenting	 things	 with	 the	 use	
of	a	single	screen,	called	a	canvas,	which	 looks	 like	a	sheet	of	paper.	
Unlike	 other	 types	 of	 presentation	 software	 which	 use	 slides,	 Prezi	
emphasizes	 the	 combination	 of	 text,	 images,	 and	 other	 multimedia	
features	 to	 create	 a	 highly	 engaging	 presentation,	 with	 files	 and	
documents	being	 called	up	 from	 links	on	 the	 canvas,	which	 the	user	
can	drag,	 zoom,	and	 tilt.	This	 flexibility,	 combined	with	 ready-made	
templates	 for	 slide	 design	 allows	 for	 a	 very	 dynamic	 presentation.	
Up	to	ten	people	can	collaborate	on	a	single	presentation.	But	unlike	
other	 presentation	 software,	 Prezi	 doesn’t	 have	 a	 feedback	 review	
feature	to	help	you	improve	your	presentation.

The	 images,	 sound,	 and	 videos	 used	 on	 the	 canvas	 can	 be	 linked	
together	 in	 a	 path	 for	 a	 smooth	 presentation.	 Prezi	 allows	 the	
importation	 of	 PowerPoint	 presentations	 and	 features	 a	 Presenter	
view,	where	 the	 presenter	 can	 see	 notes	 and	 upcoming	 slides	which	
are	not	be	visible	to	the	viewers.

2.	 Microsoft	PowerPoint
	
PowerPoint	 is	perhaps	the	best-known	presentation	software	around	
today,	 as	 it	 is	 a	 leading	 Microsoft	 product.	 PowerPoint	 has	 many	
features	 and	 templates	 to	 choose	
from	and	is	easy	to	use.	It	is	linear	
in	its	approach.

Advancing	 from	 one	 slide	 to	
another	 is	 easily	 done,	 and	 a	
well-planned	slide	show	can	keep	
viewrs	 focused	 on	 a	 presentation	
which	 has	 complex	 points	 well	
presented.

3.	 Keynote	

Keynote	 is	 the	 answer	 of	 Apple	
to	 Microsoft’s	 PowerPoint.	 It’s	
part	 of	 the	 iWork	 productivity	
suite	 for	 iCloud	 and	 specifically	
designed	for	Mac	computers.	The	
late	Steve	Jobs,	founder	of	Apple,	
used	 Keynote	 in	 presenting	
new	 devices	 during	 product	
launches,	 although	 he	 was	 a	
staunch	 denier	 of	 the	 usefulness	
of	 slides	 in	 presenting	 his	 ideas	
to	 his	 developers.	 It’s	 arguably	
more	 versatile	 when	 it	 comes	 to	
graphics,	 but	 it	 still	 has	 a	 long	
way	to	go	to	becoming	popular.	

You are most likely 
familiar with PowerPoint 
for presentations. The 
late technopreneur, 
Steve Jobs loathed 
slideshows, preferring 
to talk about product 
development details 
sitting around the  table 
and sketching out ideas 
on paper. If this worked 
for him in getting his 
ideas for the iPhone, 
iPad, and iPod across 
to his tech team, what 
do you think is he doing 
right? 

Learn more about 
Steve Jobs’s disdain for 
slideshows and how he, 
ironically, used slides 
himself in Apple product 
launches here:

http://
makeapowerfulpoint.
com/2012/09/19/the-
powerpoint-gospel-of-
steve-jobs/

INTEGRATE
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4.	 Google	Slides

Google	 Slides.	 This	 application	 is	 built	 into	 Google	
Drive,	and	if	you	already	have	a	Gmail	account	you	can	
use	this	to	access	the	program.	Google	Slides	uses	cloud	
computing,	and	while	it	looks	similar	to	

Microsoft	 PowerPoint	 it	 is	made	 for	 easier	 use	 online	
as	 one	 of	 the	 basic	 office	 tools	 of	 Google	 Drive.	 It	
has	 ready-made	 templates,	 slide	 animations,	 and	
transitions	 that	 can	 enhance	 visual	 effects.	 You	 can	
transfer	 other	 slide	 shows	 created	 with	 applications	
like	 PowerPoint,	 although	 the	 appearance	 will	 not	 be	
exactly	the	same	as	the	original,	although	it	does	have	features	similar	
to	what	are	offered	by	PowerPoint,	 such	as	 linking	 to	other	URLs	or	
blog	posts.	

5.	 Glisser

Glisser	is	an	online	presentation	software	that	is	more	
for	 a	 business	 presenter	 than	 for	 a	 casual	 presenter.	
The	 program	 has	 social	 media	 interactivity,	 sharing,	
and	actionable	analytics	features.	The	last	one	enables	
the	presenter	to	get	feedback	about	the	presentation	as	
well	 as	 to	 get	 leads	 for	 the	presenter’s	business,	 since	
viewers	can	submit	questions	about	a	presentation	and	
its	content.	Glisser	 is	available	 through	a	subscription	
program	which	provides	access	from	mobile	devices.	

6.	 SlideShare
	
SlideShare	 comes	 from	 LinkedIn,	 which	 focuses	 on	
connecting	 professionals,	 so	 it’s	 no	 surprise	 that	 the	
program	focuses	on	content	sharing	in	its	community.	
SlideShare	 is	 used	 to	 easily	 share	 presentations,	
documents,	PDFs	and	 similar	media.	 It	was	originally	
intended	 to	 be	 used	 for	 employees	 of	 a	 company	 to	
share	 files	 together,	 but	 has	 since	 become	 known	 as	
being	 a	 slide	 show	 presentation	 version	 of	 YouTube,	
since	a	lot	of	slides	intended	merely	for	entertainment	
have	been	uploaded	on	it.

7.	 Powtoon

Powtoon.	If	you	are	into	cartoon	illustration,	this	online	presentation	
software	 might	 be	 the	 best	 fit	 for	 your	 taste.	 This	 free	 web	 tool	 is	
meant	for	animated	presentations,	and	it	creates	animated	stories	
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with	 voice	 overs	 instead	 of	 the	 usual	 bulleted	 list	
presentations.	It	works	best	with	an	integrated	script	for	
animated	 characters.	 Google	 Drive	 users	 can	 integrate	
their	 Powtoon	 presentation	 into	 their	 documents	 and	
thus	share	these	readily	with	a	wider	audience.

8.				SlideDog
	

Unlike	the	other	programs	in	this	list,	SlideDog	cannot	be	
used	to	create	new	presentations	from	scratch,	but	rather	
allows	 for	 the	 creation	 of	 playlists	 of	 already	 existing	
presentations,	 as	 well	 as	 YouTube	 videos,	 .mp3	 files	
and	other	video	 file	 formats.	 It	can	be	used	 to	broadcast	
presentations	over	the	Internet	as	well	as	in	a	conference	
or	chat	room	in	wherein	viewers	can	chat	with	each	other	
while	 the	presentation	 is	ongoing.	Polls	 can	also	be	 sent	
out	 by	 the	 presenter	 and	 the	 playlist	 can	 be	 controlled	
from	any	Web-capable	device,	such	as	a	tablet.

9.				Haiku	Deck
	

Haiku	Deck	 is	 a	 free	 application	 for	 the	 iPad	which	 has	
tablet-limited	 tools,	 but	 these	 mobile	 tools	 enable	 the	
creation	 of	 easy-to-read	 presentations,	 unlike	 other	
applications	 like	 PowerPoint,	 which	 may	 overflow	
with	 bullet	 points	 and	 information	 that	 the	 user	 can	
unwittingly	add.	 Images,	however,	can	be	added	and	 the	
program	actually	automatically	 searches	 the	 Internet	 for	
free	images	that	can	be	used.	It	may	not	be	as	flexible	or	
as	complex	as	the	other	presentation	programs	in	this	list,	
but	its	simplicity	means	that	presentations	can	be	crafted	
very	quickly.

Presenting the wix.com Domain and Its 
Social Issue
Even	 the	 best	 presenters	 get	 nervous,	 but	 there	 is	 no	 reason	 your	
presentation	 shouldn’t	 be	 a	 good	 one	 if	 you	 did	 your	 homework	
beforehand.	The	 following	apply	not	 only	 to	 your	presenting	 your	WiX	
website	 and	 the	 social	 issue	 it	 focuses	 on	 but	 to	 any	 presentation	 you	
might	make	in	the	future.

1.	 Plan and prepare.	Being	a	good	communicator	is	key	to	having	an	
eff	ective	presentation,	and	this	takes	practice	and	preparation.	Practice	
your	delivery	to	make	sure	your	presentation	goes	smoothly,	and	if	you	
aren’t	thoroughly	familiar	with	it,	feel	free	to	write	your	speech	or	create	a	
script	of	the	important	things	that	need	to	be	covered.	But	essentially,	full	
knowledge	of	what	you	will	be	talking	about	can	mean	your	presentation	
will	be	successful.	

For stock photos and 
reusable images, check 
out the following 
websites:

• Compfi ght http://
compfi ght.com

• FreeImages http://
www.freeimages.com

• Morguefi le https://
morguefi le.com

• PhotoFunia https://
photofunia.com

EQUIP
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2.	 Be enthusiastic /optimistic. Nervousness is normal with just about all 
presenters, so just be with it and become both energetic and enthusiastic. 
Relax and feel free to tell stories related to the topic at hand, particularly if 
telling stories about your experiences helps the presentation move along.

3.	 Keep your words simple. Too many words on the slide will cause the 
audience members to lose focus or ignore what you are saying since they 
might spend too much time trying to read what’s on the slides. Too many 
words and overly small text on the slides could make it difficult for those 
in the back rows to read your presentation. 

4.	 Use humor. Timed humor that draws a few chuckles can help keep your 
audience’s attention. Keep things light while staying on topic but acting 
like a stand up comedian will most likely have the opposite effect and 
drive your audience away.

5.	 Use appropriate images. The proper images in a presentation engage 
the audience as well as enable them to get the message in its proper 
context. Use visual aids to support your message, as relevant images in 
your presentation will enable the audience to get your point quickly. 

6.	 Engage and interact with the audience. Monologuing increases 
audience boredom. Don’t just read your presentation. Talk to your 
audience and ask them some questions every now and then and take in 
their answers. 

7.	 Use the proper non-verbal gestures. Body movements mean a lot, 
so take this into consideration when you rehearse for your presentation. 
This is often natural but also remember that eye contact helps create 
connection with your audience even when you can’t see their eyes, and 
make sure you move freely but moderately, so you don’t distract your 
audience. 

8.	 Check other details. Check the time and place when you should be 
present, and if possible, check out the venue well before you actually 
present. Take note of the venue’s condition and facilities, so you can 
set yourself up properly. Know ahead of time what the profile of your 
audience is, and how large the crowd will be. Arrive early so you can 
adjust for anything unexpected that happens. Remember to smile and 
everything will go smoothly. 

Giving Feedback on a Project and Its Impact
For purposes of evaluation and feedback, you can give your presentation 
to a select group of people as a dry run for the actual one. Your pre-
selected audience can provide you with suggestions and ways to improve 
your presentation. But in giving feedback on the project and its impact, 
keep it professional and observe the following. 
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1.	 Don’t comment on the presenter’s presentation (i.e., clothes, hairstyle, 
shoes, etc.) unless these are extremely distracting, such as if the presenter 
was wearing a bright yellow raincoat.

2.	 Don’t comment on the presenter’s personality. Focus instead on the way 
he or she presented. If the presenter just stood in front of the audience 
and read from a sheet with a monotone voice, point this out, so that he or 
she can improve their presentation.

3.	 If you see ways by which their presentation or project can be improved, 
point these out as possibilities, and say, “Maybe you should consider…” 
rather than from the attitude of, “You’re wrong, and you should do it this 
way!”

4.	 Ask questions if you are unclear about anything that was presented on. 
After all, you are supposed to understand what the presentation was all 
about, otherwise, the presentation was pointless and a waste of your time 
and, possibly, everyone else’s.

When receiving feedback on your presentation, accept the criticism 
professionally. Ignore those points that are personal and accept those 
which would enable you to improve, both where the presentation is 
concerned and as a presenter.

Presentation tools are essentially just that—tools. If you really have 
some great stuff to share to the world, it’s still your enthusiasm and 
your passion for your creation that will see you through in getting your 
thoughts and ideas across. “People who know what they’re talking about 
don’t need PowerPoint,” said Steve Jobs. But then again, he was talking 
about a competitor’s software and the truth is he still used proprietary 
Keynote slides in presenting new gadgets from Apple to large audiences, 
particularly in product launches. 
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CHECK
A.	 Identifi	cation.	Answer	the	following	questions.	

1.	 In	which	of	the	following	programs	can	you	not	create	
new	presentations?	
a.	 PowerPoint
b.	 Haiku	Deck
c.	 SlideDog
d.	 Prezi

2.	 Which	of	the	following	is	not	a	free	image	website?	

a.	 PhotoFunia
b.	 FreeImages
c.	 CompFight
d.	 Shutterstock

B.	 Enumeration.	List	down	fi	ve	things	that	will	enable	you	to	give	an	
eff	ective	presentation.

1.	 ___________________________

2.	 ___________________________

3.	 ___________________________

4.	 ___________________________

5.	 ___________________________

C.	 Essay.	When	is	the	use	of	slides	necessary	and	when	is	it	not	crucial	in	
content	documentation	and	delivery?	
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   BUILD

As	 a	 group,	 prepare	 two	 presentations	 for	 the	 same	 content.	 One	 will	
not	 use	 a	 presentation	 tool	 and	 the	 other	 will	 be	 delivered	 using	 the	
presentation	 software	 of	 the	 group’s	 choice.	 You	 can	 determine	 the	
manner	of	delivery	of	the	details	of	your	documentation	for	each	of	the	
presentations.	

As	 a	 general	 rule,	 break	 up	 both	 of	 the	 presentations	 into	manageable	
chunks	for	members	of	the	group	to	work	on.	Coordinate	with	each	other	
to	make	sure	the	presentations	are	delivered	smoothly.	

Once	 all	 of	 you	 have	 presented,	 list	 the	 advantages	 of	 using	 and	 not	
using	a	presentation	tool	in	delivering	the	details	of	your	documentation	
presentation.	 Get	 feedback	 from	 your	 class	 audience	 and	 decide	 as	 a	
class	on	what	they	have	in	common	that	makes	them	both	effective.



Philippine Copyright 2017 234




